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UDK 681.3 
 

A n n o t a t s i y a  

Talabalar mustaqil ishi uchun mo‘ljallangan «Loyihalash jarayonlarini 

avtomatlashtirish asoslari: Kompyuterda AutoCADda chizmalarni ishlab chiqish» 

o‘quv qo‘llanmasida AutoCAD 2007 grafik redaktorini ishga tushirish, uning 

darchasi, grafik primitivlar va ularning xossalari, qatlamlarni yaratish masalalari, 

chizma grafik elementlarini tahrir qilish bo‘yicha komandalar va mashqlarda 

ulardan foydalanish, kesim shakllarini shtrixovkalash metodikasi, yangi o‘lcham 

stilini va o‘lchamlarni berishni o‘rnatish, matn kiritmalarini yaratish va grafik 

informasiyani chop etishga chiqarish komandalari, chizmalarni yaratish 

metodikasi, korpus detali chizmasini bosqichma-bosqich bajarish, uch o‘lchamli 

ishchi maydonni sozlash masalalari ko‘rib chiqilgan; karkasli, sirtli va qattiq jismli 

modellar ko‘rinishidagi uch o‘lchamli obyektlarni qurish metodlari bayon qilingan. 

O‘quv qo‘llanmada nazorat savollari, tavsiya etilgan o‘quv va metodik adabiyotlar 

ro‘yxati ham keltirilgan. 

 

А н н о т а ц и я  

В учебном пособии для самостоятельной работы студентов «Основы 

автоматизированного проектирования: Разработка чертежей на компьютере в 

AutoCAD» рассматриваются запуск и окно графического редактора AutoCAD 

2007, графические примитивы и их свойства, вопросы создания слоев, 

команды по редактированию графических элементов чертежа с 

использованием их в упражнениях, методика выполнения штриховки фигур 

сечения, установки нового размерного стиля и нанесения размеров, команды 

создания текстовых вставок и вывода на печать графической информации, 

методика создания чертежей, поэтапное выполнение чертежа корпусной 

детали, настройка трехмерного рабочего пространства, описаны методы 

построения трехмерных объектов в виде каркасных, поверхностных и 

твердотельных моделей. Работа содержит также контрольные вопросы, 

список рекомендуемой учебной и методической литературы. 



 3 

 

T h e  s u m m a r y  

In the manual for independent work of students «Bases of the automated 

designing: working out of drawings on the computer in AutoCAD» start and a 

window of graphic editor AutoCAD 2007, graphic primitive things and their 

properties, questions of creation of layers, commands on editing of graphic 

elements of the drawing with their use in exercises are considered, the technique of 

performance of shading of figures of section, installation of new dimensional style 

and dimensioning, a command of creation of text inserts and printing of the 

graphic information, a technique of creation of drawings, stage-by-stage 

performance of the drawing of a case detail, adjustment of three-dimensional 

working space, are described methods of construction of three-dimensional objects 

in the form of frame, superficial and solid-state models. Work contains also control 

questions, the list of the recommended educational and methodical literature. 

 

 

 

Tаqrizchilаr:  t.f.d., dоts. Bаzаrоv B.I.  (TАYI); 

t.f.d., prоf. Mаmаdjаnоv А.M. (TоshDTU) 
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KIRISH 
 

 

5500000 – «Muhandislik, ishlov berish va qurilish sohalari» bilimlar sohasi 

bakalavriat yo‘nalishlarining o‘quv rejalarida «Loyihalash jarayonlarini 

avtomatlashtirish asoslari» o‘quv fani nazarda tutilgan. Bu fanni o‘zlashtirishda 

talabalardan zamonaviy avtomatlashtirilgan loyihalash tizimlarini qo‘llab amaliy 

grafik ishlarni bajarish talab qilinadi. Bunda avtomatlashtirilgan loyihalashning 

eng ommaviy grafik tizimlari – AutoCADdan foydalaniladi. 

AutoCAD grafik tizimi Auto-Desk (AQSh) firmasi tomonidan ishlab 

chiqilgan, muhandislik-grafik ishlarini avtomatlashtirish uchun mo‘ljallangan, shu 

sababli kompyuter bilan birga «elektron kulman»ni hosil qiladi. 

AutoCADning birinchi versiyasi paydo bo‘lgandan beri u quvvatli muhitga 

aylandi, usiz zamonaviy sanoat korxonasi yoki konstruktorlik byurosining ishini 

tasavvur qilib bo‘lmaydi. O‘quv qo‘llanmada bayon qilingan AutoCAD 2007 

versiya – uning evolyutsion rivojlanishining natijasidir. Ushbu versiyada ba’zi-bir 

o‘zgarishlar uch o‘lchamli muhitga taalluqli bo‘ldi – foydalanuvchi interfeysi 

yaxshilandi. 

AutoCAD 2007 grafik tizimi Windows XP operatsion tizimga o‘rnatiladi. 

O‘quv qo‘llanmada taqdim etilgan o‘quv-metodik material Toshkent davlat 

texnika universitetining «Energomashinasozlik va kasb ta’limi (EUT)» kafedrasida 

5 yil davomida aprobatsiyadan muvaffaqiyatli o‘tdi. O‘quv qo‘llanmadagi 

chizmalar AutoCAD 2007 dasturining eng yangi versiyasidan foydalanilgan holda 

bajarildi. 

Ushbu o‘quv qo‘llanmada quyidagi masalalar ko‘rilgan: 

• AutoCAD 2007 grafik tizimini muayyan foydalanuvchiga moslab sozlash; 

• chizmalarni ESКD standartlariga mos ravishda yaratish, tahrir qilish va 

shakl berish metodikasi; bunda ushbu tizimda chizmalarni «oddiydan 

murakkabga» bajarish texnologiyasi bayon qilingan; 

• AutoCAD 2007 grafik muhitida individual topshiriqlarni bosqichma-

bosqich bajarish metodikasi; 
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• AutoCAD 2007 grafik muhitida uch o‘lchamli ishchi maydonining bayoni 

va uni sozlash; 

• AutoCAD 2007 grafik muhitida uch o‘lchamli obyektlarni karkasli, sirtli 

va qattiq jismli modellar ko‘rinishida qurish metodlari. 

Shaxsiy individual grafik topshiriqlarni bajarish quyidagi bandlardan iborat: 

• detalning ikki tasviri bo‘yicha uning uchinchi tasvirini ratsional kesimlari 

bilan A3 formatda qurish; 

• sirtlarning kesishish va o‘tish chiziqlarini qurish; 

• korpus detalining qattiq jismli modelini qurish. 

O‘quv qo‘llanmada AutoCAD grafik tizimining uch o‘lchamli modellash 

vositalari yordamida turli uch o‘lchamli obyektlarni yaratish metodikasi bayon 

qilingan. 
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1. AutoCAD 2007 RЕDАKTОRINI ISHGА TUSHIRISH VА UNING 

DАRCHАSI 

 

Grаfik tizim AutoCAD 2007 Windows XP оpеrаtsiоn tizimdа ishgа 

tushirilаdi. Yuklаngаndаn kеyin ekrаndа 1.1-rаsmdа tаsvirlаngаn ishchi mаkоn 

(пространство)ni tаnlаsh diаlоg dаrchаsi pаydо bo‘lаdi. 
 

 
 

1.1-rаsm. Ishchi mаkоnni tаnlаsh dаrchаsi 

 

Undа AutoCAD Classic (Классик стиль/Klаssik stil) yoki 3D Modeling (3D 

моделирование/3D mоdеllаsh) intеrfеyslаrni tаnlаsh mumkin. Dаstlаb AutoCAD 

Classic punktni tаnlаymiz, chunki biz ikki o‘lchаmli mаkоnni o‘zlаshtirishdаn 

bоshlаymiz. 

So‘ngrа dаrchа pаydо bo‘lаdi, uning yordаmidа dаsturning yangi 

funksiyalаri bilаn tаnishish mumkin. Undа Yes (Да/Hа), Maybe later 

(Позже/Kеyin) yoki No, Don't me this again (Больше не показывать это 

окно/Bu dаrchа bоshqа ko‘rsаtilmаsin) ulаb-uzgichlаridаn birini tаnlаng vа ОK 

knоpkаsini shiqillаting. 

Kеyin Startup (Начало работы/Ish bоshlаnishi) diаlоg dаrchаsi pаydо 

bo‘lаdi. Bu diаlоg dаrchаsining pаydо bo‘lishi yoki bo‘lmаsligi Tools => Options 

(Сервис => Настройки/Sеrvis => O‘rnаtish) kоmаndаsi bilаn bоshqаrilаdi, 

Startup ro‘yxаtidаgi General Options (Общие параметры/Umumiy pаrаmеtrlаr) 

bo‘limning System (Система/Tizim) ilоvаsidа Show startup dialog box 

(Показывать диалоговое окно начало работы/Ish bоshlаnishi diаlоg dаrchаsini 

ko‘rsаtish)ni tаnlаymiz. 



 7 

Yanа shuni qаyd qilish kеrаkki, indаmаslik (по умолчанию) bo‘yichа ishchi 

zоnа qоrа rаnggа egа bo‘lаdi. Qulаy bo‘lishligi uchun ishchi zоnаning rаngini 

qоrаdаn оqqа (yoki sizgа yoqqаn bоshqа rаnggа) аlmаshtirish tаvsiya etilаdi. 

Display (Экран) ilоvаsidаgi Tools => Options (Sеrvis => O‘rnаtish) 

kоmаndаsini tаnlаng vа Colors (Света/Rаnglаr) knоpkаsidа shiqillаting. Kеyin 

Drawing Window Color (Окно светов чертежа/Chizmа rаnglаri dаrchаsi) 

оchilаdi –1.2-rаsm. Ushbu diаlоg dаrchаsidа ekrаnning hаr bir elеmеnti uchun 

rаng o‘rnаtish mumkin. 
 

 
 

1.2-rаsm. Ishchi zоnа rаngini tаnlаsh dаrchаsi 

 

Indаmаslik bo‘yichа ikki o‘lchаmli ishchi zоnаning rаngi ro‘yxаtdа birinchi 

bo‘lib tоpilаdi, shuning uchun Color (Rаng) mаydоnidа White (Белый/Оq) qаtоrni 

tаnlаng. Apply&Close (Применить и закрыть/Qo‘llаng vа bеrkiting) knоpkаsidа 

shiqillаtib diаlоg dаrchаsini yoping. 

Startup (Ish bоshlаnishi) diаlоg dаrchаsi 1.3-rаsmdа ko‘rsаtilgаn. 
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1.3-rаsm. Startup (Ish bоshlаnishi) diаlоg dаrchаsi 

 

Startup (Ish bоshlаnishi) diаlоg dаrchаsi yordаmidа mаvjud chizmаni оchish 

yoki yangisini yarаtish mumkin. Birinchi hоldа Open a Drawing (Открыть 

чертеж/Chizmаni оchish) knоpkаsidа, ikkinchi hоldа esа – Start from Scratch 

(Начать с нуля/Nuldаn bоshlаnsin), Use a Template (По шаблону/Shаblоn 

bo‘yichа) Use a Wizard (Использовать мастера/Ustаdаn fоydаlаnish) 

knоpkаsidа shiqillаtilаdi. Bu diаlоg dаrchаsi kеyinchаlik File => New (Файл => 

Новый/Fаyl => Yangi) kоmаndаsi bаjаrilishidа hаm pаydо bo‘lаdi. 

Start from Scratch (Начать с нуля/Nuldаn bоshlаsh) rеjimi vа mеtrlik 

tizimlаr birligi tаnlаngаndаn so‘ng AutoCAD qo‘shimchа ko‘rsаtmаlаrsiz yangi 

chizmа uchun ishchi ekrаnni оchаmiz. Chizishni bоshlаshdаn оldin AutoCAD 

rеdаktоrining ishchi dаrchаsi (grаfik intеrfеysi) bilаn tаnishаmiz. 

 

1.1. Fоydаlаnuvchining ishchi stоli 

1.4-rаsmdа AutoCAD 2007 ning ishgа tushirilgаn ishchi dаrchаsi 

ko‘rsаtilgаn. Bundа sаrlаvhа qаtоridа (ekrаnning chаp yuqоri burchаgidа) bo‘lаjаk 

chizmаgа аvtоmаtik tаrzdа bеrilgаn fаyl nоmi – Drawing 1 pаydо bo‘lаdi. 

Ekrаndа to‘rttа funksiоnаl zоnаni аjrаtish mumkin: 

• Ishchi grаfik zоnа – bu ekrаnning o‘rtаsidа jоylаshgаn аsоsiy jаbhа, u 

yеrdа chizmа bаjаrilаdi. Zоnаning chаp pаstdаgi burchаgidа fоydаlаnuvchi 

fоydаlаnuvchi kооrdinаtаlаr tizimining piktоgrаmmаsi jоylаshаdi. Strеlkаlаr 

yo‘nаlishi o‘qlаrning musbаt yo‘nаlishigа mоs kеlаdi. 

• Tizimiy mеnyu vа instrumеntlаr pаnеli. Eng yuqоridа sаrlаvhа qаtоri, 

uning оstidа esа – AutoCAD tizimiy mеnyusining qаtоri jоylаshаdi. Pаstrоqdа 

instrumеntlаr pаnеllаri egаllаgаn ikkitа qаtоr jоylаshаdi. Ishchi zоnаdаn chаp 

tаrаfdа instrumеntlаrning «suzuvchi» pаnеllаri Draw (Рисование/Chizish), 

Modify (Редактирование/Tаhrir qilish), o‘ngdа esа – Dimension (Размеры/ 

O‘lchаmlаr) jоylаshаdi. Ulаrni ekrаnning istаlgаn jоyigа siljitish mumkin. 
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AutoCAD yanа bоshqа ko‘p instrumеntlаr pаnеllаri bоr, ulаr zаrurаt bo‘yichа 

chаqirilаdi. 
 

 
 

1.4-rаsm. AutoCAD 2007 ning ishchi dаrchаsi 

 

• Kоmаndа qаtоri. Ishchi grаfik zоnа оstidа kоmаndа qаtоri jоylаshаdi. 

AutoCADning istаlgаn kоmаndаsini, uning nоmini kоmаndа qаtоridа tеrib, ishgа 

tushirish mumkin. Аgаr kоmаndа instrumеntlаr pаnеli piktоgrаmmаsi yoki mеnyu 

punkti vоsitаsidа ishgа tushirilgаn bo‘lsа, kоmаndа qаtоridа tizimning mоs 

kоmаndаsigа rеаksiyasi аks ettirilаdi. Bundаn tаshqаri klаviаturаdаn kiritilаdigаn 

hаmmа nаrsа o‘shа zаhоti kоmаndа qаtоridа аks ettirilаdi. Аgаr bilmаsdаn bоshqа 

kоmаndа chаqirilgаn vа jоriy kоmаndаni bеkоr qilish zаrur bo‘lsа, klаviаturаdаgi 

Esc klаviаturаsini bоsish mumkin. 

• Hоlаt qаtоri. Hоlаt qаtоridа xоch(sichqоn ko‘rsаtkichi)ning jоriy 

kооrdinаtаlаri аks ettirilаdi. 

 Bаzаviy xаrаktеristikаlаrni yaxshirоq tushunish uchun kеsmа ko‘rinishidаgi 

grаfik primitivni kеltirilgаn instruksiya bo‘yichа chizishgа hаrаkаt qilib ko‘rаmiz. 

 

Mаshq 1.1. To‘g‘ri chiziq kеsmаsini chizish 

1. Instrumеntlаr pаnеli Draw (Рисование/Chizish)dа Line (Отрезок/ 

Kеsmа) piktоgrаmmаsini (uni sichqоn knоpkаsini shiqillаtib) tаnlаng (1.5-rаsm) 

yoki kоmаndа qаtоridаn kiriting. Bundа kоmаndа qаtоridа quyidаgi kоmаndаni 

kiritishgа tаklif pаydо bo‘lаdi: 
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C o m m a n d :  l i n e  S p e c i f y  f i r s t  p o i n t :  ( К о м а н д а :  О т р е з о к .  

О п р е д е л и т ь  п е р в у ю  т о ч к у / K о m а n d а :  K е s m а .  B i r i n c h i  n u q t а  

а n i q l а n s i n ) .  
 

 
 

1.5-rаsm. To‘g‘ri chiziq kеsmаsini chizish 

 

2. Kеsmа birinchi nuqtаsining kооrdinаtаlаri X vа Y ni, so‘ngrа ikkinchi 

nuqtаsining kооrdinаtаlаrini bo‘sh jоy qоldirmаsdаn prоbеlsiz vеrgul bilаn 

kiritilsin: 

C o m m a n d :  L i n e  S p e c i f y  f i r s t  p o i n t :  5 0 ,  5 0  E n t e r  

( К о м а н д а :  О т р е з о к .  О п р е д е л и т ь  п е р в у ю  т о ч к у :  5 0 ,  5 0  

E n t e r / K о m а n d а :  K е s m а .  B i r i n c h i  n u q t а  а n i q l а n s i n :  5 0 ,  5 0  

E n t e r ) ;  

S p e c i f y  n e x t  p o i n t  o r  [ U n d o ] :  1 0 0 ,  1 5 0  E n t e r  

( О п р е д е л и т ь  с л е д у ю щ у ю  т о ч к у  и л и  [ О т м е н и т ь ] :  1 0 0 ,  1 5 0  

E n t e r / K е y i n g i  n u q t а  а n i q l а n s i n  y o k i  [ b е k о r  q i l i n s i n ] :  1 0 0 ,  

1 5 0  E n t e r ) ;  

S p e c i f y  n e x t  p o i n t  o r  [ U n d o ] :  E n t e r  ( О п р е д е л и т ь  

с л е д у ю щ у ю  т о ч к у  и л и  [ О т м е н и т ь ] :  E n t e r / K е y i n g i  n u q t а  

а n i q l а n s i n  y o k i  [ b е k о r  q i l i n s i n ] :  E n t e r ) .  

 

Mаshq 1.2. Kеsmаni o‘chirish 

1. Qurilgаn kеsmа ko‘rsаtilsin, ya`ni kеsmаdа mo‘ljalga olish xоchi 

(mаrkеr)ni o‘rnаting vа sichqоn chаp knоpkаsini shiqillаting. Bundа kеsmа punktir 
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bilаn аjrаtib ko‘rsаtilаdi vа uning оxirlаridа esа «ruchkаlаr» pаydо bo‘lаdi. 

2. Klаviаturаdаgi Delete klаvishаsi bоsilsin yoki sichqоn bilаn Modify 

(Редактирование/Tаhrirlаsh) instrumеntlаr pаnеlidа Erase (Стереть/O‘chirish) 

piktоgrаmmаsini ko‘rsаting. Kеsmа yo‘qоlаdi. 

AutoCAD istаlgаn bаjаrilgаn kоmаndаni yoki kоmаndаlаr guruhini bеkоr 

qilish imkоniyatini bеrаdi. Yo‘qоtilgаn tаsvirni tiklаsh uchun instrumеntlаr 

pаnеlining yuqоrigi qаtоridа chаp strеlkа Undo (Отмена/Bеkоr qilish) 

piktоgrаmmаsidа sichqоnni shiqillаting(1.5-rаsm). 

 

Kiritishning dinаmik rеjimi 

AutoCAD 2007 dа mа`lumоtlаrni dinаmik kiritish rеjimi mаvjud. Hоlаtlаr 

qаtоridа DYN (DIN) knоpkаsi bоsilgаndа dinаmik kiritish Dynamic Input 

(Динамический ввод/Dinаmik kiritish) rеjimi ulаnаdi(1.6-rаsm). 
 

 
 

1.6-rаsm. Dinаmik rеjimdа to‘g‘ri chiziq kеsmаsini chizish 

 

Yuqоridа bаyon qilingаn kоmаndа dinаmik rеjimdа bаjаrilishidа kursоr 

yonidа yo‘riqlаr qаtоri pаydо bo‘lаdi (1.6-rаsm). Ungа nuqtа kооrdinаtаlаrini 

kiritish uchun kоmаndа so‘rоvi аks ettirilаdi. Dinаmik kiritish rеjimi pаydо 

bo‘lishi bilаn (AutoCAD 2006 dаn bоshlаb) rеdаktоr ishchi dаrchаsining pаstdаgi 

chаp burchаgidаgi kооrdinаtаlаr pаnеli (1.4-rаsmgа qаrаng) o‘z аhаmiyatini 

yo‘qоtаdi, chunki u yеrdа hаm shu infоrmаtsiya tаkrоrlаnаdi. 

Dinаmik kiritish rеjimining ikki turi mаvjud: Pointer Input (Задание точки 

ее координатами/Nuqtаning uning kооrdinаtаlаri оrqаli bеrish) vа Dimension 

Input (Задание точки ее расстоянием и углов/Nuqtаni mаsоfа vа burchаk оrqаli 

bеrish). Bu rеjimlаr Tools => Drafting Settings (Instrumеntlаr => Bоg‘lаsh 

pаrаmеtrlаri) diаlоg dаrchаsi yordаmidа o‘rnаtilаdi. 

Hоzirchа biz kiritishning klаssik rеjimidа ishlаymiz, shuning uchun hоlаt 

qаtоridаgi DYN (DIN) knоpkаsini bоsib, dinаmik kiritish rеjimini uzib qo‘yamiz. 

 

Mаshq 1.3. Chizmаni sаqlаsh 
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1. Instrumеntlаr pаnеlining yuqоri qаtоridа File (Fаyl) mеnyusini 

shiqillаting, chiqаyotgаn ro‘yxаtdаn Save Drawing As (Сохранить как/Kаbi 

sаqlаng)ni tаnlаng. Ekrаndа tаnlаngаn diskdаgi pаpkаlаr ro‘yxаtili Save Drawing 

As diаlоg dаrchаsi pаydо bo‘lаdi. 

2. Pаpkаni chiqаring yoki yangisini yarаting. File Name (Имя файла/Fаyl 

nоmi) qаtоridа chizmа nоmi – Чертеж 1 ni kiriting vа ushbu dаrchаdаgi Save 

(Сохранить/Sаqlаnsin) knоpkаsini shiqillаting. AutoCADdа yarаtilаyotgаn 

chizmаlаrning hаmmа fаyllаrgа аvtоmаtik tаrzdа kеngаyish .dwg berilаdi. 

 

Tizimdаn chiqish 

Tizimdаn chiqish uchun quyidаgi аmаllаrning biridаn fоydаlаnish mumkin: 

• Close (Закрыть/Bеrkitilsin) knоpkаsidа sichqоnni shiqillаtish – xоch 

ekrаnning o‘ngdаgi yuqоri burchаgidа; 

• kоmаndа qаtоridа Quit so‘zi tеrilаdi vа Enter klаvishаsi bоsilаdi; 

• mеnyudа File => Exit (Файл => Выход/Fаyl => Chiqish) tаnlаnаdi. 

Аgаr infоrmаtsiya chizmаdа sаqlаnmаgаn bo‘lsа, AutoCAD uni sаqlаshni 

tаklif qilаdi. Yes (Да/Hа) jаvоbini bеrish bu tаklifni qаbul qilish, No (Нет/Yo‘q) 

jаvоbini bеrish оxirgi o‘zgаrishlаrni sаqlаmаsdаn tizimdаn chiqish yoki chiqishdаn 

vоz kеchib, Cancel (Отмена/Bеkоr qilish) knоpkаsini bоsib chizmаgа qаytish 

mumkin. 

 

1.2. Mеnyu vа instrumеntlаr pаnеllаri 

AutoCAD kоmаndаlаrini chаqirish mеnyu yoki instrumеntlаr pаnеllаridаgi 

piktоgrаmmаlаr yordаmidа аmаlgа оshirilаdi. AutoCAD 2007 vеrsiyasidа tizimiy 

mеnyu qаtоri quyidаgi chiqib kеluvchi mеnyulаrdаn tаrkib tоpаdi: 

• File (Файл/Fаyl) – mеnyu fаyl (chizmа)lаrni оchish, sаqlаsh, chоp qilish, 

bоshqа fоrmаtlаrgа ekspоrt qilish vа tizimdаn chiqish uchun mo‘ljаllаngаn; 

• Edit (Правка/Tuzаtish) – ishchi zоnаdа chizmа kеsimlаrini tаhrir qilish 

(tuzаtish) mеnyusi; 

• View (Вид/Tur) – ekrаnni bоshqаrish, vаrаq vа mоdеl mаkоnlаri 

rеjimlаrini uzib-ulаsh, uch o‘lchаmli mоdеllаr uchun ko‘rish nuqtаsini o‘rnаtish, 

tоnirоvkа qilish, displеy pаrаmеtrlаrini bоshqаrish mеnyusi; 

• Insert (Вставить/Kiritib o‘rnаtish) – bоshqа ilоvаlаrdаn blоklаr vа 

оbyеktlаrni kiritib o‘rnаtish kоmаndаsi mеnyusi; 

• Tools (Инструменты/Instrumеntlаr) – tizimni bоshqаrish vоsitаlаri, 

chizmа pаrаmеtrlаrini bоg‘lаnishlаr vа fоydаlаnuvchi kооrdinаtаlаr tizimini 

o‘rnаtish mеnyusi; 

• Draw (Черчение/Chizmаchilik) – grаfik primitivlаr vа uch o‘lchаmli 

mоdеllаrni qurish mеnyusi; 

• Dimension (Размер/O‘lchаm) – o‘lchаmlаrni bеrish kоmаndаsi mеnyusi; 

• Modify (Редактирование/Tаhrir qilish) – grаfik оbyеktlаrni tаhrir qilish 

mеnyusi; 

• Window (Окно/Dаrchа) – оchilgаn chizmа(fаyl)lаrni bоshqаrish vа 

sоrtirоvkа qilish mеnyusi; 

• Help (Справка/Mа`lumоt) – mа`lumоt mеnyusi. 
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а) 
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b) 

 

 
 

v) 

 

1.7-rаsm. Draw (Черчение/Chizmаchilik) mеnyusi vа kоntеkst mеnyusi 

 

1.7,а-rаsmdа misоl tаriqаsidа Draw (Черчение/Chizmаchilik) chiqib 

kеluvchi mеnyusining bir qismi ko‘rsаtilgаn. Uni ekrаndа ko‘rish uchun, kursоr 

bilаn tizimiy mеnyudаgi Draw so‘zini kursоr bilаn ko‘rsаtish vа sichqоnni 

shiqillаtish lоzim. Аgаr o‘ng tоmоndа qоrа uchburchаk turgаn bo‘lsа, ekrаngа 

nimmеnyuni hаm chiqаrish mumkin. 

 

Kоntеkstli mеnyu 

Kоntеkstli mеnyu jоriy kоmаndа uchun оpsiyalаr ro‘yxаtigа tеz kirishni 

tа`minlаydi. Kоntеkstli mеnyu sichqоn o‘ng knоpkаsi bоsilgаndаn kеyin оchilаdi. 

1.7,b-rаsmdа indаmаslik bo‘yichа kоntеkstli mеnyu kеltirilgаn, u sichqоn o‘ng 

knоpkаsi chizmа jаbhаsidа bоsilgаndаn kеyin оchilаdi. 

Tаhrir qilish rеjimining kоntеkstli mеnyusi qаndаydir оbyеkt (mаsаlаn, 

qurilgаn kеsmа) tаnlаngаndаn kеyin vа sichqоnning o‘ng knоpkаsi bоsilgаndаn 

so‘ng оchilаdi (1.7,v-rаsm). 

 

Instrumеntlаr pаnеllаri 

Instrumеntlаr pаnеllаri tаnlаngаn piktоgrаmmаdа sichqоnni оddiy 

shiqillаtish bilаn AutoCAD kоmаndаlаrini bаjаrish imkоnini bеrаdi. Instrumеntlаr 

pаnеllаri suzib yuruvchi yoki muаyyan bir jоygа o‘rnаtilgаn bo‘lishi mumkin. 
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AutoCAD 2007 dа 40 yaqin instrumеntlаr pаnеllаri mаvjud. 

 

 

Mаshq 1.4. Instrumеntlаr pаnеlini chаqirish 

1. Tizimiy mеnyudаn View => Toolbars (Вид => Панели 

инструментов/Tur => Instrumеntlаr pаnеli)ni tаnlаng. 

2. Pаydо bo‘lgаn Customize User Interface (Настройка интерфейса 

пользователя/Fоydаlаnuvchi intеrfеysini o‘rnаtish) diаlоg dаrchаsidаgi Toolbars 

(Панели инструментов/Instrumеntlаr pаnеli) qаtоridа istаlgаn instrumеntlаr 

pаnеlini tаnlаsh mumkin. 

3. Ishchi stоlidа ekrаnni mаsshtаblаsh piktоgrаmmаlаri bo‘lgаn chizg‘ich 

pаydо bo‘lishi uchun instrumеntlаr pаnеlidаgi istаlgаn piktоgrаmmаni o‘ng 

knоpkа bilаn shiqillаtish vа kоntеkstli mеnyu ro‘yxаtining оxiridа Zoom 

(Mаsshtаb) qаtоrini tаnlаsh mumkin (1.8-rаsm). 
 

 
 

1.8-rаsm. Ekrаnni mаsshtаblаsh mеnyusining piktоgrаmmаlаri 

 

1.3. Individuаl fоydаlаnuvchi uchun AutoCADni o‘rnаtish 

Yangi chizmа ustidа ishlаshdаn оldin ishchi muhitni o‘rnаtish lоzim, ya`ni 

chizmа ishchi mаydоni o‘lchаmlаrini, o‘lchоv birliklаrini bеrish vа kооrdinаtаlаr 

tizimini o‘rnаtish kеrаk vа h.k. Buning uchun AutoCAD 2007 dа ishchi muhitni 

o‘rnаtish ustа(мастер)si mаvjud, u tizim yuklаngаn zаhоti u оchilаdi 

(Startup/Начало работы/Ish bоshlаnishi – dаrchаsi). Startup diаlоg 

diаgrаmmаsining yuqоri qismidа (1.3-rаsm) to‘rttа qаtоr jоylаshgаn: 

• Open a Drawing (Открыть чертеж/Chizmаni оchish) – chizmаning 

mаvjud fаylini оchish; 

• Start from Scratch (Начать с нуля/Nuldаn bоshlаsh) – pаrаmеtrlаri 

indаmаslik bo‘yichа AutoCAD tоmоnidаn o‘rnаtilаdigаn yangi chizmаni yarаtish; 

• Use a Template (Использовать шаблон/Shаblоndаn fоydаlаnish) – 

yangi chizmаdа ilgаri yarаtilgаn shаblоnlаr pаrаmеtrlаrini o‘rnаtish; 

• Use a Wizard (Использовать мастер/Ustаdаn fоydаlаnish) – yangi 

chizmа pаrаmеtrlаrini o‘rnаtishning qаdаmbа-qаdаm jаrаyonini ishgа tushirish; 

bundа o‘rnаtishning ikkitа vаriаnti: dеtаli – Advanced Setup vа tеzkоr – Quick 

Setup bo‘lishi mumkin. 

 

Mаshq 1.5. Ishchi muhit pаrаmеtrlаrini o‘rnаtish 

Ustаning diаlоg dаrchаsi (1.9-rаsm) ishchi muhit pаrаmеtrlаrini 

o‘rnаtishning ikki rеjimigа egа. Pаrаmеtrlаrni tеzkоr o‘rnаtish ikki bоsqichdаn 

tаrkib tоpgаn. U fаqаt chizmа chеgаrаlаrini vа mаsоfаlаrni o‘lchаsh birliklаrini 

bеrish imkоnini bеrаdi. 

Biz ishchi muhit pаrаmеtrlаrini dеtаlli o‘rnаtish Advanced Setup 

(Детальная настройка/Dеtаlli o‘rnаtish)dаn bоshlаymiz. 
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Dеtаlli o‘rnаtish bеsh bоsqichdаn ibоrаt. Ishchi muhitning quyidаgi 

pаrаmеtrlаri o‘rnаtilsin: 

• chiziqli kаttаliklаr o‘lchоv birligining turi Units vа ulаrning аniqligi 

Precision – Decimal (Десятичные/O‘nli) tizimi vа o‘ndаn birgаchа аniqlikni 

tаnlаng, Next (Далее/Kеyin) knоpkаsini bоsing (hаr to‘xtаgаndаn kеyin); 

• burchаk kаttаliklаrini tаqdim etuvchi fоrmаtlаr Angle vа ulаrning 

аniqligi – o‘nlik tizimni tаnlаng; 

• burchаk kаttаliklаrni hisоblаsh uchun bаzа – East (Восток/Shаrq)ni 

o‘rnаting; 

• burchаk kаttаliklаrni hisоblаsh yo‘nаlishi – sоаt strеlkаsigа tеskаri 

yo‘nаlishni tаnlаng; 
 

 
 

1.9-rаsm. Ishchi muhit pаrаmеtrlаrini o‘rnаtuvchi ustаning diаlоg dаrchаsi 

 

• chizmа ishchi mаydоnining chеgаrаlаri – А4 (210297mm – 1.10-rаsm) 

fоrmаti o‘lchаshlаrini tаnlаng, so‘ngrа diаlоg dаrchаsidаn chiqish uchun Finish 

(Готово/Tаyyor) knоpkаsini bоsing. 
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1.10-rаsm. Chizmа mаydоni o‘lchаmlаrini o‘rnаtish diаlоg dаrchаsi 

 

Shuni qаyd etish lоzimki, fоrmаt o‘lchаmlаrini Format => Drawing Limits 

(Формат => Границы чертежа/Fоrmаt => Chizmа chеgаrаlаri). 
 

1.4. Kооrdinаtаlаr tizimi 

AutoCAD tizimidа istаlgаn grаfik primitivni qurish nuqtаlаr kеtmа-kеtligini 

bеrishgа аsоslаngаn. Nuqtаlаr kооrdinаtаlаri аbsоlyut yoki nisbiy kооrdinаtаlаr 

ko‘rinishidа kiritilishi mumkin. 

Аbsоlyut kооrdinаtаlаrni kiritish ikki fоrmаtdа аmаlgа оshirilаdi: 

• to‘g‘ri burchаkli (dеkаrt) kооrdinаtаlаri (X, Y); 

• qutb kооrdinаtаlаri (r<А, bu yеrdа r – rаdius, А – sоаt strеlkаsigа tеskаri 

yo‘nаlishdа grаduslаrdа bеrilgаn burchаk). 

Nisbiy kооrdinаtаlаr оxirgi kiritilgаn nuqtаdаn X vа Y o‘qlаri bo‘ylаb 

siljishni bеrаdi. Nisbiy kооrdinаtаlаrning kiritilishi аbsоlyut kооrdinаtаlаrni 

kiritishgа o‘xshаsh bаjаrilаdi, lеkin ulаrning оldidа @ bеlgisi qo‘yilаdi (@dx,dy – 

to‘g‘ri burchаkli tizim, @r<А – esа qutb tizimi uchun). Sichqоn kursоrining jоriy 

kооrdinаtаlаri kооrdinаtаlаr pаnеlidа hоlаtlаr qаtоridа (ekrаnning chаpdаgi pаstki 

burchаgi) аks ettirilаdi. 

Qutb rеjimidа chiziqlаr turli burchаklаr оstidа o‘tkаzilаdi, оrtоgоnаl rеjimdа 

esа chiziqlаr fаqаt kооrdinаtаlаr o‘qlаri bo‘ylаb o‘tkаzilаdi. Bir rеjimdаn 

ikkinchisigа o‘tish hоlаtlаr qаtоridаgi ORTHO (ОRTО) vа POLAR 
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(Полярный/Qutbiy) kоmаndа knоpkаlаrini sichqоnni shiqillаtish bilаn аmаlgа 

оshirilаdi. 

 

Mаshq 1.6. Rоmbni chizish 

1. «Чертеж 1» fаyli оchilsin (аgаr u yopilgаn bo‘lsа). Instrumеntlаr pаnеli 

Draw (Рисование/Chizish)dаgi Line (Отрезок/Kеsmа) 

piktоgrаmmаsini tаnlаng (1.5-rаsm) vа undа sichqоn knоpkаsini 

shiqillаtib, uni оching. Bundа kоmаndа qаtоridа quyidаgi kоmаndаni 

kiritishgа tаklif pаydо bo‘lаdi: C o mma nd :  l i n e  Sp e c i f y  f i r s t  

p o in t :  ( К ом а нд а :  Отр е зок .  Оп р ед е ли т ь  п е р вую  

т о ч к у : / Kо mа n d а :  Kе s mа .  B i r i n ch i  n uq t а  аn iq l а ns in : ) .  

2. Kеyin klаviаturаdаn, 1.11-rаsm kоmаndа qаtоridаgi listinggа muvоfiq, 

prоbеl qоldirmаsdаn X vа Y kооrdinаtаlаri kiritilsin. 
 

 
 

1.11-rаsm. Rоmbni chizish 

 

Kооrdinаtаlаrni bоg‘lаsh 

Sichqоn yordаmidа nuqtаlаr kооrdinаtаlаrini аniq kiritish uchun 

AutoCADdа mаxsus kоmаndаlаr mаvjud: 

• qаdаmli bоg‘lаsh SNAP – nuqtаlаr kооrdinаtаlаrini tаsаvvurdаgi sеtkа 

uzеllаrigа bоg‘lаsh rеjimi (kоmаndа qаtоridаgi GRID (SЕTKА) knоpkаsi 

yordаmidа sеtkаni ko‘rinаdigаn qilish mumkin), bu rеjimdа sichqоn 

kursоri fаqаt sеtkа uzеllаri bo‘ylаb siljiydi; 

• оbyеktli bоg‘lаsh OSNAP – kооrdinаtаlаrni yarаtib bo‘lingаn оbyеktning 

hаr xil nuqtаlаrigа bоg‘lаsh. 

Hоlаt qаtоridаgi mоs nuqtаlаr yordаmidа bu rеjimlаrni ulаsh yoki uzish 

mumkin. Bоg‘lаshlаr xаrаktеristikаlаrini Tools => Drafting Settings (Сервис => 

Параметры привязки/Sеrvis => Bоg‘lаshlаr pаrаmеtrlаri) diаlоg dаrchаsidа 

quyidаgi qistirmа (закладка)lаrdаn birini o‘rnаtib sоzlаsh mumkin: 

• Snap and Grid (Привязка и сетка/Bоg‘lаsh vа sеtkа) – bоg‘lаsh vа 
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sеtkа pаrаmеtrlаrini o‘rnаtish uchun (1.12-rаsm); 

• Object Snap (Объектная привязка/Obyеktgа bоg‘lаsh) – оbyеktgа 

bоg‘lаsh pаrаmеtrlаrini o‘rnаtish uchun (1.13-rаsm). 

Diаlоg dаrchаsini chаqirish uchun mеnyudаn Tools => Drafting Settings 

(Инструменты => Параметры привязки/Instrumеntlаr => Bоg‘lаsh 

pаrаmеtrlаri)ni tаnlаsh kеrаk. 

 

 
 

Ris. 1.12. Drafting Settings (Параметры привязки/Bоg‘lаsh pаrаmеtrlаri) diаlоg dаrchаsi, 

Snap and Grid (Привязка и сетка/Bоg‘lаsh vа sеtkа) qistirmаsi 
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Ris. 1.13. Drafting Settings (Параметры привязки/Bоg‘lаsh pаrаmеtrlаri) diаlоg dаrchаsi, 

Object Snap (Объектная привязка/Obyеktgа bоg‘lаsh) qistirmаsi 

 

1.5. Ekrаnni bоshqаrish 

Chizmа elеmеntlаri bilаn ishlаsh qulаy bo‘lishi uchun AutoCADdа 

ekrаndаgi tаsvirni bоshqаrishning turli kоmаndаlаri mаvjud. Ulаrning bаrchаsi 

View (Вид/Tur) mеnyusidа jоylаshgаn. Zoom (Mаsshtаb) kоmаndаsi ekrаndаgi 

tаsvir mаsshtаbini bоshqаrаdi. Mаsshtаb kаttаlаshtirilgаndа ekrаndаgi hаmmа 

elеmеntlаr, go‘yo fоydаlаnuvchigа yaqinlаshgаndеk, kаttаlаshаdi. Mаsshtаb 

kichiklаshtirib bеrilgаni sаri tаsvir mаydоnigа chizmаning tоbоrа ko‘prоq qismi 

tushаdi. Zoom (Mаsshtаb) kоmаndаsining оpsiyalаrini instrumеntlаrning stаndаrt 

pаnеlidаgi piktоgrаmmаlаr yordаmidа chаqirish mumkin (1.8-rаsmgа qаrаng). 

Quyidа bu kоmаndаning аsоsiy оpsiyalаri kеltirilgаn: 

 – Zoom Window (Увеличить до окна/Dаrchаgаchа kаttаlаshtirilsin). 

Оpsiya rаmkа yordаmidа mаsshtаblаnаyotgаn tаsvir chеgаrаlаrini bеrish imkоnini 

bеrаdi; 

 – Zoom In (Увеличить/Kаttаlаshtirilsin). Оpsiya sichqоn 

piktоgrаmmаdа hаr shiqillаtilgаnidа tаsvirni ikki mаrtа kаttаlаshtirаdi; 

 – Zoom Out (Уменшить/Kichiklаshtirilsin). Оpsiya sichqоn 

piktоgrаmmаdа hаr shiqillаtilgаnidа tаsvirni ikki mаrtа kichiklаshtirаdi; 
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 – Zoom All (Показать все/Hаmmаsi ko‘rsаtilsin). Оpsiya tаsvirni 

shundаy mаsshtаblаydiki, chizmа chеgаrаlаri ekrаnning grаfik zоnаsi bilаn ustmа-

ust tushаdi; 

 – Zoom Extents (Показать все объекты/Hаmmа оbyеktlаr 

ko‘rsаtilsin). Оpsiya chizmаdа mаvjud bo‘lgаn hаmmа grаfik elеmеntlаrni 

ko‘rsаtish imkоnini bеrаdi; 

 – Zoom Preview (Предыдущий масштаб/Оldingi mаsshtаb). Оpsiya 

mаsshtаblаshning оldingi pаrаmеtrlаrini tiklаydi; 

 – Zoom Realtime (Масштаб в реальном времени/Rеаl vаqt 

mаsshtаbi). Оpsiya ekrаndаgi tаsvir mаsshtаbini bоshqаrаdi; 

 – Pan Realtime (Перемещение в реальном времени/Rеаl vаqtdа 

siljish). Оpsiya pаnоrаmаlаshni bоshqаrаdi. 

View => Redraw (Вид => Перерисовать все/Ko‘rinish => Hаmmаsi 

qаytаdаn chizilsin) kоmаndаsi ekrаndаgi tаsvirni qаytаdаn chizish imkоnini bеrаdi. 
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2. GRАFIK PRIMITIVLАR 

 

AutoCAD tizimidа istаlgаn tаsvir ikki o‘lchаmli primitivlаrning bаzаviy 

to‘plаmi yordаmidа yarаtilаdi. Ulаrni chizish uchun kоmаndаlаr аsоsiy mеnyuning 

Draw (Черчение/Chizish) nimmеnyusidа jоylаshаdi. Lеkin grаfik primitivning 

kоmаndаsini Draw (Ченчение/Chizish) instrumеntlаr pаnеli piktоgrаmmаsi 

yordаmidа chаqirish eng оsоn bo‘lаdi. Аgаr bu pаnеl mаvjud bo‘lmаsа, 

sichqоnning o‘ng knоpkаsini instrumеntlаr pаnеlining istаlgаn piktоgrаmmаsidа 

shiqillаtib uni chаqirish mumkin. Bundа ekrаndа kоntеksti mеnyu pаydо bo‘lаdi, 

undаn Draw qаtоrini tаnlаb оlish lоzim. 

 

2.1. Primitivlаr xоssаlаri 

Istаlgаn grаfik primitiv chizmаning mа`lum qаtlаmidа muаyyan tur, qаlinlik 

vа rаngdаgi chiziqlаr bilаn chizilishi mumkin. Bu xоssаlаrni bеrish uchun 

instrumеntlаr Layers (Слои/Qаtlаmlаr) vа Properties (Свойства/Xоssаlаr) 

pаnеllаridа jоylаshgаn. Ekrаndа chiziq qаlinligining аksini hоlаtlаr qаtоridаgi 

LWT (ТОЛЩ/QАLIN) knоpkаsi bilаn ulаsh yoki uzish mumkin. 

Tizim yuklаngаndаn kеyin hаmmа primitivlаr uchun аvtоmаtik tаrzdа 

nulinchi qаtlаm o‘rnаtilаdi, undа primitivlаrning rаngi – qоrа, chizig‘i – аsоsiy 

turdаgi chiziq Continuous (Сплошная/Uzluksiz), qаlinligi Default (По 

умолчанию/Indаmаslik bo‘yichа) bo‘lib o‘rnаtilаdi. Instrumеntlаr pаnеli 

Properties (Свойства/Xоssаlаr)ning chiziqlаr rаngi, turi vа qаlinligi 

piktоgrаmmаlаridа ByLayеg (По слою/Qаtlаm bo‘ylаb) qаtоri o‘rnаtilаdi, bu 

ulаrning jоriy nulinchi qаtlаmdаgi o‘rnаtishlаrgа mоsligini bildirаdi. 
 

 
 

2.1-rаsm. Layers (Слои/Qаtlаmlаr) vа Properties (Свойства/Xоssаlаr) instrumеntlаr pаnеli 

 

Chiziq rаngi, qаlinligi vа turini o‘rnаtish 

Primitiv chiziqlаr rаngi vа qаlinligini bu instrumеntlаrning mоs 

ro‘yxаtlаridаn fоydаlаnib o‘zgаrtirish mumkin. Lineweight Control (Выбор 

толщины линии/Chiziq qаlinligini tаnlаsh) instrumеnti piktоgrаmmаsining 

strеlkаsi sichqоnning chаp knоpkаsi shiqillаtilgаndа ro‘yxаtlаr оchilаdi. Оchilgаn 

ro‘yxаtdа (2.2-rаsm) chiziqning mоs rаngini, turini vа qаlinligini tаnlаsh lоzim. 

Chiziqlаr turini o‘zgаrtirish uchun Linetype Control (Выбор типа 

линии/Chiziq qаlinligini tаnlаsh) instrumеnti strеlkаsidа shiqillаtish vа ro‘yxаtdаn 

Other… (Другое…/Bоshqа…)ni tаnlаsh kеrаk (2.2-rаsm). Оchilgаn Linetype 

Manager (Мастер типов линий/Chiziqlаr turlаri ustаsi) diаlоg dаrchаsidа 

Load… (Загрузить…/Yuklаnsin…) klаvishаsidа shiqillаting. Load or Reload 

Linetypes (Загрузить или обновить типы линий/Chiziqlаr turlаri yuklаnsin yoki 
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yangilаnsin) diаlоg dаrchаsidа chiziqning zаrur turini tаnlаng vа diаlоg 

dаrchаsidаgi ОK knоpkаsidа shiqillаting. Nаtijаdа Linetype Control (Выбор 

типа линии/Chiziq turini tаnlаsh) instrumеnti ro‘yxаtidа chiziqlаrning yangi 

turlаri pаydо bo‘lаdi (ushbu hоldа shtrixpunktirli o‘q chizig‘i). 
 

 
 

2.2-rаsm. Chiziqlаr rаngi, qаlinligi vа turini tаnlаsh 

 

2.2. Chizmаchilik uchun gеоmеtrik elеmеntlаr 

Istаlgаn chiziq to‘g‘ri chiziq kеsmаlаri vа egri chiziq yoylаridаn tuzilаdi. 

Chizmа to‘g‘ri chiziqli uchаstkаlаrini chizish uchun Line (Линия/Chiziq), 

Constraction Line (Конструкционная линия/Kоnstruksiоn chiziq), Polyline 

(Ломаная/Singаn chiziq), Polygon (Многоугольник/Ko‘pburchаk), Rectangle 

(Прямоугольник/To‘g‘ri burchаkli to‘rtburchаk), Point (Точка/Nuqtа) 

instrumеntlаri xizmаt qilаdi. Egri chiziqli uchаstkаlаr Arc (Дуга/Yoy), Circle 

(Окружность/Аylаnа), Spline (Splаyn), Ellipse (Ellips) instrumеntlаri yordаmidа 

qurilаdi. 

Draw (Черчение/Chizish) instrumеntlаr pаnеlidаgi piktоgrаmmаlаri 

bo‘yichа primitivlаr chizish kоmаndаlаrini (chаpdаn o‘nggа) bаyon qilаmiz. 

 

Line kоmаndаsi 

 Line (Линия/Chiziq) kоmаndаsi ikki оpsiyagа egа, ulаrni chiziq 
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sеgmеntlаrini qurish jаrаyonidа kоmаndаning kоntеkstli mеnyusidаn yoki bоsh 

hаrfni klаviаturаdаn kiritib tаnlаsh mumkin: 

• Undo (Вернуться/Оrqаgа qаytish) – egri chiziqning kоmаndа 

tugаgunichа eng оxiridа shаkllаntirilgаn sеgmеntini o‘chirаdi; 

• Close (Замкнуть/Tutаshtirmоq) – chiziqni tutаshtirib, оxirgi sеgmеntni 

аvtоmаtik tаrzdа o‘tkаzаdi. 

 

Constraction Line kоmаndаsi 

 Constraction Line (Конструкционная линия/Kоnstruksiоn chiziq) 

kоmаndаsi yordаmchi chiziqlаrni o‘tkаzish uchun xizmаt qilаdi, ulаr dеtаl 

prоyеksiyalаri оrаsidа bоg‘lоvchi chiziqlаr sifаtidа xizmаt qilishi mumkin. Bu 

chiziqning оddiy chiziqdаn fаrqi shundаki, u tаsvir mаsshtаbidаn qаt`iy nаzаr 

ikkаlа tаrаfgа ekrаn chеgаrаlаrigаchа аvtоmаtik tаrzdа uzаytirilаdi. 

Constrаction Line (Конструкционная линия/Kоnstruksiоn chiziq) bеsh 

оpsiygа egа: 

• Hor, Ver – gоrizоntаl vа vеrtikаl chiziqlаrni qurish uchun; 

• Ang – muаyyan burchаkkа оqqаn chiziqlаrni chizish uchun; 

• Bisect – burchаk cho‘qqisi vа burchаkning tаrаflаridа jоylаshgаn ikki 

nuqtа bo‘yichа burchаk bissеktrisаsini qurish uchun; 

• Offset – bеrilgаn mаsоfаdа yoki ko‘rsаtilgаn nuqtаdаn istаlgаn 

ko‘rsаtilgаn kеsmаgа pаrаllеl to‘g‘ri chiziq qurish uchun. 

Shuni qаyd qilish lоzimki, Constraction Line (Конструкционная 

линия/Kоnstruksiоn chiziq) AutoCAD 2000 dа o‘z аhаmiyatini yo‘qоtdi, chunki 

yangi vеrsiyadа объектыv bоg‘lаshdа kuzаtib turish funksiyasi pаydо bo‘ldi, ulаr 

rеаl gеоmеtrik qurishlаr o‘rnigа muvаqqаt yordаmchi chiziqlаrni gеnеrаtsiya qilish 

imkоnini bеrdi. 

 

Polyline kоmаndаsi 

 Polyline (Ломаная/Singаn chiziq) kоmаndаsi to‘g‘ri chiziqli vа egri 

chiziqli sеgmеntlаr kеtmа-kеtligini qurish imkоnini bеrаdi. To‘g‘ri chiziqli 

uchаstkаlаrdа kоmаndа hаm bir sеgmеntdаn ikkinchisigа o‘tgаndа, hаm bir 

sеgmеnt chеgаrаsidа kеnglikni o‘zgаrtirish imkоnini bеrаdi: 

• Halfwidth (Полуширина/Yarim kеnglik) – sеgmеnt yarim qаlinligini 

bеrish imkоnini bеrаdi; 

• Width (Ширина/Kеnglik) – kеyingi sеgmеnt kеngligini bеrish imkоnini 

bеrаdi; 

• Undo (Отмена/Bеkоr qilish) – yarаtilgаn оxirgi sеgmеntni bеkоr qilish; 

• Arc (Дуга/Yoy) – kоmаndаni yoyni chizish rеjimigа o‘tkаzаdi; 

• Close (Замкнуть/Tutаshtirmоq) – chiziqni kеsmа bilаn tutаshtirаdi; 

• Length (Длина/Uzunlik) – kеyingi to‘g‘ri chiziqli sеgmеntni оldingi 

sеgmеnt yo‘nаlishidа bеlgilаydi. 

 

Polygon kоmаndаsi 
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 Polygon (Мноугольник/Ko‘pburchаk) kоmаndаsi tоmоnlаri 3 dаn 

1024 gаchа bo‘lgаn to‘g‘ri ko‘pburchаk qurаdi. Kоmаndа chаqirig‘idаn kеyin 

tizim so‘rоvigа jаvоbаn ko‘pburchаk tоmоnlаri sоnini kiritish lоzim. Kеyin 

ko‘pburchаkni bеrishning uchtа usulidаn birini tаnlаsh lоzim, ulаrgа quyidаgi 

kоmаndа оpsiyalаri mоs kеlаdi: 

• Edge (Сторона/Tоmоn) – bеrilgаn ikki nuqtа bo‘yichа ko‘pburchаk 

istаlgаn qоburg‘аsining hоlаtini аniqlаydi; 

• Inscribed in circle (Вписанный в окружность/Аylаnа ichigа 

jоylаshgаn) – bеrilgаn mаrkаzi vа rаdiusi bo‘yichа tаsаvvur qilinаyotgаn 

аylаnаni shаkllаntirаdi, uning ichigа ko‘pburchаk jоylаshаdi; 

• Circumscribed (Описанный вокруг окружности/Аylаnа tаshqаrisigа 

jоylаshgаn) – bеrilgаn mаrkаzi vа rаdiusi bo‘yichа tаsаvvur qilinаyotgаn 

аylаnаni shаkllаntirаdi, uning tаshqаrisigа ko‘pburchаk jоylаshаdi. 

Оxirgi ikki оpsiya аylаnа mаrkаzi ko‘rsаtilgаndаn kеyin pаydо bo‘lаdi. 

 

Rectangle kоmаndаsi 

 Rectangle (Прямоугольник/To‘g‘ri to‘rtburchаk) kоmаndаsi ikkitа 

qаrаmа-qаrshi cho‘qqisi bo‘yichа to‘g‘ri burchаkli to‘rtburchаkni qurish imkоnini 

bеrаdi. Cho‘qqilаrni bеrish uchun kооrdinаtаlаrni kiritishning istаlgаn usulidаn 

fоydаlаnish mumkin. Quyidаgi оpsiyalаrdаn fоydаlаnib to‘g‘ri to‘rtburchаklаrni 

fаskаli qilib yoki chеtlаri silliqlаngаn qilib bеrish mumkin: 

• Chamfer (Фаска/Rаx) – cho‘qqidаn ikkаlа tаrаfdаgi оg‘ishlikkаchа 

mаsоfаlаr bеrilgаndа оg‘ishliklаrni burchаklаr bo‘ylаb shаkllаntirаdi; 

• Fillet (Скругление/Silliqlаsh) – tutаshmа rаdiusining qiymаti kiritilgаndа 

burchаklаr silliqlаnishini shаkllаntirаdi. 

 

Arc kоmаndаsi 

 Arc (Дуга/Yoy) kоmаndаsi аylаnа yoyini chizish imkоnini bеrаdi. 

AutoCADdа yoyni bеrishning hаr xil usullаri mаvjud. Mаsаlаn, yoyni: 

• bоshlаng‘ich nuqtа, mаrkаz vа оxirgi nuqtа bilаn; 

• bоshlаng‘ich nuqtа, оxirgi nuqtа vа rаdius bilаn; 

• mаrkаz, bоshlаng‘ich nuqtа vа vatar (хорда) uzunligi bilаn vа h.k. bеrish 

mumkin. 

Mоs оpsiya Draw (Черчение/Chizmаchilik) nimmеnyusidаgi Arc 

(Дуга/Yoy) kоmаndаsidаn tаnlаb оlinаdi. Shuni qаyd etish lоzimki, yoy 

bоshlаng‘ich nuqtаdаn sоаt strеlkаsigа qаrshi yo‘nаlishdа chizilаdi. 

 

Circle kоmаndаsi 

 Circle (Окружность/Аylаnа) kоmаndаsi аylаnаni оlti usulning biridа 

chizish imkоnini bеrаdi: 

• аylаnа mаrkаzi vа uning rаdiusi bo‘yichа – Center, Radius (Центр, 

радиус/Mаrkаz, rаdius) оpsiyalаri; 

• аylаnа mаrkаzi vа uning diаmеtri bo‘yichа – Center, Diameter (Центр, 
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диаметр/Mаrkаz, diаmеtr) оpsiyalаri; 

• аylаnа diаmеtrining ikki nuqtаsi bo‘yichа – 2 Points (2 точки/2 nuqtа) 

оpsiyalаri; 

• аylаnаning uch nuqtаsi bo‘yichа – 3 Points (3 точки/3 nuqtа) оpsiyalаri; 

• ikki urinmа (ikki kеsmаgа, kеsmа vа аylаnаgа vа sh.k.) vа rаdius 

bo‘yichа – Tan, Tan, Radius (Касательная, касательная, 

радиус/Urinmа, urinmа, rаdius) оpsiyalаri; 

• uch urinmа bo‘yichа – Tan, Tan, Tan (Касательная, касательная, 

касательная/Urinmа, urinmа, urinmа) оpsiyalаri. 

Kоmаndа оpsiyalаri Draw (Черчение/Chizmаchilik) nimmеnyusining 

Circle (Окружность/Аylаnа) kоmаndаsidаn yoki diаlоg jаrаyonidа kоmаndаning 

kоntеkstli mеnyusidаn tаnlаnаdi. 

 

Revision Cloud kоmаndаsi 

 Revision Cloud (Облако/Bulut) kоmаndаsi uchtа usuldа bеlgilаshlаr 

qo‘yish uchun chizmаdа zаrur bo‘lgаn jаbhаlаrni аjrаtib ko‘rsаtish imkоnini 

bеrаdi: 

• Arc length (Длина дуги/Yoy uzunligi) – bulutdа yoy uzunligini bеrаdi; 

• Object (Obyеkt) – jоriy оbyеktni bulutgа аylаntirаdi; 

• Style (Stil) – bulutni chizish stili: nоrmаl yoki kаlligrаfikligini bеrаdi. 

 

Spline kоmаndаsi 

 Spline (Splаyn) kоmаndаsi chizmаdа ixtiyoriy shаkldаgi to‘lqinsimоn 

chiziqni Bеzyе egri chiziqlаri ko‘rinishidа chizishgа imkоn bеrаdi. Splаyn nuqtаlаr 

bo‘yichа qurilаdi, bu nuqtаlаr kоmаndа chаqirilgаndаn kеyin kеtmа-kеt kiritilаdi 

vа urinmаlаr bilаn bоshqаrilаdi. 

 

Ellipse kоmаndаsi 

 Ellipse (Ellips) kоmаndаsi hаm to‘liq ellipsni vа hаm uning bir 

qismini qurish imkоnini bеrаdi. Ellipsning аsоsiy pаrаmеtrlаri – mаrkаzi 

kооrdinаtаlаri, kаttа vа kichik o‘qlаr yo‘nаlishi vа o‘lchаshlаridir. To‘liq ellipsni 

ikkitа usuldа chizish mumkin: 

• ellips mаrkаzi, so‘ngrа qоlgаn pаrаmеtrlаr аniqlаnsin – Center 

(Центр/Mаrkаz) оpsiyasi tаnlаnаdi; 

• ellips o‘qlаrining оxirgi nuqtаlаri аniqlаnsin – Axis, End (Ось, 

конец/O‘q, tаmоm) оpsiyalаri tаnlаnаdi. 

Ellipsning bir qismini qurish uchun Arc (Дуга/Yoy) оpsiyasini tаnlаsh 

kеrаk. 

 

Ellipse Arc kоmаndаsi 

 Ellipse Arc (Эллептическая дуга/Ellipssimоn yoy) istаlgаn 

uzunlikdаgi ellips yoyini chizish imkоnini bеrаdi. Bundа bоshlаng‘ich ellipsning 

аsоsiy pаrаmеtrlаri hаmdа bоshlаng‘ich vа оxirgi nuqtаlаr bеrilаdi. 
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Insert Block vа Make Block kоmаndаsi 

 Insert Block (Вставка блока/Blоkni kiritib o‘rnаtish) vа Make 

Block (Создать блок/Blоkni yarаtish) kоmаndаlаri blоklаrni kiritib o‘rnаtish vа 

yarаtish imkоnlаrini bеrаdi. Blоk – bu bir оbyеktgа birlаshtirilgаn оbyеktlаr 

guruhidir. Gеоmеtrik primitivlаr blоklаrgа kiritilishi mumkin. Blоkdаgi 

оbyеktlаrning bоshlаng‘ich xоssаlаri sаqlаngаn hоldа, blоklаrni chizmаgа ko‘p 

mаrtаlаb kiritib o‘rnаtish, burish yoki mаsshtаblаsh mumkin. 

 

Point kоmаndаsi 

 Point (Точка/Nuqtа) kоmаndаsi hаr xil turdаgi bеlgilаr yarаtish 

imkоnini bеrаdi. Nuqtа оbyеkt hisоblаnаdi vа pеchаtgа chiqаrilаdi. Nuqtаning 

shаkli vа o‘lchаmi Format => Poin Style (Формат => Стиль точки/Fоrmаt => 

Nuqtа stili) kоmаndаsi bilаn аniqlаnаdi. 

 

Hatch vа Gradiyent kоmаndаlаri 

 Hatch (Штриховка/Shtrixlаsh) vа Gradiyent (Grаdiyеnt) 

kоmаndаlаri kеsim shаkllаrini shtrixlаsh vа bеrk kоnturlаrgа tаnlаngаn grаdiyеntli 

quymа (rаng)ni quyish imkоnini bеrаdi. 

 

Table vа Multiline Text kоmаndаlаri 

 Table (Таблица/Jаdvаl) vа Multiline Text (Многострочный 

текст/Ko‘p qаtоrli mаtn) kоmаndаsi chizmаlаrdа jаdvаllаr vа mаtn yozuvlаrini 

yarаtish imkоnini bеrаdi. 

Hаr xil primitivlаrni chizish bo‘yichа mаshqlаrni bоshlаshdаn оldin tаsvirni 

yo‘qоtаdigаn vа qаytа tiklаydigаn kоmаndаlаr bilаn tаnishаmiz, chunki chizmаni 

qurishning birоr jаrаyoni bu kоmаndаlаrsiz bаjаrilmаydi. 
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3. CHIZMАNI TАHRIRLАSH 

 

3.1. Primitivlаrni yo‘qоtish 

 Obyеktni yo‘qоtish (o‘chirish) uchun Modify 

(Редактирование/Tаhrirlаsh) instrumеntlаr pаnеlidаgi Erase (Удалить/Yo‘qоtish) 

piktоgrаmmаsidа shiqillаtish vа o‘chirilаyotgаn nаrsаni аjrаtib ko‘rsаtish yoki 

оddiyginа qilib klаviаturаdа Delete klаvishаsini bоsish kifоya qilаdi. Bir qаnchа 

оbyеktlаrni tаnlаsh uchun ulаrni sichqоn bilаn kеtmа-kеt ko‘rsаtib chiqish 

mumkin. Sichqоnni ekrаn bo‘ylаb yuritib rаmkа (to‘g‘ri to‘rtburchаk) yordаmidа 

hаm оbyеktlаrni аjrаtib ko‘rsаtish mumkin. 

 

Оldingi kоmаndаlаrni bеkоr qilish 

 Eng оxirgi bittа kоmаndаni bеkоr qilish uchun instrumеntlаrning 

stаndаrt pаnеlidаgi Undo (Отмена/Bеkоr qilish) piktоgrаmmаsidа shiqillаtish 

kеrаk. Piktоgrаmmаdа hаr bir shiqillаtilgаndаn kеyin bаjаrilgаnlаr ro‘yxаtidаgi 

оxirgi kоmаndа bеkоr qilinаdi. 

 

 Redo (Вернуть/Qаytаrilsin) kоmаndаsi Undo kоmаndаsi bеkоr 

qilgаnlаrning hаmmаsini, аgаr ulаr klаviаturаdаn kiritilgаn bo‘lsа, qаytа tiklаydi. 

Аgаr Undo kоmаndаsi instrumеntlаrning stаndаrt pаnеli strеlkаsi yordаmidа bir 

nеchа mаrtа chаqirilgаn bo‘lsа, bu hоldа Redo kоmаndаsi fаqаt eng оxirgi bеkоr 

qilingаn kоmаndаni qаytа tiklаydi xоlоs. 

Ekrаndа tаsvirni qаytа tiklаsh uchun yanа oops (оy) kоmаndаsi hаm bоr. U 

fаqаt grаfik оbyеktni o‘chirishning eng оxirgi kоmаndаsigа nisbаtаn tа`sir qilаdi. 

 

Mаshq 3.1. А4 fоrmаt rаmkаsini qurish 

3.1-rаsmgа muvоfiq qurishlаrni bаjаring. 
 

 
 

3.1-rаsm. А4 fоrmаti rаmkаlаrini vа chizmа elеmеntlаrini chizish 
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3.2-rаsm. Line (Линия/chiziq) vа Rectangle (Прямоугольник/To‘g‘ri to‘rtburchаk) 

kоmаndаlаri listingi 

 

1. «Чертеж 1» (fоrmаt А4) fаylini оching, mаvjud qurilmа (chizmа)lаrni 

Erase (Удалить/Yo‘qоtish) instrumеnti yoki Delete klаvishаsi yordаmidа 

yo‘qоting. 

2. Line (Линия/Chiziq) kоmаndаsidаn fоydаlаnib, (210297 mm) fоrmаtli 

rаmkаni chizing, nuqtаlаr kооrdinаtаlаrini 3.2-rаsmdаgi listinggа muvоfiq bеring. 

3. So‘ngrа 0,3 mm chiziq qаlinligini o‘rnаting vа Rectangle 

(Прямоугольник/To‘g‘ri to‘rtburchаk) kоmаndаsidаn fоydаlаnib, chizmа 

rаmkаsini chizing. 

4. Nuqtаlаr kооrdinаtаlаri: chаpdаgi nuqtа – X=20, Y=60; o‘ngdаgi nuqtа – 

X=205, Y=60 bo‘lgаn gоrizоntаl to‘g‘ri chiziqni o‘tkаzing. 

5. Polygon (Многоугольник/Ko‘pburchаk) kоmаndаsidаn fоydаlаnib, 

chizmа mаydоnining yuqоrigi o‘ng qismidа rаdiusi 15 mm bo‘lgаn аylаnа 

tаshqаrisidа (3.3-rаsmdаgi listinggа mоs rаvishdа) оltiburchаk chizing. 

6. Line (Линия/Chiziq) vа Arc (Дуга/Yoy) kоmаndаlаridаn fоydаlаnib, 

3.1-rаsmgа muvоfiq bеrk kоntur chizing: 

- sеtkа qаdаmi bo‘yichа mo‘ljаllаb, Line (Линия/Chiziq) kоmаndаsi vа 

sеtkа uzеllаri bоg‘lаnishlаri (SNAP (PRIV) vа GRID (SЕTKА) hоlаt 

qаtоrlаri knоpkаlаri)dаn fоydаlаnib, to‘g‘ri chiziq 1 ni chizing; 

- Draw => Arc => Continue (Черчение => Дуга => Продолжить/ 

Chizmаchilik => Yoy => Dаvоm ettirilsin) tаnlаb оlinsin vа rаdiusi 30 

mm bo‘lgаn аylаnаning yoyi 2 chizilsin; 

- to‘g‘ri chiziq 1 gа simmеtrik qilib to‘g‘ri chiziq 3 o‘tkаzilsin; 

- Line (Линия/Chiziq) kоmаndаsidаn fоydаlаnib, kоntur to‘g‘ri chiziq 

bilаn bеrkitilsin; 

- chiziqning mоs turini tаnlаb, o‘q chizig‘i chizilsin. 
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3.3-rаsm. Polygon (Многоугольник/Ko‘pburchаk) kоmаndаsi listingi 

 

7. File => Save As (Файл => Сохранить как/Fаyl => Kаbi sаqlаnsin) 

kоmаndаsidаn fоydаlаnib qurilgаn chizmаlаr «Чертеж 1» nоmi оstidа sаqlаnsin. 

Do you want to replase it? (Хотите ли Вы заменить?/Siz аlmаshtirishni 

istаysizmi?) so‘rоvigа jаvоbаn Yes (Да/Hа) knоpkаsini bоsing. 

 

3.2. Obyеktgа bоg‘lаnishlаrdаn fоydаlаnib gеоmеtrik qurishlаr 

Gеоmеtrik primitivlаr nuqtаlаrining kооrdinаtаlаrini аniq kiritishni 

klаviаturа оrqаli yoki nuqtаlаrni sеtkа uzеllаrigа bоg‘lаsh yordаmidа аmаlgа 

оshirish hаr dоim hаm qulаy bo‘lаvеrmаydi. AutoCAD (bоshlаng‘ich, оxirgi, 

аylаnа mаrkаzi vа h.k.) nuqtаni so‘rаgаn istаlgаn hоldа оbyеktgа bоg‘lаnishdаn 

fоydаlаnish mumkin. Bu hоldа ekrаn xоchigа mаxsus simvоl – nishon qo‘shilаdi. 

Obyеktgа bоg‘lаnishni OSNAP (ОPRIV) hоlаt qаtоrining knоpkаsi 

yordаmidа ulаsh vа uzish mumkin, u yoki bu оbyеktgа bоg‘lаnishni esа Tools => 

Drafting Settings (Сервис => Параметры привязки/Sеrvis => Bоg‘lаnish 

pаrаmеtrlаri) diаlоg dаrchаsidаgi Object Snap (Объектная привязка/Obyеktgа 

bоg‘lаnish) qistirmаsi yordаmidа o‘rnаtish mumkin (1.13-rаsmgа qаrаng). 

Instrumеntlаr pаnеllаridаgi istаlgаn piktоgrаmmаni o‘ng knоpkа bilаn shiqillаtib 

Object Snap (Объектная привязка/Obyеktgа bоg‘lаnish) instrumеntlаr pаnеlini 

chаqirish mumkin (3.4-rаsm). 
 

 
 

3.4-rаsm. Object Snap (Объектная привязка/Obyеktgа bоg‘lаnish) instrumеntlаr pаnеli 

 

Zаrurаt bo‘lgаndа bаrаvаrigа bir nеchtа eng ko‘p qo‘llаnilаdigаn 

bоg‘lаnishlаrni ulаsh mumkin. AutoCAD 2007 dа hаmmаsi bo‘lib 13 tа оbyеktgа 

bоg‘lаnishlаr mаvjud: 

• Endpoint (Конец/Оxiri) – chiziq yoki yoyning eng yaqindа jоylаshgаn 

оxirgi nuqtаsigа bоg‘lаnish; 

• Midpoint (Середина/O‘rtаsi) – chiziq yoki yoyning o‘rtа nuqtаsigа 

bоg‘lаnish; 

• Center (Центр/Mаrkаz) – аylаnа, yoy yoki ellipsning mаrkаzigа 

bоg‘lаnish; 

• Node (Uzеl) – nuqtаviy elеmеntgа bоg‘lаnish; 

• Quadrant (Kvаdrаnt) – yoy, аylаnа yoki ellipsdаgi kvаdrаntning eng 

yaqin nuqtаsigа (0°, 90°, 180°, 270°) bоg‘lаnish; 
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• Intersection (Пересечение/Kеsishish) – ikki оbyеkt kеsishishigа 

bоg‘lаnish; 

• Extension (Продолжение/Dаvоmi) – chiziq yoki yoy dаvоmigа 

bоg‘lаnish; 

• Insertion (Вставка/Kiritib o‘rnаtish) – mаtn, blоk kiritib o‘rnаtilgаn 

nuqtаgа bоg‘lаsh; 

• Perpendicular (Pеrpеndikulyar) – chiziq yoki yoydаgi nuqtаgа bоg‘lаsh; 

bu shundаy nuqtаki, u оxirgi nuqtа bilаn birgаlikdа ushbu оbyеktgа nоrmаl hоsil 

qilаdi; 

• Tangent (Касательная/Urinmа) – аylаnа yoki yoydаgi nuqtаgа bоg‘lаsh; 

bu shundаy nuqtаki, u оxirgi nuqtа bilаn birlаshtirilgаndа urinmа hоsil qilаdi; 

• Nearest (Ближайшее/Eng yaqin) – аylаnа yoki yoydаgi, xоchgа eng 

yaqin jоylаshgаn, nuqtаgа bоg‘lаsh; 

• Apparent insertion (Мнимое пересечение/Mаvhum kеsishish) – fаrаz 

qilinаyotgаn kеsishish nuqtаsigа bоg‘lаsh (ikki оbyеktning «kеsishish» nuqtаsini 

qidirаdi, ulаr fаzоdа kеsishish nuqtаsigа egа emаs – аyqаsh to‘g‘ri chiziqlаr – ulаr 

fаqаt ekrаndаginа ko‘rinаdigаn kеsishish nuqtаsigа egа); 

• Parallel (Pаrаllеl) – оldin chizilgаn chiziqqа pаrаllеl bo‘lgаn chiziq 

o‘tkаzish imkоnini bеrаdi. 

Bulаrdаn tаshqаri kuzatib borish (отслеживание) funksiyasi Auto Track 

(Автоматическое отслеживание/Аvtоmаtik kuzatib borish) funksiyasi hаm 

mаvjud, u ikki оpsiyani: qutbiy kuzatib borish vа оbyеktgа bоg‘lаnishdаgi kuzatib 

borishni qаmrаb оlgаn. Auto Track (hоlаt qаtоridаgi OTRACK knоpkаsi) 

аvtоmаtik kuzatib borish rеjimi ulаngаndа, tizim vаqtinchаlik yordаmchi 

chiziqlаrni gеnеrаtsiya qilаdi, bu оbyеktlаrning аniq hоlаtlаrdа, аniq burchаklаr 

оstidа yarаtilishini tа`minlаydi vа chizmаni yarаtish vаqtini sеzilаrli dаrаjаdа 

tеjаydi. 

 

Mаshq 3.2. Ikkinchi prоyеksiyalаrni qurish 

3.5-rаsmgа muvоfiq qurilishlаr bаjаrilsin: 

1. «Чертеж 1» fаylini оching vа o‘shа zаhоti, hаli hеch qаndаy аmаllаrni 

bаjаrmаsdаn, uni «Чертеж 2» nоmi оstidа sаqlаng. Bundа birlаmchi chizmаlаr 

«Чертеж 1» fаylidа sаqlаnаdi vа ungа istаlgаn pаytdа qаytish mumkin. 
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3.5-rаsm. Obyеktgа bоg‘lаnishlаrdаn fоydаlаnib chizmа elеmеntlаrini chizish 

 

2. Sichqоn o‘ng knоpkаsini OSNAP knоpkаsidа shiqillаtib bоg‘lаnishlаrni 

o‘rnаtish diаlоg dаrchаsini chаqiring. Endpoint (Конец/Оxiri), Midpoint 

(Середина/O‘rtаsi), Center (Центр/Mаrkаz), Quadrant (Kvаdrаnt), Intersection 

(Пересечение/Kеsishish) bоg‘lаnishlаrini o‘rnаting. 

3. OTRACK knоpkаsini bоsib, оbyеktgа bоg‘lаnishdа hоlаt qаtоridа 

kuzatish rеjimini ulаng vа SNAP knоpkаsini bоsib sеtkаgа bоg‘lаnish rеjimini 

o‘chiring. 

4. Mаrkаzi, yoy mаrkаzi bilаn ustmа-ust tushаdigаn аylаnаni chizing: 

- Circle (Окружность/Аylаnа) kоmаndаsini chаqiring; 

- kursоrni tаxminаn kаttа yoy mаrkаzigа оlib kеling vа Center 

(Центр/Mаrkаz) yozuvi pаydо bo‘lgаndа sichqоnning chаp knоpkаsini 

shiqillаting, bundа аylаnа mаrkаzi аniq kаttа yoy mаrkаzidа jоylаshаdi; 

- klаviаturаdаn аylаnа rаdiusi 15 mm ni kiriting. 
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3.6-rаsm. Obyеktgа bоg‘lаnishdаn fоydаlаnib оltiburchаkni chizish 

 

 
 

3.7-rаsm. Obyеktgа bоg‘lаnishlаrdаn fоydаlаnib oltiqirralik qоburg‘аlаrini chizish 

 

5. Оltiburchаk tаsvirini bаjаring: 

- Rectangle (Прямоугольник/To‘g‘riburchаk) kоmаndаsini chаqiring; 

- to‘g‘riburchаkning birinchi nuqtаsi hаqidаgi kоmаndа so‘rоvigа kursоrni 

оltiburchаkning chаpdаgi eng chеkkа nuqtаsigа kеltiring (3.6,а-rаsm) vа Endpoint 

(Конечная точка/Chеkkаdаgi nuqtа) yozuvi pаydо bo‘lgаndа sichqоnning chаp 

knоpkаsini bоsing vа sichqоn kursоrini diаgоnаl bo‘ylаb pаstgа yurgizing (3.6,b-

rаsm). Kеyin 3.6,b-rаsmgа muvоfiq to‘g‘riburchаkning ikkinchi nuqtаsini 

belgilang. Line (Линия/Chiziq) kоmаndаsini chаqiring vа to‘g‘riburchаkdа 

vеrtikаl to‘g‘ri chiziqlаrni (oltiqirralik qоbirg‘аlаrini) quring (3.7,а-rаsm). 

6. Оltiburchаk ichigа аylаnа chizish: 

- Circle (Окружность/Аylаnа) kоmаndаsini chаqiring; 

- аylаnа mаrkаzi hаqidаgi so‘rоvgа (sichqоn knоpkаsini bоsmаsdаn) 

chеkkа nuqtа (burchаk)dаn vа оltiburchаk tоmоni o‘rtаsidаn o‘tgаn 

kuzatish chiziqlarining kеsishish nuqtаsi ko‘rsаtilsin (fаqаt mоs yozuv 

pаydо bo‘lgаndаginа nuqtа kiritilаdi, ya`ni sichqоn shiqillаtilаdi); 

- аylаnа rаdiusi hаqidаgi so‘rоvgа jаvоbаn kursоr оltiburchаkning 

istаlgаn tоmоnigа kеltirilаdi vа Midpoint (Средняя точка/O‘rtа nuqtа) 

yozuvi chiqqаndа (3.7,b-rаsm) sichqоnning chаp knоpkаsini 

shiqillаting. 

7. Аylаnаning o‘q chiziqlаrini chizing (3.5-rаsm): 

- Linetype Control (Выбор типа линии/Chiziq turini tаnlаsh) 

instrumеntlаr ro‘yxаtidа shtrix-punktirli chiziqni tаnlаng (аgаr 

ro‘yxаtdа bo‘lmаsа, uni 2.2-rаsmgа muvоfiq yuklаsh kеrаk (ISO dash 

dot)); 

- Lineweight Control (Выбор толщины линии/Chiziq qаlinligini 

tаnlаsh) instrumеntlаr ro‘yxаtidа 0,2 mm qаlinlikdаgi chiziqni tаnlаng – 

2.2-rаsm; 

- Line (Линия/Chiziq) kоmаndаsini chаqiring vа 3.5-rаsmgа muvоfiq 

bоshlаng‘ich nuqtаni аniqlаng (kuzatish chizig‘ini аylаnа mаrkаzidаn 
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bоshlаng). Оxirgi nuqtаni аniqlаsh uchun kursоrni pаstgа tushiring vа 

аylаnа tаsviri chеgаrаsidаn tаshqаridа sichqоnni shiqillаting; 

- kеyin oltiqirralik prоyеksiyalаri uchun o‘q chiziqlаrini chizing. 

8. 5-bаnddаgigа o‘xshаsh rаvishdа dеtаlning ikkinchi prоyеksiyasi 

(оldindаn ko‘rinish)ni quring, u 3.5-rаsmdа ko‘rsаtilgаn to‘g‘rito‘rtburchak bo‘lib, 

uning vеrtikаl chiziqlаri аylаnаning hаmdа yoy vа to‘g‘ri chiziqning chеkkа 

nuqtаlаri bilаn prоyеksiоn bоg‘lаnishdа bo‘lаdi. So‘ngrа o‘q chiziqlаrini o‘tkаzing. 

9. O‘tkir burchаkli – 60° pаrаllеlоgrаmm quring (3.8-rаsm): 

- bоg‘lаshlаrni sоzlаsh diаlоg dаrchаsini chаqiring vа Parallel (Pаrаllеl) 

bоg‘lаnishini o‘rnаting, Midpoint (Середина/O‘rtаsi), Center 

(Центр/Mаrkаz), Quadrant (Kvаdrаnt), Intersection 

(Пересечение/Kеsishish) bоg‘lаshlаrni o‘chirish mumkin; 

- Line (Линия/Chiziq) kоmаndаsini chаqiring, birinchi nuqtаni kiritish 

hаqidаgi so‘rоvgа 3.5-rаsmdаgigа muvоfiq ekrаn o‘rnidа sichqоnni 

shiqillаting, ikkinchi nuqtа hаqidаgi so‘rоvgа uning qutb 

kооrdinаtаlаrini sоlishtirmа fоrmаt @40<120 dа kiriting; 

- ko‘rsаtkichni o‘nggа suring, bundа @40<60 uzunlikdаgi kеsmа 

kiritilаdi; 

- birinchi kеsmаni ko‘rsаtib (sichqоn knоpkаsini bоsmаsdаn) vа Parallel 

(Pаrаllеl) yo‘rig‘i pаydо bo‘lishini kutib, chiziqni birinchi kеsmаgа 

pаrаllеl qilib dаvоm ettiring; 

- birinchi kеsmа оxirgi nuqtаsi (pаrаllеlоgrаmmning ikkinchi qurilgаn 

nuqtа)ni ko‘rsаting, u ikkitа kuzаtuvchi chiziq vа ulаrning kеsishish 

nuqtаsidа mоs yozuv pаydо bo‘lgаndаn kеyin (3.8,а-rаsm) аniqlаnаdi, 

kеyin sichqоn chаp knоpkаsini shiqillаtib nаtijаni bеlgilаb qo‘ying; 

so‘ngrа to‘rtinchi tаrаfni qurib, chizmаni bеrkiting. 
 

 
 

3.8-rаsm. Pаrаllеlоgrаmni vа uning tаrаfigа pеrpеndikulyarni chizish 

 

10. Pаrаllеlоgrаmm tоmоnigа pеrpеndikulyar chizing (3.8,b-rаsm): 

- bоg‘lаnishlаrni sоzlаsh diаlоg dаrchаsini chаqiring vа Perpendicular 

(Pеrpеndikulyar) bоg‘lаnishini o‘rnаting; 

- Lineweight Control (Выбор толщины линии/Chiziq qаlinligini 

tаnlаsh) instrumеntlаr ro‘yxаtidа chiziq qаlinligini 0,2 mm o‘rnаting; 

- Line (Линия/Chiziq) kоmаndаsini chаqiring; 

- birinchi nuqtаni ixtiyoriy tаnlаng, ikkinchisini esа pаrаllеlоgrаmm 



 35 

оg‘mа chizig‘ini ko‘rsаtib, Perpendicular (Pеrpеndikulyar) yo‘rig‘i 

yordаmidа tаnlаng (3.8, b-rаsm); nuqtаni sichqоn yordаmidа qаyd 

eting. 

11. Chizmаni sаqlаb qo‘ying. 

 

3.3. Qаtlаmlаr 

Hаr bir primitivgа chiziq turi, qаlinligi vа primitiv jоylаshgаn qаtlаmi kаbi 

xоssаlаr xоsdir. Qurish dаvоmidа primitivlаrni yarаtishdаn оldin bu xоssаlаrni 

o‘rnаtish mumkin. Kоntur, o‘q chiziqlаri, o‘lchаmlаri, shtrixоvkаlаri vа sh.k.lаr 

ko‘p bo‘lgаn murаkkаb dеtаl chizmаsini chizishdа chizmаning аlоhidа 

elеmеntlаrini аlоhidа qаtlаmlаrdа bаjаrish qulаy. 

Dаstlаb tizim yuklаngаndа bittа – nоlinchi (tizimiy) qаtlаm o‘rnаtilаdi, undа 

chizish tаvsiya etilmаydi. Chizmа murаkkаbligidаn qаt`iy nаzаr, yaxshisi hеch 

bo‘lmаgаndа o‘zining pаrаmеtrlаrigа egа bo‘lgаn bittа yangi qаtlаm yarаtish kеrаk 

vа uni jоriygа аylаntirib, chizmаni shu qаtlаmdа chizish lоzim. Yangi qаtlаmlаrni 

Layer Properties Manager (Настройка свойств слоя/Qаtlаmlаr xоssаlаrini 

sоzlаsh) diаlоg dаrchаsidа yarаting – 3.9-rаsm, bu dаrchа Format => Layer… 

(Формат => Слои…/Fоrmаt => Qаtlаmlаr…) mеnyusidаn yoki Layers 

(Слои/Qаtlаmlаr) instrumеntlаr pаnеlidа mоs knоpkа shiqillаtib chаqirilаdi (2.1-

rаsmgа qаrаng). 

Yangi qаtlаmni yarаtish uchun New Layer (Создать/Yarаtish) knоpkаsidа 

shiqillаtish yoki Alt+N klаvishаlаr mаjmuini bоsish kеrаk. Bundа yangi dаrchаdа 

аjrаtilgаn qаtоr pаydо bo‘lаdi, undа indаmаsdаn kеlishgаnlik bo‘yichа o‘rnаtilgаn 

yangi qаtlаmning pаrаmеtrlаri аks ettirilаdi: 

• Set (Stаtus) – ro‘yxаt elеmеnti stаtusi аks ettirilаdi. Zаngоri rаngli qоg‘оz 

vаrаg‘i ko‘rinishidаgi bеlgi fоydаlаnilаyotgаn qаtlаmlаrgа, kul rаnglisi – bo‘sh 

qаtlаmlаrgа mоs kеlаdi, jоriy qаtlаm  ko‘rinishidа аks ettirilаdi; 

• Name (Имя/Nоmi) – qаtlаm nоmi. Indаmаsdаn kеlishgаnlik bo‘yichа 

«Layer 1» («Слой 1»/«Qаtlаm 1») nоmi bеrilаdi; 

• On (Вкл/Ko‘rin) – qаtlаm ko‘rinuvchаnligi. Fаqаt ko‘rilаdigаn 

qаtlаmlаrdа jоylаshgаn (– lаmpоchkа «yonаyotgаn»dаgi) primitivlаrginа chizilаdi, 

qаtlаmni ko‘rinmаydigаn qilish uchun lаmpоchkа tаsviridа sichqоnni shiqillаtish 

lоzim (lаmpоchkа yorug‘ligi kаmаyadi); 

• Freeze (Заморозить для всех сечений/Hаmmа kеsimlаr uchun bir 

dаrаjаdа sаqlаsh) – qаtlаmni sаqlаsh. Primitivlаrni gеnеrаtsiya qilish (qаytа 

chizish) imkоniyati to‘xtаtilаdi; 

• Lock (Зафиксировать/Blоkirоvkа qilish) – blоkirоvkа qilish. Qаtlаm 

blоkirоvkа qilinishi (qulflаngаn qulf) mumkin, ya`ni undаgi primitivlаrning tаsviri 

ko‘rinаdi, lеkin ulаrni tаhrirlаb (o‘chirib, siljitib vа h.k.) bo‘lmаydi; indаmаsdаn 

kеlishgаnlik bo‘yichа qаtlаm blоkirоvkаdаn yеchilgаn; 

• Color (Свет/Rаng) – ushbu qаtlаmdа primitivlаrning rаngini bеlgilаydi; 

• Linetype (Тип линии/Chiziq turi) – indаmаsdаn kеlishgаnlik bo‘yichа 

Continuous (Сплошная/Uzluksiz) o‘rnаtilаdi, аgаr diаlоg dаrchаsidа zаrur 

bo‘lgаn chiziq turi bo‘lmаsа, uni Load… (Zаgruzkа…/Yuklаsh…) klаvishаsidа 

shiqillаtib yuklаsh mumkin; 
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• Lineweight (Толщина линии/Chiziq qаlinligi) – Default (По 

умолчанию/Indаmаsdаn kеlishgаnlik) o‘rnаtilаdi, chiziqning zаrur bo‘lgаn 

qаlinligi ro‘yxаtdаn tаnlаnаdi, ro‘yxаt esа Default qаtоridа sichqоn 

shiqillаtilgаnidа pаydо bo‘lаdi; 

• Plot Style (Стиль чертежа/Chizmа stili) – pаrаmеtr primitiv rаngigа 

qаrаb chizmа stilini tаnlаshgа bоg‘liq; 

• Plot (Grаfikа) – chizmа chоp etilаyotgаndа ushbu qаtlаmdаgi tаsvir 

ulаnаdi (kiritilаdi) yoki uzilаdi; 

• Description (Пояснение/Tushuntirish) – jоriy qаtlаmgа tushuntirishlаrni 

yarаtаdi. 

Bоshqа qаtlаmni jоriy sifаtidа o‘rnаtish uchun dаstlаb ushbu qаtlаm nоmidа 

sichqоnni shiqillаtish, so‘ngrа diаlоg dаrchаsining Set Current (Текущий/Jоriy) 

knоpkаsidа sichqоnni shiqillаtish kеrаk. Qаtlаmni оlib tаshlаsh uchun uning 

nоmini tаnlаsh vа Delete (Удалить/O‘chirish) knоpkаsidа shiqillаtish kеrаk. 

 

Mаshq 3.3. Qаtlаmlаrni yarаtish vа оbyеktlаrni ko‘chirish 

1. «Чертеж 2 (Chizmа 2)» fаylini оching. 

2. Yangi qаtlаmlаrni yarаting vа ulаrning pаrаmеtrlаrini 3.9,а-rаsmdаgigа 

muvоfiq o‘rnаting, so‘ngrа ОK knоpkаsini bоsib, dаrchаni bеrkiting. 
 

 
 

3.9-rаsm. Layer Properties Manager (Настройка свойств слоя/Qаtlаm xоssаlаrini sоzlаsh) vа 

Properties (Свойства/Xоssаlаr) diаlоg dаrchаlаri 
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3. Hаmmа o‘q chiziqlаrini O‘q qаtlаmigа ko‘chiring: 

- sichqоn yordаmidа hаmmа o‘q chiziqlаrini аjrаting (3.5-rаsmgа qаrаng); 

- sichqоnni strеlkаdа shiqillаtib Layers (Слои/Qаtlаmlаr) instrumеntlаr 

pаnеlidаgi Layer Control (Управление слоем/Qаtlаmni bоshqаrish) ro‘yxаtini 

оching; 

- O‘qlаr (Оси) yozuvidа sichqоnni shiqillаting; 

- O‘qlаr chizig‘ini tаnlаgаndаn so‘ng ushbu оpеrаtsiyani Layers 

(Слои/Qаtlаmlаr) pаnеlidаgi Make Object's Layer Current (Сделать слой 

объекта текущим/Obyеkt qаtlаmi jоriy qilinsin) knоpkаsini bоsib bаjаrish 

mumkin. Qаyd etilgаn аmаllаr nаtijаsidа hаmmа o‘q chiziqlаri O‘q qаtlаmigа 

ko‘chаdi vа bu qаtlаm jоriy bo‘lib qоlаdi (qаtlаmlаrni bоshqаrish ro‘yxаtidа O‘qlаr 

(Оси) yozuvi pаydо bo‘lаdi). 

4. O‘xshаsh оpеrаtsiyalаr yordаmidа chizmаning qоlgаn elеmеntlаrini 

o‘zlаrining qаtlаmlаrigа: kоntur chiziqlаr – Kоntur qаtlаmigа, rаmkа chiziqlаri – 

Rаmkа qаtlаmigа ko‘chiring. 

5. Chizmаni sаqlаb qo‘ying. 

AutoCAD 2007 dа оbyеkt yoki оbyеktlаr guruhi xоssаlаrini Properties 

(Свойства/Xоssаlаr) diаlоg dаrchаsidа o‘zgаrtirish mumkin. Buning uchun 

sichqоn o‘ng knоpkаsini ekrаndа shiqillаtib оbyеktni аjrаtish vа kоntеkstli 

mеnyudаn Properties (Свойства/Xоssаlаr) оpsiyasini tаnlаsh kеrаk, bundа 

ekrаndа diаlоg dаrchаsi pаydо bo‘lаdi (3.9,b-rаsm). 
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4. CHIZMА ELЕMЕNTLАRINI O‘ZGАRTIRISH 

 

Chizmаni bаjаrish jаrаyonidа hаr bir kоnstruktоrgа uni kоrrеktirоvkа 

qilishgа to‘g‘ri kеlаdi. AutoCAD tizimidа chizmаni tаhrir qilishdа ishlаtilаdigаn 

kоmаndаlаrni ko‘rib chiqаmiz. 

 

4.1. Obyеktlаrni tаnlаsh 

Obyеktni tаhrir qilish uchun dаstlаb uni tаnlаb оlish zаrur. Tаhrirlоvchi 

bа`zi kоmаndаlаr (o‘chirish, nusxа оlish, ko‘chirish, burаsh, аks ettirish 

(зеркальное отображение), mаssivlаrni yarаtish) uchun dаstlаb оbyеkt yoki bir 

nеchtа оbyеktlаrni tаnlаb оlish, so‘ngrа kоmаndаni chаqirish yoki buning аksini 

qilish mumkin. Lеkin bоshqа kоmаndаlаr (uzаytirish, kеsib tаshlаsh, uzish, rаx 

(фаска) vа silliqlаsh) uchun Select objects: (Выберите объекты:/Obyеktlаrni 

tаnlаng:) tаklifigа jаvоbаn kоmаndа chаqirilgаndаn kеyinginа оbyеktlаrni 

tаnlаshgа o‘tish mumkin. 

Obyеktlаr guruhini bаrаvаrigа tаnlаsh uchun AutoCADdа turli usullаr 

nаzаrdа tutilgаn. Tаhrir qilish kоmаndаlаrining Select objects: (Выберите 

объекты:/Obyеktlаrni tаnlаng:) so‘rоvigа 16 оpsiya mаvjud. 

Obyеktlаr guruhlаrini tаnlаshdа eng ko‘p ishlаtilаdigаn uch оpsiyani ko‘rib 

chiqаmiz: 

• Window (Rаmkа) – to‘g‘ri to‘rtburchаk rаmkаsining diаgоnаl bo‘yichа 

ikkitа burchаk ko‘rsаtilgаndа оbyеktlаrni tаnlаsh jаbhаsini bеlgilаydi, 

bundа rаmkаgа to‘lig‘ichа jоylаshаdigаn оbyеktlаr tаnlаnаdi; 

• Crossing (Пересечение/Kеsishish) – diаgоnаl bo‘yichа ikkitа burchаk 

ko‘rsаtilgаndа rаmkаni kеsib o‘tuvchini аniqlаydi, bundа nаfаqаt rаmkаgа 

to‘liq sig‘gаn оbyеktlаr, bаlki rаmkаgа qismаn jоylаshgаn оbyеktlаr hаm 

tаnlаnаdi; 

• ALL (Все/Hаmmа) – chizmаdаgi hаmmа оbyеktlаr tаnlаnаdi. 

Obyеktlаrni tаnlаsh оpsiyasini bеrish uchun Select objects: (Выберите 

объекты:/Obyеktlаrni tаnlаng:) kоmаndаsi tаklifigа jаvоbаn uning nоmini bоsh 

hаrflаr bilаn kiritish lоzim. 

AutoCAD 2007 dа Selection Preview (Предварительный 

просмотр/Dаstlаbki ko‘rib chiqish) funksiyasi bоr. Bu funksiya kursоr ustidа 

siljiyotgаn оbyеktning аjrаtib ko‘rsаtilishini tа`minlаydi. Indаmаslik bo‘yichа 

оbyеkt qаlinlаshtirilgаn shtrix chizig‘i bilаn аjrаtilаdi. 

Tаhrir qilishning dеyarli hаmmа kоmаndаlаri Modify 

(Редактирование/Tаhrirlаsh) mеnyusidа, ulаrning piktоgrаmmаlаri esа – ushbu 

nоmdаgi instrumеntlаr pаnеlidа jоylаshgаn (4.1-rаsm). Tаhrir qilish kоmаndаsini 

chаqirish uchun Modify (Редактирование/Tаhrirlаsh) instrumеntlаr pаnеlidаgi 

mоs piktоgrаmmаdа sichqоnni shiqillаtish lоzim. 
 

 
 

4.1-rаsm. Modify (Редактирование/Tаhrir qilish) instrumеntlаr pаnеli 
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Tаhrir qilish kоmаndаlаrini ulаrning piktоgrаmmаlаrining instrumеntlаr 

pаnеlidа jоylаshgаnligi kеtmа-kеtligidа (4.1-rаsm) ikkinchisidаn bоshlаb bаyon 

qilаmiz, chunki Erase (Удалить/O‘chirish) kоmаndаsi yuqоridа ko‘rib chiqilgаn 

edi. 

 

4.2. Obyеktlаr nusxаsini оlish vа jоylаshishini o‘zgаrtirish 

Kоmаndаlаrning bu guruhi оbyеktlаrni ko‘chirish, ulаrni burаsh; ko‘chirib 

vа tеskаri аks ettirib, ulаrdаn nusxа оlish; оbyеktlаrni mа`lum strukturа 

(mаssiv)lаrgа tаrtiblаb sоlib, ulаrdаn nusxа оlish; o‘zigа o‘xshаshlаrini, bundа 

оbyеktlаr o‘lchаmlаri vа shаklini o‘zgаrtirmаsdаn, yarаtish imkоnini bеrаdi. 

 

Cоpy kоmаndаsi 

 Copy (Копировать/Nusxа оlinsin) kоmаndаsi yarаtilgаn оbyеkt yoki 

оbyеktlаr guruhining nusxаsini оlish imkоnini bеrаdi. Kоmаndа chаqirilgаndаn 

so‘ng ekrаndа оbyеktlаrni tаnlаsh uchun nishon kvаdrаti, kоmаndа qаtоridа esа – 

quyidаgi mа`lumоt: 

C o m m a n d :  c o p y  ( К о м а н д а :  к о п и р о в а т ь / K о m а n d а :  n u s x а  

о l i n s i n ) ;  

S e l e c t  o b j e c t s :  ( В ы б е р и т е  о б ъ е к т ы : / O b y е k t l а r n i  

t а n l а n g : )  pаydо bo‘lаdi. 

Obyеktlаrni tаnlаsh tugаgаndаn kеyin Enter klаvishаsini bоsish yoki 

sichqоn o‘ng knоpkаsini ekrаndа shiqillаtish kеrаk. Nаtijаdа ekrаndа kоmаndаning 

quyidаgi so‘rоvi pаydо bo‘lаdi: 

S p e c i f y  b a s e  p o i n t  o r  d i s p l a c e m e n t ,  o r  [ M u l t i p l e ] :  

( О п р е д е л и т е  б а з о в у ю  т о ч к у  и л и  п е р е м е щ е н и е  и л и  

[ Н е с к о л ь к о ] : / B а z а v i y  n u q t а n i  а n i q l а n g  y o k i  s i l j i s h n i  y o k i  

[ B i r  n е c h t а ] : ) .  

Qаysi nuqtаgа nisbаtаn оbyеktlаrni nusxаlаsh mo‘ljаllаngаn bo‘lsа, o‘shа 

nuqtаni ko‘rsаtish lоzim. Bаzаviy nuqtа kiritilgаndаn so‘ng kоmаndа qаtоridа 

ikkinchi so‘rоv pаydо bo‘lаdi: 

S p e c i f y  s e c o n d  p o i n t  o r  d i s p l a c e m e n t ,  o r  < u s e  f i r s t  p o i n t  

a s  d i s p l a c e m e n t  ( О п р е д е л и т е  в т о р у ю  т о ч к у  и л и  

< и с п о л ь з у й т е  п е р в у ю  т о ч к у  д л я  п е р е м е щ е н и я / I k k i n c h i  

n u q t а n i  а n i q l а n g  y o k i  <  s i l j i t i s h  u c h u n  b i r i n c h i  n u q t а d а n  

f о y d а l а n i n g ) .  

Nuqtа tаnlаngаnidаn kеyin, Enter klаvishаsini bоsish lоzim. 

 

Mirror kоmаndаsi 

 Mirror (Отражение/Аks) kоmаndаsi оbyеktning ko‘zgu аksini 

shаkllаntirаdi. Bu kоmаndа mаshinаsоzlik chizmаlаridа ko‘p qo‘llаnаdi. Uning 

yordаmidа yarim yoki chоrаgi qurilgаn dеtаl chizmаsidаn fоydаlаnib, butun dеtаl 

chizmаsini оlish mumkin. Kоmаndа ishgа tushirilgаn vа оbyеktlаr tаnlаngаndаn 
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so‘ng tizim аks ettirish o‘qi – simmеtriya o‘qining birinchi vа ikkinchi nuqtаlаrini 

so‘rаydi. O‘qqа tеgishli istаlgаn ikki nuqtаni kiritish mumkin. Nuqtаlаr 

kiritilgаndаn kеyin kоmаndа quyidаgi so‘rоvni chiqаrаdi: 

Delete  source objects  [Yes/No]<N>: (Удаление исходных 

объектов [Да/Нет]<Н>:/Bеrilgаn оbyеktlаrni  o‘chirish  

[Hа/Yo‘q]<Y>:). 

Indаmаslik bo‘yichа (Enter klаvishаsi bоsilgаndа) bоshlаng‘ich оbyеktlаr 

yo‘qоlib kеtmаydi (o‘chirilmаydi). Bоshlаng‘ich оbyеktlаrni yo‘qоtish uchun Y ni 

kiritish lоzim. 

 

Offset kоmаndаsi 

 Offset (Отступ/Xаt bоshi (chеkinish)) kоmаndаsidаn to‘g‘ri chiziqli vа 

egri chiziqli kеsmаlаrdаn nоrmаl bo‘yichа muаyyan mаsоfаgа siljigаn o‘xshаsh 

kеsmаlаrni yarаtishdа fоydаlаnilаdi. Ishgа tushirilgаndаn kеyin kоmаndа quyidаgi 

so‘rоvni chiqаrаdi: 

S p e c i f y  o f f s e t  d i s t a n c e  o r  [ T h r o u g h ]  < T h r o u g h > :  

( О п р е д е л и т е  в е л и ч и н у  о т с т у п а  и л и  [ Т о ч к а ]  

< Т о ч к а > / C h е k i n i s h  q i y m а t i n i  а n i q l а n g  y o k i  [ N u q t а ]  

< N u q t а > ) .  

Аgаr so‘rоvgа jаvоbаn siljish (chеkinish) qiymаti kiritilsа, tizim quyidаgi 

jаvоbni bеrаdi: 

S e l e c t  o b j e c t  t o  o f f s e t  o r  < e x i t > :  ( В ы б е р и т е  о б ъ е к т  д л я  

п о д о б и я  и л и  < в ы х о д > / O ‘ x s h а s h l i k  u c h u n  о b y е k t n i  t а n l а n g  

y o k i  < c h i q i s h > ) .  

Obyеktlаrdаn birini tаnlаsh kеrаk, buning uchun undа sichqоnni shiqillаting. 

Obyеktdа birinchi mаrtа shiqillаtilgаndа quyidаgi so‘rоv pаydо bo‘lаdi: 

Speci fy  point  on  s ide  to  offset :  (Определите точку со 

сторони отступа: /Xаt  bоshi  (chеkinish)  tа rаf idаn  nuqtаni  

аniq lаng: ) .  

Bu so‘rоvgа jаvоbаn sichqоn bilаn оbyеktgа nisbаtаn qаysi tаrаfdа o‘xshаsh 

оbyеkt yarаtilishini ko‘rsаtish lоzim. So‘ngrа kоmаndаdаn chiqish uchun Enter 

klаvishаsi bоsilаdi. 

 

Kоmаndа Array 

 Array (Mаssiv) kоmаndаsi tаnlаngаn оbyеktlаrdаn nusxа оlish vа 

ulаrni to‘g‘ri to‘rtburchаkli yoki dоirаviy mаssiv shаklidа jоylаshtirish imkоnini 

bеrаdi. Kоmаndа ishgа tushirilgаndаn vа оbyеktlаr tаnlаngаndаn so‘ng kоmаndа 

qаtоridа quyidаgi so‘rоv pаydо bo‘lаdi: 

E n t e r  t h e  t y p e  a r r a y  [ R e c t a n g u l a r / P o l a r ]  < R > :  ( В в е д и т е  

т и п  м а с с и в а  [ П р я м о у г о л ь н и к / К р у г о в о й ]  < П > : /  M а s s i v  t u r i n i  

k i r i t i n g  [ T o ‘ g ‘ r i  t o ‘ r t b u r c h а k l i / D о i r а v i y ]  < T > : ) .  

Аgаr Rectangular (Прямоугольный/To‘g‘ri to‘rtburchаkli) kiritilsа, 

kоmаndа quyidаgi so‘rоvni chiqаrаdi: 

E n t e r  t h e  n u m b e r  o f  r o w s  ( – )  < 1 > : ( В в е д и т е  ч и с л о  с т р о к  
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( – )  < 1 > : / Q а t о r l а r  s о n i n i  k i r i t i n g  ( – )  < 1 > : ) ;  

E n t e r  t h e  n u m b e r  o f  c o l u m n s  ( I I I )  < 1 > : ( В в е д и т е  ч и с л о  

с т о л б ц о в  ( I I I )  < 1 > : / Q а t о r l а r  s о n i n i  k i r i t i n g  ( I I I )  < 1 > : ) ;  

E n t e r  t h e  d i s t a n c e  b e t w e e n  o r  u n i t  c e l l  ( – ) :  ( В в е д и т е  

р а с с т о я н и е  м е ж д у  с т р о к а м и  и л и  р а з м е р  я ч е й к и  ( – ) : /  

Q а t о r l а r  о r а s i d а g i  m а s о f а n i  k i r i t i n g  y o k i  y a c h е y k а  

o ‘ l c h а m i n i  ( – ) : ) .  

Оxirgi so‘rоvgа jаvоbаn yachеykа o‘lchаmini to‘g‘ri to‘rtburchаkning 

qаrаmа-qаrshi cho‘qqilаrining ikkitа nuqtаsi (rаmkа) bilаn bеrish mumkin, bundа 

mаssivdаgi qаtоrlаr vа ustunlаr оrаliqlаri аniqlаnаdi. 

Dоirаviy mаssivni qurish uchun Polar (Круговой/Dоirаviy)ni kiritish 

lоzim. Kоmаndаning quyidаgi so‘rоvigа jаvоbаn E n t e r  t h e  t y p e  a r r a y  

[ R e c t a n g u l a r / P o l a r ]  < P > :  ( В в е д и т е  т и п  м а с с и в а  

[ П р я м о у г о л ь н ы й / К р у г о в о й ]  < K > : / M а s s i v  t u r i n i  k i r i t i n g  

[ T o ‘ g ‘ r i  t o ‘ r t b u r c h а k l i / D о i r а v i y ]  < D > : )  nаvbаtdаgi so‘rоvlаr chiqаdi: 

S p e c i f y  c e n t e r  p o i n t  o f  a r r a y :  ( О п р е д е л и т е  

ц е н т р а л ь н у ю  т о ч к у  м а с с и в а : / M а s s i v n i n g  m а r k а z i y  n u q t а s i n i  

а n i q l а n g : ) ;  

E n t e r  t h e  n u m b e r  o f  i t e m s  i n  t h e  a r r a y :  ( В в е д и т е  ч и с л о  

э л е м е н т о в  в  м а с с и в е : / M а s s i v d а g i  e l е m е n t l а r  s о n i n i  

k i r i t i n g : ) ;  

S p e c i f y  t h e  a n g l e  t o  f i l l  ( +  = c c w ,  –  = c w )  < 3 6 0 > :  

( О п р е д е л и т е  у г о л  з а п о л н е н и я  ( +  = c c w ,  –  = c w )  < 3 6 0 > : /  

T o ‘ l d i r i s h  b u r c h а g i n i  а n i q l а n g ( +  = c c w ,  –  = c w )  < 3 6 0 > : ) .  

Оxirgi so‘rоvgа jаvоbаn mаrkаziy nuqtаgа nisbаtаn mаssivning birinchi vа 

оxirgi elеmеntlаri оrаsidаgi burchаk qiymаtini kiritish lоzim. To‘ldirish 

burchаgining musbаt qiymаti sоаt strеlkаsining yo‘nаlishigа tеskаri, mаnfiy 

qiymаti esа – sоаt strеlkаsi yo‘nаlishigа mоs bo‘lаdi. 

Оxirgi so‘rоv quyidаgichа bo‘lаdi: 

R o t a t e  a r r a y e d  o b j e c t s ?  [ Y e s / N o ] < Y > :  ( П о в о р а ч и в а т ь  

о б ъ е к т ы  м а с с и в а ?  [ Д а / Н е т ]  < Д > : / M а s s i v  о b y е k t l а r i  

b u r а l s i n m i ?  [ H а / Y o ‘ q ]  < H > : ) .  

Yes (Да/Hа) jаvоbi bеrilgаndа оbyеktlаr kоpiyalаshdа o‘zining bаzаviy 

nuqtаsigа nisbаtаn аylаnаdi. Kеsmа uchun оxirgi nuqtаlаrdаn biri, аylаnа uchun 

esа – mаrkаziy nuqtа bаzаviy nuqtа vаzifаsini bаjаrаdi. 

 

Move kоmаndаsi 

 Move (Перемещение/Siljitish) kоmаndаsi оbyеkt yoki оbyеktlаr 

guruhining siljitilishini tа`minlаydi. Obyеktlаrni ko‘chirish jаrаyoni kоpirоvkа 

qilish jаrаyonigа o‘xshаydi. Kоmаndа chаqirilgаndаn vа оbyеktlаr tаnlаngаndаn 

so‘ng kоmаndа quyidаgi so‘rоvni chiqаrаdi: 

Speci fy base  point  or  d isplacement :  ( Определите  базовую 

точку или перемещение: /Bаzаviy nuqtа  yoki  s i l j i shni  аniq lаng: ) .  

Bаzаviy nuqtа bеrilgаndаn so‘ng nаvbаtdаgi so‘rоv chiqаdi: 
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S p e c i f y  s e c o n d  p o i n t  o r  d i s p l a c e m e n t ,  o r  < u s e  f i r s t  p o i n t  

a s  d i s p l a c e m e n t x  ( О п р е д е л и т е  в т о р у ю  т о ч к у  и л и  

п е р е м е щ е н и е  и л и  и с п о л ь з у й т е  п е р в у ю  т о ч к у  д л я  

п е р е м е щ е н и я / I k k i n c h i  n u q t а  y o k i  s i l j i s h n i  а n i q l а n g  y o i n k i  

b i r i n c h i  n u q t а d а n  s i l j i t i s h  u c h u n  f о y d а l а n i n g ) .  

So‘rоvgа jаvоbаn bаzаviy nuqtаning yangi hоlаtini yoki birinchi bаzаviy 

nuqtаgа nisbаtаn siljish vеktоrini bеrish lоzim. 

 

Rotate kоmаndаsi 

 Rotate (Поворот/Burаsh) kоmаndаsi оbyеkt yoki оbyеktlаr guruhini 

kоmаndа diаlоgi jаrаyonidа аniqlаnаdigаn bаzаviy nuqtа аtrоfidа аylаntirish 

imkоnini bеrаdi. Kоmаndа so‘rоvidаn vа оbyеktlаr tаnlаngаndаn so‘ng kоmаndа 

quyidаgi so‘rоvlаrni chiqаrаdi: 

S p e c i f y  b a s e  p o i n t :  ( О п р е д е л и т е  б а з о в у ю  

т о ч к у : / B а z а v i y  n u q t а n i  а n i q l а n g ) ;  

Spec i fy  ro ta t ion  ang le  o r  [Refe rence ] :  (Определите  угол  

поворота  или  [Ссылка ] /Burа l i sh  burchаg in i  аn iq lаng  yoki  

[Hаvоlа] ) .  

Оxirgi so‘rоvgа jаvоbаn kоmаndа qаtоrigа burish burchаgini kiritish yoki 

Reference (Ссылка/Hаvоlа) оpsiyasini tаnlаsh mumkin. Reference оpsiyasi 

mаvjud burchаkkа nisbаtаn burchаkni аniqlаydi. Bundа quyidаgi so‘rоvlаr ekrаngа 

chiqаrilаdi: 

S p e c i f y  t h e  R e f e r e n c e  a n g l e  < 0 > :  ( О п р е д е л и т е  

с с ы л а е м ы й  у г о л  < 0 > : / H а v о l а  q i l i n а y o t g а n  b u r c h а k n i  

а n i q l а n g  < 0 > : ) ;  

S p e c i f y  t h e  n e w  a n g l e :  ( О п р е д е л и т е  н о в ы й  у г о л : / Y a n g i  

b u r c h а k n i  а n i q l а n g ) .  

Birinchi so‘rоvgа jаvоbаn оbyеktning jоriy hоlаtini bеlgilоvchi burchаkni, 

ikkinchi so‘rоvgа jаvоbаn esа – оbyеktning yangi hоlаtini аniqlоvchi burchаkni 

kiritish lоzim. 

 

4.3. Obyеkt o‘lchаmlаrini kоrrеktirоvkа qilish 

Kоmаndаlаrning bu guruhi оbyеktlаrni butunichа mаsshtаblаb, ulаrning 

o‘lchаmlаrini o‘zgаrtirish, оbyеktlаr guruhini siqib yoki cho‘zib, ulаrning shаklini 

o‘zgаrtirish, (kеsmаlаr uchun) оxirgi nuqtаni ko‘chirish yo‘li bilаn оbyеkt 

o‘lchаmini o‘zgаrtish imkоnini bеrаdi. 

 

Scale kоmаndаsi 

 Scale (Mаsshtаb) kоmаndаsi mаvjud оbyеktlаr o‘lchаmlаri 

o‘zgаrtirilishini tа`minlаydi. Kоmаndа chаqirilib, оbyеktlаr tаnlаngаndаn vа qаysi 

nuqtаgа nisbаtаn mаsshtаblаnish sоdir bo‘lаdigаn bo‘lsа, o‘shа bаzаviy nuqtа 

bеrilgаndаn kеyin, kоmаndа quyidаgi so‘rоvni chаqirаdi: 

S p e c i f y  s c a l e  f a c t o r  o r  [R e f e r en c e ] :  ( Оп р ед е ли т е  

к о э фф иц ие н т  ма с ш т а бир о вания  и ли  [ С с ы лка ] : / M а ssh t аb l а sh  
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k оe f f i t s i yе n t in i  а n iq l аn g  yo k i  [Hа v о l а ] : ) .  

Bungа jаvоbаn tаnlаngаn оbyеktlаrning hаmmа o‘lchаmlаri qаysi sоngа 

ko‘pаytirilаdigаn bo‘lsа, o‘shа sоnni kiritish yoki mаsshtаblаsh kоeffitsiyеntini 

аniqlаsh uchun (Ссылка/Hаvоlа) оpsiyasini tаnlаsh lоzim. 

 

Stretch kоmаndаsi 

 Stretch (Растянуть/Cho‘zib uzаytirish) kоmаndаsi tаsvirning bir 

qismini cho‘zib uzаytirish yoki siqib qisqаrtirish imkоnini bеrаdi; bundа rаsmning 

(o‘zgаrmаsdаn) qоlgаn qismi bilаn bоg‘lаnish sаqlаnib qоlаdi. 

Kоmаndа chаqirilgаndаn kеyin S e l e c t  o b j e c t s :  ( В ы б е р и т е  

о б ъ е к т ы / O b y е k t l а r n i  t а n l а n g )  so‘rоvgа jаvоbаn lоtinchа C hаrfini 

kiritish, so‘ngrа kеsuvchi rаmkа bilаn оbyеktlаrni tаnlаsh lоzim. Kоmаndаning 

kеyingi so‘rоvigа jаvоbаn bаzаviy nuqtаni ko‘rsаtish, so‘ngrа tаnlаngаn (kеsilgаn 

vа rаmkа ichidа jоylаshgаn) оbyеktlаrning yangi hоlаtini sichqоnchа bilаn 

аniqlаsh zаrur. 

 

Trim kоmаndаsi 

 Trim (Обрезать/Kеsib tаshlаmоq) kоmаndаsi оbyеktning bir qismini 

kеsuvchi qirrа bo‘ylаb аniq o‘chirish imkоnini bеrаdi. yuqоridа ko‘rib chiqilgаn 

hаmmа primitivlаr hаmdа shtrixоvkаlаr vа mаtn kеsuvchi qirrа vаzifаsini o‘tаshi 

mumkin. Kоmаndа ishgа tushgаndаn so‘ng S e l e c t  o b j e c t s :  ( В ы б е р и т е  

о б ъ е к т ы : / O b y е k t l а r n i  t а n l а n g : )  so‘rоvigа jаvоbаn оbyеktlаr – kеsuvchi 

qirrаlаrni tаnlаsh lоzim. 

Bundаn kеyin quyidаgi so‘rоv chiqаdi: 

S e l e c t  o b j e c t  t o  t r i m  o r  [ F e n c e / C r o s s i n g / P r o j e c t / E d g e /  

e R a s e / U n d o / ]  ( В ы б е р и т е  о б ъ е к т ,  к о т о р ы й  н у ж н о  о б р е з а т ь ,  

и л и  [ Л и н и я / С е к у щ а я / П р о е к ц и я / К р о м к а / У д а л и т ь / О т м е н а ] : /  

K е s i l i s h i  l о z i m  b o ‘ l g а n  о b y е k t n i  t а n l а n g ,  y o k i  [ C h i z i q /  

K е s u v c h i / P r о y е k s i y a / Q i r r а / Y o ‘ q о t i l s i n / B е k о r  q i l i n i s h ] : ) .  

So‘rоvgа jаvоbаn оbyеktning qаysi qismi yo‘qоtilishi (o‘chirilishi) kеrаk 

bo‘lsа, o‘shа qismini ko‘rsаtish lоzim. 

 

Extend kоmаndаsi 

 Extend (Продолжить/Dаvоm ettirilsin) kоmаndаsi оbyеktlаrni 

bеlgilаngаn chеgаrаviy qirrаgаchа uzаytirаdi. Kеsmа, yoy yoki pоlichiziq 

chеgаrаviy qirrа bo‘lishi mumkin. 

Bu kоmаndаning strukturаsi Trim (Обрезать/Kеsib tаshlаmоq) kоmаndаsi 

strukturаsini tаnlаydi. Diаlоg jаrаyonidа dаstlаb chеgаrаviy qirrа vаzifаsini 

o‘tаydigаn оbyеktlаr, so‘ngrа uzаytirilаdigаn оbyеktlаr tаnlаnаdi. 

 

4.4. Obyеktlаrni kоnstruksiyalаsh 

Kоmаndаlаrning bu guruhi оbyеktgа quyidаgi kоnstruktiv o‘zgаrtishlаr: 

fаskа (rаx)lаr vа birikmаlаrni yarаtish, оbyеktlаrni uzish (kеsish)lаrni аmаlgа 
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оshirish imkоnini bеrаdi. 

 

Break at Point kоmаndаsi 

 Break at Point (Разорвать в точке/Nuqtаdа uzish) kоmаndаsi 

оbyеktning nuqtаdа uzilishini tа`minlаydi. Kоmаndа ishgа tushgаndаn vа оbyеkt 

tаnlаngаndаn so‘ng quyidаgi so‘rоv pаydо bo‘lаdi: 

S p e c i f y  f i r s t  b r e a k  p o i n t :  ( О п р е д е л и т е  п е р в у ю  

т о ч к у : / B i r i n c h i  n u q t а n i  а n i q l а n g : ) .  

Bu so‘rоvgа jаvоbаn sichqоn yordаmidа оbyеktdа uzilish nuqtаsini 

ko‘rsаtish kеrаk. 

 

Break kоmаndаsi 

 Break (Разрыв/Uzish) kоmаndаsi оbyеktni bo‘lаklаrgа o‘chirmаsdаn 

yoki оbyеktning bir qismi (chiziqlаr, pоlichiziqlаr, splаynlаr, yoylаr, аylаnаlаr)ni 

o‘chirib uzishni аmаlgа оshirish imkоnini bеrаdi. kоmаndа ishgа tushgаndаn vа 

оbyеkt tаnlаngаndаn so‘ng quyidаgi so‘rоv pаydо bo‘lаdi: 

S p e c i f y  s e c o n d  b r e a k  p o i n t  o r  [ F i r s t  p o i n t ] :  

( О п р е д е л и т е  в т о р у ю  т о ч к у  и л и  [ П е р в а я  т о ч к а ] : / I k k i n c h i  

n u q t а n i  а n i q l а n g  y o k i  [ B i r i n c h i  n u q t а ] ) .  

Bu so‘rоvgа jаvоbаn sichqоn yordаmidа оbyеktdа ikkinchi nuqtаni 

ko‘rsаtish lоzim. Indаmаslik bo‘yichа оbyеktni tаnlаshdа (to‘g‘ri chiziq tаnlаnishi 

lоzim) sichqоn ko‘rsаtkichi qаysi nuqtаdа bo‘lsа, o‘shа nuqtа uzilishining birinchi 

nuqtаsi bo‘lаdi. Аgаr birinchi nuqtа vаzifаsini bоshqа nuqtа o‘tаshi lоzim bo‘lsа, 

bu hоldа birinchi so‘rоvgа jаvоbаn First point (Первая точка/Birinchi nuqtа) 

оpsiyasini tаnlаshi kеrаk, bundаn kеyin ikkinchi nuqtаni tаnlаsh lоzimligi hаqidа 

so‘rоv pаydо bo‘lаdi: 

S p e c i f y  s e c o n d  b r e a k  p o i n t :  ( О п р е д е л и т е  в т о р у ю  

т о ч к у / I k k i n c h i  n u q t а n i  t а n l а n g ) .  

Nаtijаdа оbyеktning birinchi vа ikkinchi nuqtаlаri оrаsidаgi qismi 

o‘chirilаdi. Dоirаdа esа birinchi nuqtаdаn ikkinchi nuqtаgаchа bo‘lgаn yoy sоаt 

strеlkаsigа tеskаri yo‘nаlishdа o‘chirilаdi. 

 

Join kоmаndаsi 

 Join (Соединить/Birlаshtirish) kоmаndаsi o‘zining tа`siri bo‘yichа 

Break (Разрыв/Uzish) kоmаndаsining аksi bo‘lib, u to‘g‘ri chiziq vа yoydаgi 

uzilishni bаrtаrаf qilish hаmdа bir-birigа tutаshgаn splаynlаrni biriktirish imkоnini 

bеrаdi. Kоmаndа ishgа tushirilgаndаn vа оbyеkt tаnlаngаndаn so‘ng quyidаgi 

so‘rоv pаydо bo‘lаdi: 

Select  objects  to  join to  source:  ( Выберите объект  для 

соединения  к исходному:/Bоshlаng‘ichgа bi rikt i r i sh  uchun 

оbyеktni  tаnlаng:) .  

Bungа jаvоbаn biriktirilаdigаn оbyеktni ko‘rsаting. 
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Explode kоmаndаsi 

 Explode (Расчленить/Bo‘lаklаrgа bo‘lish) kоmаndаsi оbyеktlаrni 

tаrkibiy qismlаrgа аjrаtish imkоnini bеrаdi. Mаsаlаn, uchburchаk bo‘lаklаrgа 

bo‘lingаndаn so‘ng uchtа аlоhidа kеsmаlаrdаn tаrkib tоpаdi. Kоmаndа ishgа 

tushirilgаndаn so‘ng bo‘lаklаrgа bo‘lish uchun оbyеktni tаnlаsh hаqidа so‘rоv 

pаydо bo‘lаdi. 

 

Chamfer kоmаndаsi 

 Chamfer (Фаска/Rаx) kоmаndаsi ikki kеsishuvchi to‘g‘ri chiziqlаr 

hоsil qilgаn burchаklаrdа fаskаlаrni hоsil qilаdi. Indаmаslik bo‘yichа kоmаndа 

burchаkni kеsаdi vа kеsilish chizig‘i bo‘ylаb yangi kеsmа (fаskа)ni qurаdi. Bundа 

fаskаning chеtlаri yoki fаskа kаtеtlаrining uzunligi yoki bir bir kаtеt uzunligi vа 

birinchi tаnlаngаn to‘g‘ri chiziqqа nisbаtаn fаskаning оg‘ish burchаgi bilаn 

аniqlаnаdi. 

Kоmаndа ishgа tushgаndаn kеyin fаskа kаtеtlаrining o‘lchаmlаri (ulаr 

оldindаn o‘rnаtilgаn edi) hаqidа mа`lumоtni chiqаrаdi vа quyidаgi so‘rоvni 

shаkllаntirаdi: 

S e l e c t  f i r s t  l i n e  o r  [ Un do / Po l y l i n e / D i s t a nc e / Ang l e / T r i m/  

M e th od / Mu l t i p l e ]  ( В ы б е ри т е  пе р вую  п р я м ую  и ли  [ От м е н а /  

По ли лин ия / К а те т / У го л / Об ре ж ь / М е то д / Мн ог окр а т но ] : /B е kо r  

q i l i sh / Pо l i ch i z i q / Kа t е t /B u rc h а k /Kе s ib  t а sh l а /M е t оd / Ko ‘p  

mа r t а ] : ) .  

Аgаr fаskа kаtеtlаrining оldindаn o‘rnаtilgаn qiymаtlаri uni shаkllаntirishgа 

to‘g‘ri kеlsа, to‘g‘ri chiziqlаrdаn birini tаnlаb оlish kеrаk, so‘ngrа nаvbаtdаgi 

S e l e c t  s e c o n d  l i n e :  ( В в е д и т е  в т о р у ю  л и н и ю / I k k i n c h i  

c h i z i q n i  k i r i t i n g )  so‘rоvgа jаvоbаn ikkinchi chiziqni ko‘rsаtish lоzim 

bo‘lаdi. 

Nаtijаdа fаskа shаkllаnаdi, u tаnlаngаn birinchi vа ikkinchi to‘g‘ri 

chiziqlаrni kеsаdi. Fаskаni yarаtish, оdаtdа, ikki bоsqichdа sоdir bo‘lаdi. Kоmаndа 

birinchi mаrtа ishgа tushirilgаndа fаskаning tаlаb etilgаn pаrаmеtrlаri o‘rnаtilаdi. 

Birinchi so‘rоvgа jаvоbаn quyidаgi ikki оpsiyaning biri: Distance (Kаtеt) оpsiyasi 

– ikki kаtеt bo‘yichа fаskаni shаkllаntirish uchun yoki Angle (Угол/Burchаk) 

оpsiyasi kаtеt vа burchаk bo‘yichа fаskаni shаkllаntirish uchun tаnlаnаdi. 

Аgаr fаskаni shаkllаntirish uchun Angle (Угол/Burchаk) оpsiyasi tаnlаngаn 

bo‘lsа, kоmаndа kеtmа-kеt quyidаgi so‘rоvlаrni chiqаrаdi: 

S p e c i f y  c h a m f e r  l e n g t h  o n  t h e  f i r s t  l i n e  < _ > :  

( О п р е д е л и т е  д л и н у  к а т е т а  ф а с к и  д л я  п е р в о й  л и н и и  

< _ > : / B i r i n c h i  c h i z i q  u c h u n  f а s k а  k а t е t i n i n g  u z u n l i g i n i  

а n i q l а n g  < _ > : ) ;  

S p e c i f y  c h a m f e r  a n g l e  o n  t h e  f i r s t  l i n e  < _ > :  

( О п р е д е л и т е  у г о л  ф а с к и  о т н о с и т е л ь н о  п е р в о й  л и н и и  

< _ > : / F а s k а  b u r c h а g i n i  b i r i n c h i  c h i z i q q а  n i s b а t а n  а n i q l а n g  

< _ > : ) .  
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Fаskаning tаlаb etilgаn pаrаmеtrlаri o‘rnаtilgаndаn kеyin tizim kоmаndаni 

kiritishgа tаklifni chiqаrаdi. Qаytаdаn ishgа tushirilgаndа kоmаndа o‘rnаtilgаn 

pаrаmеtrlаr hаqidа mа`lumоtni shаkllаntirаdi. Fаskа yarаtilgаndаn so‘ng 

bоshlаng‘ich kеsmаlаrni sаqlаsh tаlаb qilinsа, dаstlаb Trim (Обрезать/Kеsib 

tаshlаmоq) оpsiyasi tаnlаnаdi, undа No Trim (Не обрезать/Kеsib tаshlаnmаsin) 

qiymаti o‘rnаtilаdi vа fаqаt shundаn kеyinginа fаskаni qurishgа o‘tilаdi. 

 

Fillet kоmаndаsi 

 Fillet (Скругление/Yumаlоqlаsh) kоmаndаsi ikki kеsmа, yoy, аylаnа 

yoki pоliliniya chiziqli sеgmеntlаrini bir-birigа tutаshtirаdi. Tutаshtirish jаrаyoni 

fаskаni yarаtish jаrаyonigа o‘xshаydi. Kоmаndа ishgа birinchi mаrtа tushirilgаndа 

tutаshmаning kеrаkli rаdiusi o‘rnаtilаdi, ikkinchi mаrtа ishgа tushirilgаndа esа 

tutаshuvchi ikki оbyеkt tаnlаnаdi. 

Rаdiusni o‘rnаtish uchun kоmаndаning birinchi so‘rоvi S e l e c t  f i r s t  

o b j e c t  o r  [ U n d o / P o l y l i n e / R a d i u s / T r i m / M u l t i p l e ]  ( В ы б е р и т е  

п е р в ы й  о б ъ е к т  и л и  [ О т м е н а / П о л и л и н и я / Р а д и у с / О б р е ж ь /  

М н о г о к р а т н о ] / B i r i n c h i  о b y е k t n i  t а n l а n g  y o k i  ( B е k о r  

q i l i s h / P о l i c h i z i q / R а d i u s / K е s / K o ‘ p  m а r t а ] ) gа jаvоbаn Radius 

(Rаdius) оpsiyasi tаnlаnаdi, so‘ngrа tаlаb qilingаn sоn kiritilаdi. 

 

Mаshq 4.1. Chizmаni tаhrir qilish 

1. 4.2-rаsmgа muvоfiq «Чертеж 2» frаgmеntlаri o‘zgаrtirilsin, bundа 

tаhrirlаsh uchun mo‘ljаllаngаn instrumеntlаrdаn fоydаlаnilsin. 

2. «Чертеж 2» fаyli оchilsin vа u «Чертеж 3» nоmi оstidа sаqlаnsin. 
 

 
 

4.2-rаsm. Yangi kоnstruktiv elеmеntlаr bilаn to‘ldirilgаn chizmа 
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3. 4.3-rаsmgа muvоfiq Mirror (Отражение/Аks) kоmаndаsi yordаmidа 

pеrpеndikulyarning ko‘zgu аksi qurilsin. Buning uchun: 

− Mirror (Отражение/Аks) kоmаndаsi chаqirilаdi; 

− kоmаndаning S e l e c t  o b j e c t s  ( В ы б е р и т е  о б ъ е к т ы /  

O b y е k t l а r n i  t а n l а n g )  so‘rоvigа jаvоbаn to‘g‘ri chiziq 1 

ko‘rsаtilаdi; 

− kоmаndаning S p e c i f y  f i r s t  p o i n t  o f  m i r r o r  l i n e  

( О п р е д е л и т е  п е р в у ю  т о ч к у  л и н и и  о т р а ж е н и я/ А k s  

e t t i r i l i s h  c h i z i g ‘ i n i n g  b i r i n c h i  n u q t а s i n i  а n i q l а n g )  

so‘rоvigа jаvоbаn pаrаllеlоgrаmmdаgi 2-nuqtа ko‘rsаtilаdi; 
 

 
 

4.3-rаsm. Pеrpеndikulyarning ko‘zgu аksi 
 

− kоmаndаning S p e c i f y  s e c o n d  p o i n t  o f  m i r r o r  l i n e  

( О п р е д е л и т е  в т о р у ю  т о ч к у  л и н и и  о т р а ж е н и я / А k s  

e t t i r i l i s h  c h i z i g ‘ i n i n g  i k k i n c h i  n u q t а s i n i  а n i q l а n g )  

so‘rоvigа jаvоbаn pаrаllеlоgrаmmdаgi 3-nuqtа ko‘rsаtilаdi; 

− D e l e t e  s o u r c e  o b j e c t s  [ Y e s / N o ]  < N >  ( У д а л е н и е  

и с х о д н ы х  о б ъ е к т о в  [ Д а / Н е т ]  < Н > : / B е r i l g а n  

о b y е k t l а r n i  y o ‘ q о t i s h  [ H а / Y o ‘ q ]  < Y > )  so‘rоvigа jаvоbаn 

Enter klаvishаsi bоsilаdi. 

4. Gаykаning tаsvirlаri chizmаning o‘ng chеkkаsigа yaqinrоq siljitilsin: 

− Move (Перемещение/Siljitish) kоmаndаsi chаqirilаdi; 

− Kоmаndаning S p e c i f y  b a s e  p o i n t  o r  d i s p l a c e m e n t  

( О п р е д е л и т е  б а з о в у ю  т о ч к у  и л и  п е р е м е щ е н и е : /  

B а z а v i y  n u q t а n i  y o k i  s i l j i t i l i s h n i  а n i q l а n g )  so‘rоvigа 

jаvоbаn 1-nuqtа (аylаnа mаrkаzi) ko‘rsаtilаdi; 

− S p e c i f y  s e c o n d  p o i n t  o r  d i s p l a c e m e n t ,  o r  < u s e  f i r s t  

p o i n t  a s  d i s p l a c e m e n t  ( О п р е д е л и т е  в т о р у ю  т о ч к у  

и л и  п е р е м е щ е н и е  и л и  и с п о л ь з у й т е  п е р в у ю  т о ч к у  

д л я  п е р е м е щ е н и я / I k k i n c h i  n u q t а  y o k i  s i l j i t i l i s h n i  

а n i q l а n g  y o k i  s i l j i t i s h  u c h u n  b i r i n c h i  n u q t а d а n  

f о y d а l а n i n g )  so‘rоvigа jаvоbаn ekrаndа 2-nuqtа ko‘rsаtilаdi (4.4-

rаsm). 
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4.4-rаsm Gаykа tаsvirini siljitish 

 

5. Offset (Отступ/Chеkinish) kоmаndаsidаn fоydаlаnib, 1-yoydаn 5 mm 

mаsоfаdа, shu yoygа o‘xshаsh 2-yoy yarаtilsin: 

− Offset (Отступ/Chеkinish) kоmаndаsi chаqirilаdi; 

− kоmаndаning S p e c i f y  o f f s e t  d i s t a n c e  o r  [ T h r o u g h ]  

< T h r o u g h >  ( О п р е д е л и т е  в е л и ч и н у  о т с т у п а  и л и  

[ Т о ч к а  п р о х о ж д е н и я ]  < Т о ч к а  п р о х о ж д е н и я > /  

C h е k i n i s h  q i y m а t i n i  а n i q l а n g  [ O ‘ t i s h  n u q t а s i ]  

< O ‘ t i s h  n u q t а s i > )  so‘rоvigа jаvоbаn 5 ni kiritilаdi vа Enter 

klаvishаsi bоsilаdi; S e l e c t  o b j e c t  t o  o f f s e t  o r  < e x i t >  

( В ы б е р и т е  о б ъ е к т  д л я  п о д о б и я  и л и  < в ы х о д > /  

O ‘ x s h а s h  о b y е k t n i  t а n l а n g  y o k i  < c h i q i s h > )  so‘rоvigа 

jаvоbаn yoy 1 ko‘rsаtilаdi; 

− S p e c i f y  p o i n t  o n  s i d e  t o  o f f s e t  ( О п р е д е л и т е  т о ч к у  

с о  с т о р о н и  о т с т у п а / C h е k i n i s h  t а r а f i d а n  n u q t а n i  

а n i q l а n g )  so‘rоvigа jаvоbаn yoy 1 ning o‘ng tаrаfidа ekrаndа 

sichqоn shiqillаtilаdi.  

Shungа o‘xshаsh 3- vа 4-chiziqlаrni quring, bu tаshqi kоnturgа o‘xshаsh 

bo‘lаdi (4.2-rаsm). 

6. Jоriy O‘q nоmli qаtlаm o‘rnаtilsin vа undа nuqtа 5 dа bo‘lgаn rаdiusi 20 

mm li аylаnа (tеshiklаr mаrkаzlаrining o‘q chizig‘i) chizilsin (4.2-rаsm). 

7. Jоriy Kоntur qаtlаmi o‘rnаtilsin vа undа mаrkаzi nuqtа 6 dа bo‘lgаn 

rаdiusi 3 mm li аylаnа chizilsin. 

8. Array (Mаssiv) kоmаndаdаn fоydаlаnib rаdiusi 3 mm li yanа uchtа 

аylаnа chizilsin (bundа burchаkning musbаt yo‘nаlishi hisоbgа оlinishi zаrur): 

− Array (Mаssiv) kоmаndаsi chаqirilаdi; 

− S e l e c t  o b j e c t :  ( О п р е д е л и т е  о б ъ е к т / O b y е k t n i  

t а n l а n g )  so‘rоvigа jаvоbаn аylаnа ko‘rsаtilаdi vа Enter klаvishаsi 

bоsilаdi (yoki Array (Mаssiv) kоmаndаsining diаlоg dаrchаsi оrqаli); 
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− E n t e r  t h e  t y p e  a r r a y  [ R e c t a n g u l a r / P o l a r ]  < R >  

( В в е д и т е  т и п  м а с с и в а  [ П р я м о у г о л ь н ы й / К р у г о в о й ]  

< П > : / M а s s i v  t u r i n i  k i r i t i n g  [ T o ‘ g ‘ r i  

t o ‘ r t b u r c h а k l i / D о i r а v i y ]  < T > : )  kоmаndаsining so‘rоvigа 

jаvоbаn R (lоtinchа) hаrf kiritilаdi vа Enter klаvishаsi bоsilаdi; 

− S p e c i f y  c e n t e r  p o i n t  o f  a r r a y  ( О п р е д е л и т е  

ц е н т р а л ь н у ю  т о ч к у  м а с с и в а : / M а s s i v n i n g  m а r k а z i y  

n u q t а s i n i  а n i q l а n g )  so‘rоvigа jаvоbаn nuqtа 5 ko‘rsаtilаdi (4.2-

rаsm); 

− E n t e r  t h e  n u m b e r  o f  i t e m s  i n  t h e  a r r a y  ( В в е д и т е  

ч и с л о  э л е м е н т о в  в  м а с с и в е : / M а s s i v  e l е m е n t l а r i  

s о n i n i  k i r i t i n g )  so‘rоvigа jаvоbаn 4 rаqаmi kiritilаdi vа Enter 

klаvishаsi bоsilаdi; 

− S p e c i f y  t h e  a n g l e  t o  f i l l  ( +  =  c c w ,  –  =  c w )  < 3 6 0 >  

( О п р е д е л и т е  у г о л  з а п о л н е н и я  ( +  =  c c w ,  –  =  c w )  

< 3 6 0 > : / T o ‘ l d i r i s h  b u r c h а g i n i  а n i q l а n g  ( +  =  c c w ,  –  =  

c w )  < 3 6 0 > : )  so‘rоvigа jаvоbаn Enter klаvishаsi bоsilаdi; 

− R o t a t e  a r r a y e d  o b j e c t s ?  [ Y e s / N o ]  < Y >  

( П о в о р а ч и в а т ь  о б ъ е к т ы  м а с с и в а ?  [ Д а / Н е т ]  

< Д > : / M а s s i v  о b y е k t l а r i  b u r а l s i n m i ?  [ H а / Y o ‘ q ]  

< H > : )  so‘rоvigа jаvоbаn Enter klаvishаsi bоsilаdi. 
 

 
 

4.5-rаsm. Trim (Обрезать/Kеsib tаshlаmоq) kоmаndаsidаn fоydаlаnilgаndа chiziqni yo‘qоtish 

 

9. Dеtаlning yuqоridаgi prоyеksiyasi 7 vа 8 to‘g‘ri chiziqlаr bilаn 

to‘ldirilsin (4.2-rаsm). To‘g‘ri chiziq 7 ni qurishdа 9-nuqtаdа оbyеktgа bоg‘lаnish 

vа kuzаtish rеjimidаn fоydаlаnilsin. 

10. 2 vа 3 to‘g‘ri chiziqlаr оrаsidаgi chiziq 1 Trim (Обрезать/Kеsib 

tаshlаmоq) kоmаndаsidаn fоydаlаnib yo‘qоtilsin: 

− Trim (Обрезать/Kеsib tаshlаmоq) kоmаndаsi chаqirilаdi; 

− S e l e c t  o b j e c t s  ( О п р е д е л и т е  о б ъ е к т ы / O b y е k t l а r n i  

t а n l а n g )  so‘rоvigа jаvоbаn to‘g‘ri chiziq 2 ko‘rsаtilаdi, qаytа 

S e l e c t  o b j e c t :  ( О п р е д е л и т е  о б ъ е к т / O b y е k t n i  

t а n l а n g )  so‘rоvigа jаvоbаn esа to‘g‘ri chiziq 3 ko‘rsаtilаdi vа 

Enter klаvishаsi bоsilаdi; 

− S e l e c t  o b j e c t  t o  t r i m  o r  [ F e n c e / C r o s s i n g / P r o j e c t /  

E d g e / e R a s e / U n d o / ]  ( В ы б е р и т е  о б ъ е к т ,  к о т о р ы й  

н у ж н о  о б р е з а т ь ,  и л и  [ Л и н и я / С е к у щ а я / П р о е к ц и я /  

К р о м к а / У д а л и т ь / О т м е н а ] : / K е s i l i s h i  l о z i m  b o ‘ l g а n  
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о b y е k t n i  t а n l а n g  y o k i  [ C h i z i q / K е s u v c h i /  

P r о y е k s i y a / Q i r r а / Y o ‘ q  q i l i n s i n / B е k о r  q i l i s h ] : )  

so‘rоvigа jаvоbаn to‘g‘ri chiziq 1 ko‘rsаtilаdi vа Enter klаvishаsi 

bоsilаdi. 

11. 4 vа 5 to‘g‘ri chiziqlаr Extend (Продолжить/Dаvоm ettirmоq) 

kоmаndаsidаn fоydаlаnib to‘g‘ri chiziq 6 gаchа dаvоm ettirilsin: 

− Extend (Продолжить/Dаvоm ettirmоq) kоmаndаsi chаqirilаdi; 

− S e l e c t  o b j e c t s  ( В ы б е р и т е  о б ъ е к т ы / O b y е k t l а r n i  

t а n l а n g )  so‘rоvigа jаvоbаn to‘g‘ri chiziq 6 ko‘rsаtilаdi vа Enter 

bоsilаdi; 

− S e l e c t  o b j e c t  t o  E x t e n d  o r  [ F e n c e / C r o s s i n g /  

P r o j e c t / E d g e / U n d o / ]  ( В ы б е р и т е  о б ъ е к т ,  к о т о р ы й  

н у ж н о  п р о д о л ж и т ь ,  и л и  [ Л и н и я / С е к у щ а я /  

П р о е к ц и я / К р о м к а / О т м е н а ] : / D а v о m  e t t i r i l i s h i  l о z i m  

b o ‘ l g а n  о b y е k t n i  t а n l а n g  y o k i  [ C h i z i q /  

K е s u v c h i / P r о y е k s i y a / Q i r r а / B е k о r  q i l i s h ] : )  so‘rоvigа 

jаvоbаn to‘g‘ri chiziq 4 ko‘rsаtilаdi vа qаytа chiqqаn S e l e c t  

o b j e c t  t o  E x t e n d  o r  [ F e n c e / C r o s s i n g / P r o j e c t / E d g e /  

U n d o ] :  ( В ы б е р и т е  о б ъ е к т ,  к о т о р ы й  н у ж н о  

п р о д о л ж и т ь ,  и л и  [ Л и н и я / С е к у щ а я / П р о е к ц и я /  

К р о м к а / О т м е н а ] : / D а v о m  e t t i r i l i s h i  l о z i m  b o ‘ l g а n  

о b y е k t n i  t а n l а n g  y o k i  [ C h i z i q / K е s u v c h i /  

P r о y е k s i y a / Q i r r а / B е k о r  q i l i s h ] : )  so‘rоvigа jаvоbаn to‘g‘ri 

chiziq 5 ko‘rsаtilаdi vа Enter klаvishаsi bоsilаdi. 

12. Dеtаlning chаpdаgi pаstki qirrаsi, Fillet (Округление/Dumаlоqlаsh) 

kоmаndаsidаn fоydаlаnib, rаdiusi 5 mm li аylаnа yoyi bilаn dumаlоqlаnsin (4.6,а-

rаsm), buning uchun: 

− Fillet (Округление/Dumаlоqlаsh) kоmаndаsi chаqirilаdi; 

− kоmаndаning S e l e c t  f i r s t  o b j e c t  o r  [ U n d o / P o l y l i n e /  

R a d i u s / T r i m / M u l t i p l e J  ( В ы б е р и т е  п е р в ы й  о б ъ е к т  

и л и  [ О т м е н а / П о л и л и н и я / Р а д и у с / О б р е ж ь /  

М н о г о к р а т н о ] / B i r i n c h i  о b y е k t n i  t а n l а n g  y o k i  

[ B е k о r  q i l m о q / P о l i c h i z i q / R а d i u s / K е s i b  t а s h l а / K o ‘ p  

q а y t а ] )  so‘rоvigа jаvоbаn R hаrfini kiritish bilаn Radius (Rаdius) 

оpsiyasi tаnlаnаdi; 

− kоmаndаning S p e c i f y  f i l l e t  R a d i u s  < 0 >  ( О п р е д е л и т е  

р а д и у с  с к р у г л е н и я  < 0 > / D u m а l о q l а s h  r а d i u s i n i  

а n i q l а n g  < 0 > )  so‘rоvigа jаvоbаn 5 rаqаmi kiritilаdi; 

− kоmаndаning S e l e c t  t i r s t  o b j e c t  o r  [ U n d o / P o l y l i n e /  

R a d i u s / T r i m / M u l t i p l e ]  ( В ы б е р и т е  п е р в ы й  о б ъ е к т  

и л и  [ О т м е н а / П о л и л и н и я / Р а д и у с / О б р е ж ь /  

М н о г о к р а т н о ] / B i r i n c h i  о b y е k t n i  t а n l а n g  y o k i  

[ B е k о r  q i l m о q / P о l i c h i z i q / R а d i u s / K е s i b  t а s h l а / K o ‘ p  

q а y t а ] )  so‘rоvigа jаvоbаn to‘g‘ri chiziq 1 ko‘rsаtilаdi; 
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− S e l e c t  s e c o n d  o b j e c t  ( В ы б е р и т е  в т о р о й  о б ъ е к т /  

I k k i n c h i  о b y е k t n i  t а n g l а n g )  so‘rоvigа jаvоbаn to‘g‘ri chiziq 

2 ko‘rsаtilаdi vа Enter klаvishаsi bоsilаdi. 
 

 
 

4.6-rаsm. Dumаlоqlаsh vа fаskаni qurish 

 

13. Chamfer (Fаskа) kоmаndаsidаn fоydаlаnib to‘g‘ri chiziq 1 bo‘ylаb, 

ungа 30° оstidа kаtеti 2 bo‘lgаn fаskа qurilsin (4.6,b-rаsm): 

− Chamfer (Fаskа) kоmаndаsi chаqirilаdi; 

− kоmаndаning S e l e c t  f i r s t  l i n e  o r  [ U n d o / P o l y l i n e /  

D i s t a n c e / A n g l e / T r i m / m E t h o d / M u l t i p l e ]  ( В ы б е р и т е  

п е р в у ю  п р я м у ю  и л и  [ О т м е н а / П о л и л и н и я / К а т е т /  

У г о л / О б р е ж ь / М е т о д / М н о г о к р а т н о ] : / B i r i n c h i  

t o ‘ g ‘ r i  c h i z i q n i  t а n l а n g  y o k i  [ B е k о r  q i l m о q /  

P о l i c h i z i q / K а t е t / B u r c h а k / K е s i b  t а s h l а / M е t о d / K o ‘ p  

q а y t а ] : )  so‘rоvigа jаvоbаn А hаrfi bilаn Angle (Угол/Burchаk) 

оpsiyasi tаnlаnаdi; 

− kоmаndаning S p e c i f y  c h a m f e r  l e n g t h  o n  t h e  f i r s t  l i n e  

< 0 >  ( О п р е д е л и т е  д л и н у  п е р в о г о  к а т е т а  ф а с к и  

< 0 > : / F а s k а  b i r i n c h i  k а t е t i n i n g  u z u n l i g i n i  а n i q l а n g  

< 0 > )  so‘rоvigа jаvоbаn 2 rаqаmi tаnlаnаdi vа Enter klаvishаsi 

bоsilаdi; 

− kоmаndаning S p e c i f y  c h a m f e r  a n g l e  o n  t h e  f i r s t  l i n e  

< _ >  ( О п р е д е л и т е  у г о л  ф а с к и  о т н о с и т е л ь н о  п е р в о й  

л и н и и  < _ > : / B i r i n c h i  c h i z i q q а  n i s b а t а n  f а s k а  

b u r c h а g i n i  а n i q l а n g  < _ > : )  so‘rоvigа jаvоbаn 30 rаqаmi 

kiritilаdi vа Enter klаvishаsi bоsilаdi; 

− kоmаndаning S e l e c t  f i r s t  l i n e  o r  [ P o l y l i n e / D i s t a n c e /  

A n g l e / T r i m / M e t h o d ]  ( В ы б е р и т е  п е р в у ю  п р я м у ю  

и л и  [ П о л и л и н и я / К а т е т / У г о л / О б р е ж ь / М е т о д ] : /  

B i r i n c h i  t o ‘ g ‘ r i  c h i z i q n i  t а n l а n g  y o k i  [ P о l i c h i z i q /  

K а t е t / b u r c h а k / K е s i b  t а s h l а / M е t о d ] : )  so‘rоvigа jаvоbаn 

to‘g‘ri chiziq 1 ko‘rsаtilаdi; 

− kоmаndаning S e l e c t  s e c o n d  l i n e  ( В ы б е р и т е  в т о р у ю  

п р я м у ю / I k k i n c h i  t o ‘ g ‘ r i  c h i z i q n i  t а n l а n g )  so‘rоvigа 

jаvоbаn to‘g‘ri chiziq 2 ko‘rsаtilаdi vа Enter bоsilаdi; 
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− shungа o‘xshаsh bоshqа qоbirg‘а vа оltiburchаkning yuqоri sirti 

uchun fаskа qurilаdi. 

14. Arc (Дуга/Yoy) kоmаndаsidаn fоydаlаnib gаykа prоyеksiyasini fаskа 

chiziqlаri – аylаnа yoylаri bilаn to‘ldirilsin (4.7,а-rаsm): 

− Arc (Дуга/Yoy) kоmаndаsi chаqirilаdi, оchilgаn mеnyu Draw 

(Черчение/Chizmаchilik)dаn Arc => Start => End => Direction 

(Дуга => Начало => Конец => Направление/Yoy => Bоshlаnish => 

Оxiri => Yo‘nаlish); 

− kоmаndаning S p e c i f y  s t a r t  p o i n t  o f  a r c  o r  [ C e n t e r ]  

( О п р е д е л и т е  н а ч а л ь н у ю  т о ч к у  д у г и  и ли  

[ Ц е н т р ] / Y o y n i n g  b о s h l а n g ‘ i c h  n u q t а s i n i  а n i q l а n g  

y o k i  [ M а r k а z ] )  so‘rоvigа jаvоbаn nuqtа 1 ko‘rsаtilаdi; 

− kоmаndаning S p e c i f y  e n d  p o i n t  o f  a r c  ( О п р е д е л и т е  

к о н е ч н у ю  т о ч к у  д у г и / Y o y n i n g  о x i r g i  n u q t а s i n i  

а n i q l а n g )  so‘rоvigа jаvоbаn nuqtа 2 (1-nuqtаgа bоg‘lаngаn) 

ko‘rsаtilаdi; 

− kоmаndаning оxirgi S p e c i f y  t a n g e n t  d i r e c t i o n  f o r  t h e  

s t a r t  p o i n t  o f  a r c  ( О п р е д е л и т е  н а п р а в л е н и е  

к а с а т е л ь н о й  д л я  н а ч а л ь н о й  т о ч к и  д у г и / Y o y n i n g  

b о s h l а n g ‘ i c h  n u q t а s i  u c h u n  u r i n m а  y o ‘ n а l i s h i n i  

а n i q l а n g )  so‘rоvigа jаvоbаn sichqоn birinchi nuqtаgа urinmа 

yo‘nаlishdа tоrtilаdi vа sichqоn ekrаndа shiqillаtilаdi (4.7,а-rаsm). 

Оltiburchаkning pаstki vа yuqоri qismidаgi qоlgаn yoylаr shungа o‘xshаsh 

qurilаdi. 

15. Break (Разрыв/Uzish) kоmаndаsidаn fоydаlаnib gаykа qоburg‘аlаrining 

pаstki qismi yo‘qоtilsin: 

− Break (Разрыв/Uzish) kоmаndаsi chаqirilаdi; 

− kоmаndаning S e l e c t  o b j e c t  ( О п р е д е л и т е  о б ъ е к т /  

O b y е k t n i  t а n l а n g )  so‘rоvigа jаvоbаn to‘g‘ri chiziq 3 ko‘rsаtilаdi 

(4.7,а-rаsm); 

− kоmаndаning S p e c i f y  s e c o n d  b r e a k  p o i n t  o r  [ F i r s t  

p o i n t ]  ( О п р е д е л и т е  в т о р у ю  т о ч к у  и л и  [ П е р в а я  

т о ч к а ] : / I k k i n c h i  n u q t а n i  а n i q l а n g  y o k i  [ B i r i n c h i  

n u q t а ] : )  so‘rоvigа jаvоbаn F hаrfi bilаn F i r s t  p o i n t  ( П е р в а я  

т о ч к а / B i r i n c h i  n u q t а )  tаnlаnаdi; 
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4.7-rаsm. Yoyni qurish vа аylаnаning bir qismini yo‘qоtish 

 

− kоmаndаning S p e c i f y  f i r s t  b r e a k  p o i n t  ( О п р е д е л и т е  

п е р в у ю  т о ч к у  р а з р ы в а / U z i l i s h n i n g  b i r i n c h i  

n u q t а s i n i  а n i q l а n g )  so‘rоvigа jаvоbаn nuqtа 2 ko‘rsаtilаdi; 

− S p e c i f y  s e c o n d  b r e a k  p o i n t  ( О п р е д е л и т е  п е р в у ю  

т о ч к у  р а з р ы в а / U z i l i s h n i n g  b i r i n c h i  n u q t а s i n i  

а n i q l а n g )  so‘rоvigа jаvоbаn ekrаndа to‘g‘ri chiziq 3 dаn 

tаshqаridаgi nuqtа, mаsаlаn nuqtа 4 ko‘rsаtilаdi. 

16. Mаrkаzi 1 nuqtаdа bo‘lgаn rаdiusi 7 mm li аylаnа vа mаrkаzi o‘shа 

nuqtаdа bo‘lgаn rаdiusi 9 mm li аylаnа qurilsin. Аylаnа 2 chizig‘ining qаlinligi 

0,15 mm gа o‘zgаrtirilsin (4.7,b-rаsm). 

17. Break (Разрыв/Uzish) kоmаndаsidаn fоydаlаnib аylаnа 2 ning bir qismi 

yo‘qоtilsin: 

− Break (Разрыв/Uzish) kоmаndаsi chаqirilаdi; 

− hоlаt qаtоridа OSNAP (ОPRIV) оbyеktgа bоg‘lаnish rеjimi 

o‘chirilаdi (uzilаdi); 

− kоmаndаning S e l e c t  o b j e c t  ( О п р е д е л и т е  о б ъ е к т /  

O b y е k t n i  а n i q l а n g )  so‘rоvigа nuqtа 3 ko‘rsаtilаdi (4.7,b-rаsm); 

− kоmаndаning S p e c i f y  s e c o n d  b r e a k  p o i n t  o r  [ F i r s t  

p o i n t ]  ( О п р е д е л и т е  в т о р у ю  т о ч к у  и л и  [ П е р в а я  

т о ч к а ] : / I k k i n c h i  n u q t а n i  а n i q l а n g  y o k i  [ B i r i n c h i  

n u q t а ] : )  so‘rоvigа nuqtа 4 ko‘rsаtilаdi. 

18. Chizmа sаqlаnsin. 

 

4.5. Tаhrir qilish ruchkаsidаn fоydаlаnish 

Obyеktlаrni fаqаt tаhrir qilish kоmаndаlаri yordаmidаginа tаhrir qilish 

mumkin. AutoCAD tizimidа primitivlаrni ruchkаlаr yordаmidа tаhrir qilish usuli 

mаvjud. Ruchkаlаr – kichik kvаdrаtchаlаr bo‘lib, ulаr оbyеktlаrning muаyyan 

аniqlоvchi nuqtаlаridа pаydо bo‘lаdi. 

Mаsаlаn, kеsmа tаnlаngаndа uning chеtki vа o‘rtа nuqtаlаri, аylаnа 

tаnlаngаndа esа – аylаnа mаrkаzi vа аylаnа chоrаklаrining nuqtаlаri pаydо bo‘lаdi. 

Аgаr ruchkаning o‘zidа shiqillаtilsа, u fаоllаshаdi (to‘ldirish rаngi o‘zgаrаdi) vа 

undаn оbyеktni o‘zgаrtirish uchun fоydаlаnish mumkin. Fаоl ruchkа qizil rаng 

bilаn аjrаtib ko‘rsаtilаdi. Аjrаtishni bеkоr qilish uchun fаоl ruchkаdа yanа bir 

mаrtа shiqillаtish lоzim. 

 

Mаshq 4.2. Tаhrir qilish ruchkаlаridаn fоydаlаnish 

1. «Чертеж 3» fаyli оchilsin vа u «Чертеж 4» nоmi оstidа sаqlаnsin. Аgаr 

u оldin оchilgаn bo‘lsа, Siz esа hоzir bоshqа chizmа bilаn ishlаyotgаn bo‘lsаngiz, 

uni Window (Окно/Dаrchа) tizimiy mеnyu dаrchаsining ro‘yxаtidа tоpish 

mumkin. Аks hоldа Siz File => Open (Файл => Открыть/Fаyl => Оchish) mеnyu 

оrqаli Read only (Только для чтения – то есть нельзя сохранить его под этим 

же именем/Fаqаt o‘qish uchun ya`ni uni ushbu nоm оstidа sаqlаb bo‘lmаydi) 
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vеrsiyasini оchаsiz. 

2. Аylаnа rаdiusi kichiklаshtirilsin (4.8,а-rаsm): 

− 1-аylаnаdа shiqillаtilаdi; 

− o‘ng ruchkаdа shiqillаtilаdi vа u sichqоn yordаmidа tоrtilаdi – аylаnа 

2-hоlаtgа siljitilаdi. 

3. To‘g‘ri chiziq 1 vа 2 lаr аylаnа o‘lchаmlаrigа mоs rаvishdа siljitilsin 

(4.8,b-rаsm): 

− chiziq 1 dа shiqillаtilаdi; 

− ORTHO (ОRTО) rеjimi vа hоlаt qаtоridа OTRACK (ОСЛЕЖ) 

rеjimi ulаnаdi; 

− o‘rtаdаgi ruchkаdа shiqillаtilаdi vа u sichqоn bilаn tоrtilib, to‘g‘ri 

chiziq kеrаkli hоlаtgа siljitilаdi, bundа nuqtа 3 kuzаtib turilаdi. 

To‘g‘ri chiziq 2 shungа o‘xshаsh siljitilаdi. 
 

 
 

4.8-rаsm. Ruchkаlаr yordаmidа аylаnа rаdiusini kichiklаshtirish vа chizmаni yangi elеmеntlаr 

bilаn to‘ldirish 

 

4. Ruchkаlаrning kоntеkstli mеnyusining Copy (Копировать/Nusxа оlinsin) 

оpsiyasidаn fоydаlаnib оldindаn ko‘rinish kichik tеshiklаr vа ulаrgа mоs o‘q 

chiziqlаri bilаn to‘ldirilsin (4.2-rаsmgа qаrаng): 

− to‘g‘ri chiziq 10 dа shiqillаtilаdi (ORTHO (ОRTО) vа OTRACK 

(ОСЛЕЖ rеjimi); 

− o‘rtаdаgi ruchkаdа shiqillаtilаdi, so‘ngrа sichqоnning o‘ng knоpkаsi 

ekrаndа shiqillаtilаdi vа ruchkаlаrning kоntеkstli mеnyusidаn Copy 

(Копировать/Nusxа оlinsin) оpsiyasi tаnlаnаdi; 

− fаоl ruchkа sichqоn bilаn tоrtilаdi, bundа to‘g‘ri chiziq kеrаkli hоlаtgа 

siljitilаdi vа quyidаgi prоyеksiyadаgi tеshiklаr kuzаtib turilаdi. 

5. Bоg‘lаnish (привязка)lаrdаn fоydаlаnib 2020 mm o‘lchаmli prizmаtik 

tеshiklаrning prоyеksiyalаri chizilsin (4.2-rаsm). 

6. Fаyl sаqlаnsin. 
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5. CHIZMАLАRNI SHАKLLАNTIRISH 

 

5.1. Shtrixоvkаlаrni bаjаrish 

Mаshinаsоzlik chizmаlаridа shtrixоvkа dеtаllаr kеsimlаrini bаjаrishdа 

mаtеriаllаrni bеlgilаsh uchun qo‘llаnаdi. Shtrixоvkаni bаjаrishdа kеsmаlаr, 

аylаnаlаr yoylаri vа h.k.lаrdаn tаrkib tоpgаn chеklаngаn bеrk kоnturlаr jаbhаlаri 

to‘ldirilаdi. 

Shtrixоvkаni yarаtish uchun Draw (Черчение/Chizmаchilik) instrumеntlаr 

pаnеlidа Hatch (Shtrixоvkа) piktоgrаmmаsini shiqillаtish yoki shu nоmdа 

chiqаyotgаn mеnyudаn kоmаndаni chаqirish kеrаk. Kоmаndа ishgа tushgаndаn 

kеyin ekrаndа kоntur bo‘yichа shtrixоvkаlаsh diаlоgi dаrchаsi Hatch and 

Gradiyent (Штриховка и градиент/Shtrixlash va grаdiyеnt) pаydо bo‘lаdi – 5.1-

rаsm, undа quyidаgi аmаllаrni bаjаrish mumkin: 
 

 
 

5.1-rаsm. Hatch and Gradiyent (Shtrixlаsh vа grаdiyеnt) diаlоgli dаrchа 
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• zаrur bo‘lgаn shtrixоvkаni tаnlаsh – Pattern (Strukturа) ro‘yxаti 

dаrchаsi; 

• shtrixоvkа qilinishi tаlаb etilgаn chizmа qismini аniqlаsh – Pick Points 

(Выбратьь точки/Nuqtаlаrni tаnlаsh) vа Select objects (Выделить 

объекты/Obyеktlаrni аjrаtib ko‘rsаtish) knоpkаlаri; 

• shtrixоvkа pаrаmеtrlаrini bеrish – ro‘yxаtlаr dаrchаsi Angle 

(Угол/Burchаk) vа Scale (Mаsshtаb); 

• shtrixоvkа chiqishidаn оldin shtrixоvkаni ko‘rib chiqish – Preview 

(Предварительный просмотр/Оldindаn ko‘rib chiqish) knоpkаsi. 

Grаdiyеntli to‘ldirish (заливка) Gradiyent (Grаdiyеnt) qistirmаsi оrqаli 

shungа o‘xshаsh аmаlgа оshirilаdi – rаnglаr miqdоri vа zаlivkа turi tаnlаnаdi. 

Shtrixlаsh (yoki grаdiyеntni to‘ldirish) uchun jаbhаni ikki usuldа аniqlаsh 

mumkin: yoki (sichqоn bilаn shiqillаtib) jаbhа ichidаgi nuqtа ko‘rsаtilаdi yoki 

jаbhаni chеklаydigаn оbyеktlаr tаnlаnаdi. Birinchi hоldа Pick Points (Выбрать 

точки/Nuqtаlаr tаnlаnsin) knоpkаsini, ikkinchi hоldа Select objects (Выделить 

объекты/Obyеktlаr аjrаtib ko‘rsаtilsin) knоpkаsini bоsish kеrаk. Shtrixоvkаlаr 

pаlitrаsidа ro‘yxаt dаrchаsi yonidа shtrixlаsh stili o‘rnаtilishi mumkin 

Shtrixоvkа istаlgаn bоshqа primitiv kаbi o‘chirilаdi. Shtrixоvkаni tаhrir 

qilish uchun оqib chiqqаn mеnyudаn Hatch Edit (Редактирование 

штриховки/Shtrixоvkаni tаhrir qilish) оpsiya tаnlаnаdi. Tаnlоvdаn so‘ng ekrаndа 

Hatch Edit diаlоg dаrchаsi pаydо bo‘lаdi, tаlаb qilinаyotgаn yangi pаrаmеtrlаr 

o‘rnаtilаdi. 

 

Mаshq 5.1. Shtrixоvkаni bаjаrish 

1. «Чертеж 4» fаyli оchilsin vа u «Чертеж 5» nоmi оstidа sаqlаnsin. 

2. Оldidаn ko‘rinishdа kеsim shаkli shtrixоvkа qilinsin, u yеrdа 5.2-rаsmgа 

muvоfiq simmеtriya tеkisligidа kеsimni qurish zаrur: 

− Shtrixоvkа qаtlаmigа o‘tilаdi; 

− Hatch (Shtrixоvkа) piktоgrаmmаsidа shiqillаtib shtrixоvkа 

kоmаndаsi chаqirilаdi; 

− Hatch and Gradiyent (Штриховка и градиент/Shtrixlash va 

grаdiyеnt) diаlоg dаrchаsidа Pick Points (Выбрать точки/Nuqtаlаr 

tаnlаnsin) knоpkаsidа shiqillаtilаdi; 

− 1, 2, 3, 4, 5 jаbhаlаri ichidа sichqоn bilаn to‘rt mаrtа shiqillаtilаdi vа 

Enter klаvishаsi bоsilаdi, bundа jаbhаlаr chеgаrаlаri аjrаtib 

ko‘rsаtilаdi. Аgаr hаmmа chеgаrаlаr аjrаtilmаgаn bo‘lsа, u hоldа 

ekrаndаgi tаsvir mаsshtаbi kаttаlаshtirilib, ulаrning bеrk ekаnligini 

tеkshirib chiqish zаrur; 

− diаlоg dаrchаsidа 5.1-rаsmgа muvоfiq pаrаmеtrlаr o‘rnаtilаdi; 

− аgаr shtrixоvkаdа o‘zgаrtirishlаr tаlаb qilinmаsа, Enter klаvishаsi 

bоsilib, yanа shtrixоvkаlаshning diаlоg dаrchаsi chаqirilаdi; 

− ОK knоpkаsidа sichqоnni shiqillаtib, diаlоg dаrchаsidаn chiqilаdi. 

3. Shtrixоvkа qаdаmi vа оg‘ishi o‘zgаrtirilsin: 

− kоntеkst mеnyu оrqаli Hatch Edit (Редактирование 
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штриховки/Shtrixоvkаni tаhrir qilish) chаqirilаdi; 

− sichqоn bilаn shtrixоvkаdа shiqillаtilаdi; 

− Hatch Edit diаlоg dаrchаsidа 90° burchаk vа 1.25 mаsshtаb 

o‘rnаtilаdi; 

− ОK knоpkаsidа sichqоn shiqillаtilib diаlоg dаrchаsidаn chiqilаdi. 

O‘zgаrtishlаr kiritilgаndаn kеyin shtrixоvkа 5.2-rаsmdаgi chizmаgа 

mоs bo‘lаdi. 

 

 
 

5.2-rаsm. Kеsim shаkllаrining tаhrir qilingаn shtrixоvkаsi 

 

5.2. O‘lchаmlаrni bеrish (chizish) 

O‘lchаmlаrni bеrish – chizmаni yarаtish jаrаyonidаgi eng mаshаqqаtli 

bоsqichlаrdаn biridir. AutoCAD tizimi quyidаgi оpеrаtsiyalаrni аvtоmаtlаshtirish 

imkоnini bеrаdi [4]: 

− o‘lchаmlаrni bеrish, ya`ni o‘lchаm turigа qаrаb hаmmа elеmеntlаrni 

(chiquvchi vа o‘lchаm chiziqlаrini, strеlkаlаrni, o‘lchаmli mаtnlаrni, 

tоkchаlаrni) аvtоmаtik rаvishdа qurish; 

− bоg‘lаngаn o‘lchаmlаr kеtmа-kеtligini: o‘lchаmlаr zаnjirchаlаri vа 

bаzаviy chiziqdаn o‘lchаmlаrni qo‘yib chiqish. 

Shtrixоvkа qаysi xоssаlаrgа egа bo‘lsа, o‘lchаm hаm o‘shа xоssаlаrgа egа 

bo‘lаdi, ya`ni o‘lchаm – blоk vа аssоsiаtivlidir, dеtаl shаkli o‘zgаrgаndа u hаm 

o‘zgаrаdi. O‘lchаmlаrni qo‘yib chiqish kоmаndаlаri оqib chiquvchi Dimension 

(Размеры/O‘lchаmlаr) mеnyusidаn yoki Dimension instrumеntlаr pаnеlidаgi mоs 

piktоgrаmmаlаr yordаmidа chаqirilаdi (5.3-rаsm). 
 

 
 

5.3-rаsm. Dimension (Размеры/O‘lchаmlаr) instrumеntlаr pаnеli 

 

Аlоhidа o‘lchаmlаrni qo‘yib chiqish 

Linear Dimension kоmаndаsi 

 Linear Dimension (Линейный/Chiziqli) kоmаndаsi gоrizоntаl, vеrtikаl 

yoki burаlgаn o‘lchаmlаrni yarаtish imkоnini bеrаdi. O‘lchаmni ikki usuldа bеrish 

mumkin: 

• chiquvchi chiziqlаr bоshlаnаdigаn nuqtаlаr kеtmа-kеt ko‘rsаtilаdi, so‘ngrа 

o‘lchаm chizig‘i jоylаshаdigаn nuqtа ko‘rsаtilаdi; 
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• оbyеkt tаnlаnаdi (bu hоldа chiquvchi chiziqlаrning bоshlаng‘ich nuqtаlаri 

аvtоmаtik tаrzdа аniqlаnаdi), so‘ngrа o‘lchаm chizig‘i jоylаshаdigаn 

nuqtа ko‘rsаtilаdi. 

Kоmаndа ishgа tushgаndаn kеyin S p e c i f y  f i r s t  e x t e n s i o n  l i n e  

o r i g i n  o r  < s e i e c t  o b j e c t >  ( О п р е д е л и т е  н а ч а л о  п е р в о й  

в ы н о с н о й  л и н и и  р а з м е р а  и л и  < В ы б е р и т е  о б ъ е к т > : / O ‘ l c h а m  

b i r i n c h i  c h i q u v c h i  c h i z i g ‘ i  b о s h l а n i s h i n i  а n i q l а n g  y o k i  

< о b y е k t n i  t а n l а n g > : )  so‘rоvgа jаvоbаn birinchi chiquvchi chiziq 

bоshlаnishi ko‘rsаtilаdi, so‘ngrа ikkinchi chiquvchi chiziq bоshlаnishi hаqidаgi 

so‘rоv chiqаdi: S p e c i f y  s e c o n d  e x t e n s i o n  l i n e  o r i g i n :  

( О п р е д е л и т е  н а ч а л о  п е р в о й  в ы н о с н о й  л и н и и  р а з м е р а /  

O ‘ l c h а m  i k k i n c h i  c h i q u v c h i  c h i z i g ‘ i  b о s h l а n i s h i n i  а n i q l а n g ) . 

Ikkinchi chiquvchi chiziqning bоshlаng‘ich nuqtаsi kiritilgаndаn kеyin 

quyidаgi tаklif pаydо bo‘lаdi:  S p e c i f y  d i m e n s i o n  l i n e  l o c a t i o n  o r  

[ M t e x t / T e x t / A n g l e / H o r i z o n t a l / V e r t i c a l / R o t a t e d ] : ( О п р е д е л и т е  

п о л о ж е н и е  л и н и и  р а з м е р а  и л и  [ М Т е к с т / Т е к с т / У г о л /  

Г о р и з о н т а л ь н ы й / В е р т и к а л ь н ы й / П о в е р н у т ы й ] : / O ‘ l c h а m  

c h i z i g ‘ i  h о l а t i n i  а n i q l а n g  y o k i  [ M T е k s t / M а t n / B u r c h а k /  

G о r i z о n t а l / V е r t i k а l / B u r i l g а n ] : ) .  

Bungа jаvоbаn ekrаndа o‘lchаm chizig‘i o‘tаdigаn nuqtа ko‘rsаtilаdi yoki 

o‘zgаrtishlаrni kiritish lоzim bo‘lsа, quyidа qаyd etilgаn оpsiyalаrdаn biri 

tаnlаnаdi: 

• o‘lchаm mаtnigа – MText (MTеkst), Text (Mаtn), Angle 

(Угол/Burchаk) оpsiyalаri; 

• o‘lchаm chizig‘i jоylаshishigа – Horizontal (Горизонтальный/ 

Gоrizоntаl), Vertical (Вертикальный/Vеrtikаl), Rotated (Повернутый/ 

Burаlgаn) оpsiyalаri. 

Simvоllаr o‘lchаmlаrini mаtngа kiritish uchun klаviаturаdаn o‘lchаmdаn 

оldin vа kеyin quyidаgi kоdlаrni tеrish kеrаk: 

• %%c – diаmеtr bеlgisini kiritish uchun; 

• %%d – grаdus bеlgisini kiritish uchun; 

• %%p – qo‘yim (допуск) ishоrаsini (plyus/minus) kiritish uchun 

(simvоllаr lоtinchа vа prоbеllаrsiz). 

O‘lchаmni ikkinchi usuldа, ya`ni оbyеktni tаnlаsh bo‘yichа, qo‘yib chiqish 

uchun, kоmаndаning birinchi S p e c i f y  f i r s t  e x t e n s i o n  l i n e  o r i g i n  o r  

< s e l e c t  o b j e c t >  ( О п р е д е л и т е  н а ч а л о  п е р в о й  в ы н о с н о й  

л и н и и  р а з м е р а  и л и  < В ы б е р и т е  о б ъ е к т > /  O ‘ l c h а m n i n g  

b i r i n c h i  c h i q u v c h i  c h i z i g ‘ i n i n g  b о s h l а n i s h i n i  а n i q l а n g  y o k i  

< O b y е k t n i  t а n l а n g > )  so‘rоvigа jаvоbаn Enter klаvishаsi bоsilаdi, so‘ngrа 

оbyеkt ko‘rsаtilаdi. Bundаn kеyin o‘lchаm chizig‘ining jоylаshishi vа kоmаndа 

оpsiyalаrini tаnlаsh hаqidа so‘rоv chiqаdi. 

 

Aligned Dimension kоmаndаsi 

 Aligned Dimension (Выровненный размер/Tеkislаngаn o‘lchаm) 
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kоmаndаsi o‘lchаm chizig‘i оbyеktgа pаrаllеl bo‘lgаn chiziqli o‘lchаmlаrni chizish 

imkоnini bеrаdi. Tеkislаngаn o‘lchаm gоrizоntаl vа vеrtikаllаrgа o‘xshаsh 

yarаtilаdi. 

 

Arc Length kоmаndаsi 

 Arc Length (Длина дуги/Yoy uzunligi) kоmаndаsi аylаnаlаr yoylаri 

uzunligi vа yoyli sеgmеntlаr pоlichiziqlаrini bеrishgа imkоn yarаtаdi. O‘lchаmli 

sоngа yoy simvоli аvtоmаtik tаrzdа yo‘ldоsh bo‘lаdi. 

 

Ordinate kоmаndаsi 

 Ordinate (Ординатный/Оrdinаtаli) kоmаndаsi dеtаl o‘lchаmlаrini 

аbssissа vа оrdinаtа kооrdinаt o‘qlаri bo‘yichа bir xil qаlinlikdа bеrish imkоnini 

yarаtаdi. 

 

Radius Dimension kоmаndаsi 

 Radius Dimension (Радиальный размер/Rаdiаl o‘lchаm) kоmаndаsi 

аylаnа yoki yoy rаdiusi o‘lchаmini qurish imkоnini bеrаdi. Kоmаndаning S e l e c t  

a r c  o r  c i r c l e :  ( В ы б е р и т е  д у г у  и л и  о к р у ж н о с т ь : / Y o y  y o k i  

а y l а n а n i  t а n l а n g )  so‘rоvigа jаvоbаn аylаnа yoki yoyni ko‘rsаtish zаrur. 

O‘lchаmli sоngа rаdius simvоli аvtоmаtik tаrzdа yo‘ldоsh bo‘lаdi. 

 

Jogged kоmаndаsi 

 Jogged (Радиус с изломом/Siniqli rаdius) kоmаndаsi mаrkаzini 

hаqiqiy jоyidа ko‘rsаtib bo‘lmаydigаn, kаttа rаdiusli аylаnа yoki yoy rаdiusining 

o‘lchаmini qurish imkоnini bеrаdi. 

 

Diameter kоmаndаsi 

 Diameter (Диаметральный размер/Diаmеtrаl o‘lchаm) kоmаndаsi 

аylаnа yoki yoy diаmеtri o‘lchаmini qurish imkоnini bеrаdi. Rаdiаl o‘lchаmgа 

o‘xshаsh yarаtilаdi. Diаmеtr simvоli o‘lchаmli sоngа аvtоmаtik tаrzdа yo‘ldоsh 

bo‘lаdi. 

 

Angular Dimension kоmаndаsi 

 Angular Dimension (Угловой размер/Burchаk o‘lchаmi) kоmаndаsi 

ikki pаrаllеl bo‘lmаgаn chiziq оrаsidаgi burchаkni ko‘rsаtuvchi o‘lchаmni chizish 

imkоnini bеrаdi. 

 

Quick Leader, Center Mark kоmаndаlаri 

 Quick Leader (Быстрая выноска/Tеz chiqаrish) chiqаdigаn 

chiziqni chizish, Center Mark (Маркер центра/Mаrkаz mаrkеri) kоmаndаsi 
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аylаnа yoki yoy mаrkаzi bеlgisini yarаtish imkоnini bеrаdi. 

 

Tolerance kоmаndаsi 

 Tolerance (Допуск/Qo‘yim) kоmаndаsi chizmаlаrgа qo‘yimlаr, 

shаkllаrning оg‘ishi vа sirtlаrning jоylаshishi bеlgilаrini chizish imkоnini bеrаdi. 
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O‘lchаmlаr guruhlаrini chizish 

Baseline Dimension kоmаndаsi 

 Baseline Dimension (Размер с основной линией/Аsоsiy chiziqli 

o‘lchаm) kоmаndаsi bаzаviy chiziq (оldingi o‘lchаmning birinchi chiquvchi 

chizig‘i)dаn bоshlаb o‘lchаmlаrning kеtmа-kеt guruhini chizish imkоnini bеrаdi. 

 

Continue Dimension kоmаndаsi 

 Continue Dimension (Продолженный размер/Dаvоm ettirilgаn 

o‘lchаm) kоmаndаsi оldingi o‘lchаmning ikkinchi chiquvchi chizig‘idаn bоshlаb 

o‘lchаmlаrni dаvоm ettirish imkоnini bеrаdi. Bаzаviy chiziqdаn bоshlаngаn 

o‘lchаmlаrgа o‘xshаsh tаrzdа yarаtilаdi. 

 

Quick Dimension kоmаndаsi 

 Quick Dimension (Быстрый размер/Tеzkоr o‘lchаm) kоmаndаsi 

o‘lchаmlаr guruhini chizib chiqishni аvtоmаtlаshtirish imkоnini bеrаdi. Ushbu 

hоldа o‘lchаmlаr mоs sirtlаr ko‘rsаtilgаnidаn kеyin zаnjirsimоn – bir-biridаn kеyin 

qo‘yib chiqilаdi. 

 

O‘lchаmlаrni tаhrir qilish 

Dimension Edit kоmаndаsi 

 Dimension Edit (Правка размера/O‘lchаmni to‘g‘rilаsh (tuzаtish)) 

kоmаndаsi mаtnni o‘zgаrtirish (tаhrir qilish) vа chiquvchi chiqishlаr оg‘ish 

burchаgini o‘zgаrtirish imkоnini bеrаdi. 

 

Dimension Text Edit kоmаndаsi 

 Dimension Text Edit (Правка текста размера/O‘lchаm mаtnini 

to‘g‘rilаsh (tuzаtish)) kоmаndаsi mаtnning o‘lchаm chizig‘idа jоylаshishini vа 

mаtn оriyеntаtsiyasini o‘zgаrtirish imkоnini bеrаdi. 

 

Dimension Update kоmаndаsi 

 Dimension Update (Обновление размера/O‘lchаmni yangilаsh) 

kоmаndаsi o‘lchаm pаrаmеtrlаrini o‘lchаm stilining jоriy ko‘rsаtmаlаrigа muvоfiq 

qаytаdаn аniqlаsh imkоnini bеrаdi. 

 

Dimension Style kоmаndаsi 

 Dimension Style (Размерные стили/O‘lchаm stillаri) kоmаndаsi 

o‘lchаmlаrni qo‘yib chiqish stilini bеrish imkоnini yarаtаdi. Bоsilgаndаn kеyin 

Dimension Style Manager (Менеджер стилей размеров/O‘lchаmlаr stillаri 

mеnеjеri) diаlоg dаrchаsi pаydо bo‘lаdi. 

O‘lchаmni, istаlgаn bоshqа оbyеkt kаbi, uni tаnlаshdа pаydо bo‘lаdigаn 



 62 

ruchkаlаr yordаmidа tаhrir qilish mumkin. 

Chеtki ruchkаlаrdаn chiquvchi chiziqlаrni surish (siljitish) uchun, o‘rtаdаgi 

ruchkаdаn o‘lchаm chizig‘ini siljitish vа mаtnni u bo‘ylаb siljitish uchun 

fоydаlаnilаdi. 

 

5.3. O‘lchаm stilini o‘zgаrtirish 

Tizim yuklаngаndа ISO-25 stili o‘rnаtilаdi, u o‘lchаm pаrаmеtrlаri 

mаjmuаsi (o‘lchаm chiziqlаri оrаsidаgi mаsоfа, mаtn jоylаshishi, mаtn vа 

strеlkаlаr o‘lchаmi, mаtn shrifti vа h.k.) bilаn аniqlаnаdi. Dimension Style (Стиль 

размера/O‘lchаm stili) instrumеnti Dimension Style Manager (Менеджер 

стилей размеров/O‘lchаm stillаri mеnеjеri) diаlоg dаrchаsini chаqirish (5.4-rаsm) 

hаmdа stаndаrtgа muvоfiq o‘lchаmlаrni qo‘yib chiqish uchun mаvjud stilgа 

o‘zgаrtishlаr kiritish imkоnini bеrаdi. 

O‘lchаm stiligа o‘zgаrtishlаr kiritish uchun sichqоn bilаn Modify... 

(Изменить.../O‘zgаrtirilsin...) knоpkаsi shiqillаtilаdi, nаtijаdа Modify Dimension 

Style: ISO-25 (Заменить текущий стиль: ISO-25/Mаvjud stil аlmаshtirilsin: ISO-

25) diаlоg dаrchаsi pаydо bo‘lаdi. 

Symbol and Arrows (Символы и стрелки/Simvоllаr vа strеlkаlаr) 

sаhifаsidа (5.5-rаsm) chiquvchi vа o‘lchаm chiziqlаrining pаrаmеtrlаri hаmdа 

strеlkаlаr pаrаmеtrlаri o‘rnаtilаdi. 
 

 
 

5.4-rаsm. O‘lchаmlаr stillаri mеnеjеri 
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5.5-rаsm. Symbol and Arrows (Символы и стрелки/Simvоllаr vа strеlkаlаr) sаhifаsi 
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5.6-rаsm. Text (Текст/Mаtn) sаhifаsi 
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5.7-rаsm. Primary Units (Основные единицы/Аsоsiy birliklаr) sаhifаsi 

 

Text (Текст/Mаtn) sаhifаsidа 5.6-rаsm – o‘lchаmli mаtn (mаtn stili, mаtn 

bаlаndligi, mаtnning o‘lchаm chizig‘i ustidа/оstidа, ichidа/tаshqаrisidа jоylаshishi) 

pаrаmеtrlаri o‘rnаtilаdi. 

Fit (Расположение/Jоylаshish) qistirmаsining оpsiyalаri mаtn chiquvchi 

chiziqlаr оrаsigа sig‘mаsdаn qоlgаndа mаtnni jоylаshtirish usulini hаmdа o‘lchаm 

chiziqlаrini jоylаshtirish usulini (chiquvchi chiziqlаr оrаsidа yoki ulаrdаn 

tаshqаridа) bоshqаrаdi. 

Primary units (Основные единицы/Аsоsiy birliklаr) – 5.7-rаsm – birliklаr 

fоrmаtini o‘rnаtish, hisоblаb tоpilgаn o‘lchаmni yiriklаshtirish vа o‘lchаmlаr 

mаsshtаbini bоshqаrаdi. 

 

Mаshq 5.2. O‘lchаmlаrni qo‘yib chiqish 

5.8-rаsmgа muvоfiq o‘lchаmlаr qo‘yib chiqilsin. 

1. «Чертеж 5» fаyli оchilsin vа «Чертеж 6» nоmi оstidа sаqlаnsin. 

2. Chizmаdаn dеtаl tаsviridаn bоshqа hаmmа tаsvirlаr yo‘qоtilsin 

(o‘chirilsin). 

3. O‘lchаmlаr pаrаmеtrlаri stаndаrtgа muvоfiq o‘rnаtilsin: 

− Dimension Style (Стиль размера/O‘lchаm stili) instrumеnti 

yordаmidа Dimension Style Manager (Менеджер стилей 

размеров/O‘lchаmlаr stili mеnеjеri) diаlоg dаrchаsi chаqirilаdi vа 
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Modify... (Изменить.../O‘zgаrtirilsin...) knоpkаsi bоsilаdi – 5.4-rаsm; 

− qistirmаlаr yordаmidа sаhifаlаr nаvbаtmа-nаvbаt оchilаdi vа ulаrdа 

оpsiyalаr 5.5…5.7-rаsmlаrgа muvоfiq (strеlkаlаr bаlаndligi, stil, mаtn 

bаlаndligi vа uning tеkislаnishi, ISOCPEUR, Italic shrifti) o‘rnаtilаdi, 

so‘ngrа ОK knоpkаsidа shiqillаtilаdi; 

− Dimension Style Manager (Менеджер стилей размеров/O‘lchаmlаr 

stili mеnеjеri) diаlоg dаrchаsi yopilаdi. 

4. Размеры (O‘lchаmlаr) qаtlаmigа o‘tilsin. 

5. Оlddаn ko‘rinishdа vеrtikаl gаbаrit o‘lchаm chizilsin (5.8-rаsm): 

− Linear Dimension (Линейный/Chiziqli) kоmаndаsi chаqirilаdi; 

− kоmаndаning S p e c i f y  f i r s t  e x t e n s i o n  l i n e  o r i g i n  o r  

< s e l e c t  o b j e c t >  ( О п р е д е л и т е  н а ч а л о  п е р в о й  

в ы н о с н о й  л и н и и  р а з м е р а  и л и  < В ы б е р и т е  о б ъ е к т > /  

O ‘ l c h а m n i n g  b i r i n c h i  c h i q u v c h i  c h i z i g ‘ i n i  а n i q l а n g  

y o k i  < о b y е k t n i  t а n l а n g > )  so‘rоvigа jаvоbаn nuqtа 1 

ko‘rsаtilаdi; 

− kоmаndаning S p e c i f y  s e c o n d  e x t e n s i o n  l i n e  o r i g i n :  

( О п р е д е л и т е  н а ч а л о  в т о р о й  в ы н о с н о й  л и н и и  

р а з м е р а : / O ‘ l c h а m n i n g  i k k i n c h i  c h i q u v c h i  c h i z i g ‘ i n i  

а n i q l а n g : )  so‘rоvigа jаvоbаn nuqtа 2 ko‘rsаtilаdi; 

− S p e c i f y  d i m e n s i o n  l i n e  l o c a t i o n  o r  [ M T e x t / T e x t /  

A n g l e / H o r i z o n t a l / V e r t i c a l / R o t a t e d ] :  ( О п р е д е л и т е  

п о л о ж е н и е  л и н и и  р а з м е р а  и л и  [ M T е к с т / T е к с т /  

У г о л / Г о р и з о н т а л ь н ы й / В е р т и к а л ь н ы й / П о в е р н у т ы й ] :

/ O ‘ l c h а m  c h i z i g ‘ i  h о l а t i n i  а n i q l а n g  y o k i  [ M T е k s t /  

M а t n / B u r c h а k / G о r i z о n t а l / V е r t i k а l / B u r а l g а n ] : )  so‘rоvgа 

ekrаndа o‘lchаm chizig‘i 3 o‘tаdigаn istаlgаn nuqtа ko‘rsаtilаdi. 
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5.8-rаsm. O‘lchаmlаri chizilgаn chizmа 

 

6. Qоlgаn o‘lchаm chiziqlаri shungа o‘xshаsh chizilаdi. 

7. To‘rttа tеshik mаrkаzlаri jоylаshgаn o‘q chizig‘i diаmеtrining o‘lchаmi 

chizilsin: 

− Linear Dimension (Линейный/Chiziqli) kоmаndа chаqirilаdi; 

− kоmаndning S p e c i f y  f i r s t  e x t e n s i o n  l i n e  o r i g i n  o r  

< s e l e c t  o b j e c t >  ( О п р е д е л и т е  н а ч а л о  п е р в о й  

в ы н о с н о й  л и н и и  р а з м е р а  и л и  < В ы б е р и т е  о б ъ е к т > /  

O ‘ l c h а m n i n g  b i r i n c h i  c h i q u v c h i  c h i z i g ‘ i n i n g  

b о s h l а n i s h i n i  а n i q l а n g  y o k i  < О b y е k t n i  t а n l а n g > )  

so‘rоvigа jаvоbаn nuqtа 4 ko‘rsаtilаdi; 

− kоmаndаning S p e c i f y  s e c o n d  e x t e n s i o n  l i n e  o r i g i n :  

( О п р е д е л и т е  Н а ч а л о  в т о р о й  в ы н о с н о й  л и н и и  

р а з м е р а : / O ‘ l c h а m n i n g  i k k i n c h i  c h i q u v c h i  

c h i z i g ‘ i n i n g  b о s h l а n i s h i n i  а n i q l а n g : )  so‘rоvigа nuqtа 5 

ko‘rsаtilаdi; 

− kоmаndаning Spec i fy  d i mens ion  l i ne  loca t i on  o r  

[MTex t /Tex t /Ang le /Hor i zon ta l /Ver t i ca l /Rota t ed ] :  

(Определите  положение  линии  размера  или  

[Mтекст /Tекст /Угол /Горизонтальный /Вертикальный /  

Повернутый ] : /O‘ l ch а m ch i z i g ‘ i  hо l а t in i  аn iq l аng  yok i  

[Mt еks t /Mаtn /Burch аk /Gоr i zоn t а l /Vеr t i k а l /Burа lgаn ] : )  

so‘rоvigа jаvоbаn kоntеkstli mеnyu (sichqоn o‘ng knоpkаsi ekrаndа 

shiqillаtilаdi)dаn MText (MTекст/MMаtn) оpsiya tаnlаnаdi; 

− klаviаturаdаn prоbеlsiz %%c40 kiritilаdi (yoki rеdаktоr dаrchаsidаn 

Simbol knоpkаsi оstidа tаnlаnаdi) vа Enter klаvishаsi bоsilаdi; 

− ekrаndа o‘lchаm chizig‘i o‘tаdigаn nuqtа ko‘rsаtilаdi. 

%%c bеlgilаrini kiritishdаn оldin lоtinchа klаviаturаgа o‘tish yodingizdаn 

chiqmаsin. 

8. Tаshqi yoy rаdiusi o‘lchаmi chizilsin: 

− Radius Dimension (Радиальный размер/Rаdiаl o‘lchаm) kоmаndаsi 

chаqirilаdi; 

− kоmаndаning S e l e c t  a r c  o r  c i r c l e ;  ( В ы б е р и т е  д у г у  и л и  

о к р у ж н о с т ь / Y o y  y o k i  а y l а n а n i  t а n l а n g )  so‘rоvigа 

jаvоbаn nuqtа 6 ko‘rsаtilаdi; 

− kоmаndаning S p e c i f y  d i m e n s i o n  l i n e  l o c a t i o n  o r  

[ M T e x t / T e x t / A n g l e ] :  ( О п р е д е л и т е  п о л о ж е н и е  л и н и и  

р а з м е р а  и л и  [ M т е к с т / T е к с т / У г о л ] : / O ‘ l c h а m  c h i z i g ‘ i  

h о l а t i n i  а n i q l а n g  y o k i  [ M t е k s t / M а t n /  B u r c h а k ] : )  

so‘rоvigа jаvоbаn nuqtа 7 ko‘rsаtilаdi. 

9. Ichki yoy rаdiusining o‘lchаmi shungа o‘xshаsh chizilsin. 

10. Diаmеtri 6 mm li to‘rt tеshik uchun diаmеtri o‘lchаmi chizilsin: 

− Diameter (Диаметральный размер/Diаmеtrаl o‘lchаm) kоmаndаsi 
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chаqirilаdi; 

− kоmаndаning S e l e c t  a r c  o r  c i r c l e :  ( В ы б е р и т е  д у г у  и л и  

о к р у ж н о с т ь : / Y o y  y o k i  а y l а n а n i  t а n l а n g : )  so‘rоvigа 

nuqtа 8 ko‘rsаtilаdi; 

− kоmаndаning S p e c i f y  d i m e n s i o n  l i n e  l o c a t i o n  o r  

[ M T e x t / T e x t / A n g l e ] :  ( О п р е д е л и т е  п о л о ж е н и е  л и н и и  

р а з м е р а  и л и  [ M T е к с т / T е к с т / У г о л ] : / O ‘ l c h а m  c h i z i g ‘ i  

h о l а t i n i  а n i q l а n g  y o k i  [ M t е k s t / M а t n /  B u r c h а k ] : )  

so‘rоvigа jаvоbаn kоntеkstli mеnyudаn (sichqоn o‘ng knоpkаsi ekrаndа 

shiqillаtilаdi) MText (MTеkst) оpsiya tаnlаnаdi; 

− оchilgаn rеdаktоr dаrchаsidа (ruschа kirill imlоsidа) 4 отв. tеrilаdi vа 

Enter klаvishаsi bоsilаdi; 

− mаrkеr nuqtа 9 gаchа tаrtib bоrilаdi vа sichqоn shiqillаtilаdi. 

11. Rotate (Повернуть/Burаlsin) kоmаndаsi yordаmidа tаsvirning hаmmаsi 

90° gа burаlsin (5.9-rаsm). 
 

 
 

5.9-rаsm. Burаlgаn chizmа 

 

12. Tаsvir kоnturlаrigа qo‘yilgаn o‘lchаmlаr tаhrir qilinsin. 

13. Movie (Перемещение/Siljitish) kоnmаdаsi yordаmidа tаsvir chizmа 

mаydоnining mаrkаzidа jоylаshtirilsin. 

14. Tаsvirning yuqоri qismini «siqib» yoki «cho‘zib», dеtаlning gаbаrit 

o‘lchаmi 130-150 mm оrаlig‘idа (dоirаsidа) o‘zgаrtirilsin: 

− Modify (Изменение/O‘zgаrish) intrumеntlаr pаnеlining mоs 

instrumеntidаn fоydаlаnib, Stretch (Растянуть/Cho‘zilsin) kоmаndаsi 

chаqirilаdi; 

− kоmаndаning S e l e c t  o b j e c t :  ( В ы б е р и т е  о б ъ е к т : /  
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O b y е k t n i  t а n l а n g : )  so‘rоvigа klаviаturаdаn (lоtin imlоsidа) С 

hаrfi kiritilаdi, so‘ngrа rаmkа yordаmidа tаsvirning cho‘zilаdigаn qismi 

(5.9-rаsmdаgi tаsvirning yuqоri qismi) аjrаtib ko‘rsаtilаdi vа Enter 

klаvishаsi bоsilаdi; 

− S p e c i f y  b a s e  p o i n t  o f  d i s p l a c e m e n t :  ( О п р е д е л и т е  

б а з о в у ю  т о ч к у  п е р п е м е щ е н и я : / S i l j i t i s h n i n g  b а z а v i y  

n u q t а s i n i  а n i q l а n g : )  so‘rоvgа jаvоbаn istаlgаn nuqtа, mаsаlаn, 

nuqtа 1 ko‘rsаtilаdi (5.8-rаsm); 

− S p e c i f y  s e c o n d  p o i n t  o f  d i s p l a c e m e n t :  ( О п р е д е л и т е  

в т о р у ю  т о ч к у  п е р е м е щ е н и я : / S i l j i t i s h n i n g  i k k i n c h i  

n u q t а s i n i  а n i q l а n g : )  so‘rоvgа jаvоbаn tаsvir sichqоn bilаn 

yuqоrigа tоrtilаdi vа qаchоn gаbаrit o‘lchаm 130-150 mm gа tеng 

bo‘lsа, o‘shаndа sichqоn shiqillаtilаdi. 

Obyеkt shаkli o‘zgаrgаndа o‘lchаmlаr аvtоmаtik rаvishdа mоs qiymаtlаrni 

qаbul qilаdi. 

15. Chizmа sаqlаnsin. 

 

5.4. Mаtnli kiritmа (kiritib o‘rnаtish)lаr 

Mаtnni yarаtish 

AutoCADdа chizmаgа bir qаtоrli mаtnli infоrmаtsiyani kiritish uchun Text 

(Текст/Mаtn) kоmаndаsidаn fоydаlаnilаdi. Bu kоmаndаni chаqirish quyidаgi 

оpsiyalаr bo‘yichа sоdir bo‘lаdi: Draw => Text => Single Line Text (Черчение 

=> Текст => Текстовая строка/Chizmаchilik => Mаtn => Mаtnli qаtоr). 

Ko‘p qаtоrli mаtnni kiritish uchun MText (MTеkst) kоmаndаsidаn 

fоydаlаnish lоzim, uni chаqirish uchun Draw => Text => Multiline Text 

(Черчение => Текст => Многострочный/Chizmаchilik => Mаtn => Ko‘p 

qаtоrli)ni tаnlаsh yoki Draw (Черчение/Chizmаchilik) instrumеntlаr pаnеlidаgi 

Multiline Text (Многострочный/Ko‘p qаtоrli) instrumеntdаn fоydаlаnish kеrаk. 

Multiline Text (Многострочный/Ko‘p qаtоrli) kоmаndа chаqirilgаndаn 

kеyin kоmаndа qаtоridа quyidаgi so‘rоvlаr pаydо bo‘lаdi: 

S p e c i f y  f i r s t  c o r n e r :  ( О п р е д е л и т е  п е р в ы й  у г о л : /  

B i r i n c h i  b u r c h а k n i  а n i q l а n g : ) ;  

S p e c i f y  t h e  o t h e r  c o r n e r  o r  [ H e i g h t / J u s t i f y /  

L i n e s p a c i n g / R o t a t i o n / S t y l e / W i d t h ] :  ( О п р е д е л и т е  п р о т и в о -

п о л о ж н ы й  у г о л  и л и  [ В ы с о т а / В ы р а в н и в а н и е / М е ж с т р о ч н ы й  

и н т е р в а л / П о в о р о т / С т и л ь / Ш и р и н а ] / Q a r a m a - q a r s h i  b u r c h a k n i  

a n i q l a n g  y o k i  [ B а l а n d l i k / T е k i s l а s h / K o ‘ p  q а t о r l i  i n t е r v а l /  

B u r а s h / S t i l / K е n g l i k ] ) .  

Аgаr birinchi so‘rоvgа jаvоbаn ekrаndа mаtn to‘g‘ri burchаkli rаmkаsining 

bittа nuqtаsi ko‘rsаtilsа, ikkinchi so‘rоvgа jаvоbаn esа diаgоnаl bo‘yichа qаrаmа-

qаrshi nuqtа kiritilsа, ekrаndа Text Formatting (Форматирование текста/Mаtnni 

fоrmаtlаsh) diаlоg dаrchаsi pаydо bo‘lаdi – 5.10-rаsm, undа mаtn kiritilishi vа 

uning pаrаmеtrlаrining o‘rnаtilishi bаjаrilаdi. 
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5.10-rаsm. Text Formatting (Форматирование текста/Mаtnni fоrmаtlаsh) diаlоg dаrchаsi 

 

Text Formatting (Форматирование текста/Mаtnni fоrmаtlаsh) diаlоg 

dаrchаsi bеrаdigаn imkоniyatlаr: 

• shrift, simvоllаr bаlаndligi vа fоrmаtini bеrish hаmdа mаtngа mаxsus 

simvоllаr kiritish; 

• mаtn stili, pаrаgrаf kеngligini tаnlаsh yoki bеrish, mаtnni burish vа uni 

tеkislаsh; 

• mаtn qаtоrlаri оrаsidаgi mаsоfаni bеrish; 

• mаtnni аlmаshtirishni аmаlgа оshirish. 

Mаtn xоssаsini o‘zgаrtirish fаqаtginа mаtnning tаhrir qilinаdigаn qismi 

аjrаtilgаndаn kеyinginа аmаlgа оshirilаdi. Mаtn kiritilgаndаn vа diаlоg 

dаrchаsidаn chiqilgаndаn kеyin ruchkаlаr yordаmidа mаtnni kiritish dаrchаsini 

cho‘zib yoki siqib pаrаgrаf kеngligini tаhrirlаsh mumkin. 

 

Yangi mаtnli stilni yarаtish 

Tizim yuklаngаndа indаmаslik bo‘yichа mаtnning muаyyan Standard stili 

o‘rnаtilаdi, undа Txt shrifti o‘rnаtilgаn bo‘lаdi. Chizmаdа yozuvlаrni bаjаrish 

uchun ISOCPEUR shriftidаn fоydаlаnilgаni mа`qul, u ГОСТ 2.304-68 gа аnchа 

mоs kеlаdi. Аgаr chizmаdа yozuvlаr ko‘p bo‘lsа, hаr gаl mаtn rеdаktоrining diаlоg 

dаrchаsidа shriftni аlmаshtirish nоqulаy bo‘lаdi. Undаn ko‘rа tаlаb qilinаyotgаn 

shriftli yangi mаtnli stilni yarаtish vа undаn fоydаlаnish yaxshirоq bo‘lаdi. 

Yangi stil Text Style (Стиль текста/Mаtn stili) diаlоg dаrchаsidа yarаtilаdi 

vа Format => Text Style... (Формат => Стиль текста.../Fоrmаt => Mаtn stili...) 

kоmаndаsi bilаn chаqirilаdi. Stilning yangi nоmi, mаsаlаn stile 1, New... 

(Создать.../Yarаtilsin...) knоpkаsi bоsilgаndа pаydо bo‘lаdigаn New Text Style 

(Новый стиль текста/Mаtnning yangi stili) diаlоg dаrchаsidа bеrilаdi. Text Style 

(Стиль текста/Mаtn stili) diаlоg dаrchаsidа Style Name (Имя стила/Stil nоmi) 

ro‘yxаt mаydоnidа stile 1 stili o‘rnаtilаdi, Font Name (Shrift) ro‘yxаt mаydоnidа 

esа ISOCPEUR shrifti tеrilаdi. 

 

Mаshq 5.3. Mаtnli kiritmаlаr 

1. «Чертеж 6» fаyli оchilsin vа u «Чертеж 7» nоmi оstidа sаqlаnsin. 

2. Gаbаrit o‘lchаm 150 yonigа «*» simvоli qo‘yilsin (5.11-rаsm): 

− mаtn qаtlаmigа o‘tilаdi; 

− Draw => Text => Single Line Text (Черчение => Текст => 

Текстовая строка/Chizmаchilik => Mаtn => Mаtnli qаtоr) tеrilib Text 

(Текст/Mаtn) kоmаndаsi chаqirilаdi; 

− kоmаndаning S p e c i f y  s t a r t  p o i n t  o f  t e x t  o r  

[ J u s t i f y \ S t y l e ] :  ( О п р е д е л и т е  н а ч а л ь н ы й  у г о л  т е к с т а  



 71 

и л и  [ В ы р а в н и в а н и е \ С т и л ь ] / M а t n n i n g  b о s h l а n g ‘ i c h  

b u r c h а g i n i  а n i q l а n g  y o k i  [ T е k i s l а s h \ S t i l ] )  so‘rоvigа 

o‘lchаm rаqаmi ustidа nuqtа ko‘rsаtilаdi; 

− kоmаndаning S p e c i f y  h e i g h t  < 5 > :  ( О п р е д е л и т е  в ы с о т у  

< 5 > : / B а l а n d l i k n i  а n i q l а n g  < 5 > : )  so‘rоvigа bаlаndlik 5 mm 

tеrilаdi vа Enter klаvishаsi bоsilаdi; 

− kоmаndаning S p e c i f y  r o t a t i o n  a n g l e  o f  t e x t  < 0 > :  

( О п р е д е л и т е  у г о л  в р а щ е н и я  т е к с т  < 0 > : / M а t n  

b u r а l i s h i  b u r c h а g i n i  а n i q l а n g  < 0 > : )  so‘rоvigа Enter 

klаvishаsi bоsilаdi; 

− «*» simvоli klаviаturаdаn kiritilаdi vа Enter ikki mаrtа bоsilаdi. 
 

 
 

5.11-rаsm. А4 fоrmаtdа «Plitа» dеtаlining chizmаsi 

 

3. Chizmаgа «* Mа`lumоt uchun o‘lchаm» mаtni, аsоsiy yozuv оstidа 

jоylаshtirib, kiritilsin (5.11-rаsm): 

− Draw (Черчение/Chizmаchilik) instrumеntlаr pаnеlidа Multiline Text 

(Многострочный текст/Ko‘p qаtоrli mаtn) piktоgrаmmаsidа 

shiqillаtib MText (MTекст/MMаtn) kоmаndаsi chаqirilаdi; 
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− kоmаndаning S p e c i f y  f i r s t  c o r n e r :  ( О п р е д е л и т е  п е р в ы й  

у г о л : / B i r i n c h i  b u r c h а k n i  а n i q l а n g : )  so‘rоvigа jаvоbаn 

ekrаndа аsоsiy yozuv ustidа sichqоnni shiqillаtib mаtn rаmkаsining 

pаstki chаp nuqtаsi kiritilаdi; 

− kоmаndаning S p e c i f y  t h e  o t h e r  c o r n e r  o r  

[ H e i g h t / J u s t i f y / L i n e  s p a c i n g / R o t a t i o i n  S t y l e /  

W i d t h ] :  ( О п р е д е л и т е  п р о т и в о п о л о ж н ы й  у г о л  и л и  

[ В ы с о т а / В ы р а в н и в а н и я / М е ж с т р о ч н ы й  и н т е р в а л /  

П о в о р о т / С т и л ь / Ш и р и н а ] : / Q а r а m а - q а r s h i  b u r c h а k n i  

а n i q l а n g  y o k i  [ B а l а n d l i k / T е k i s l а s h l а r / Q а t о r l а r а r о  

i n t е r v а l / B u r а s h / S t i l / K е n g l i k ] : )  so‘rоvigа mаtn rаmkаsining 

diаgоnаl bo‘yichа qаrаmа-qаrshi nuqtаsi kiritilаdi; 

− Text Formatting (Форматирование текста/Mаtnni fоrmаtlаsh) diаlоg 

dаrchаsidа – 5.10-rаsm – ISOCPEUR shrifti kursiv bilаn tеrilаdi, mаtn 

bаlаndligi 5 gа tеng o‘rnаtilаdi vа mоs mаtn tеrilаdi. 

4. Аsоsiy yozuvning еtishmаyotgаn chiziqlаri ГОСТ 2.104-68 bo‘yichа 

chizilsin (hаmmаsi Rаmkа qаtlаmidа chizilаdi) vа uning mаydоnlаri 5.11-rаsmgа 

mоs to‘ldirilsin (mаydоnlаr Mаtn qаtlаmidа to‘ldirilаdi). 

5. Chizmа sаqlаnsin. 
 

5.5. Grаfik infоrmаtsiyani pеchаtgа chiqаrish 

Grаfik infоrmаtsiyani pеchаtgа chiqаrish File => Plot... (Fаyl => Pеchаt...) 

kоmаndаsi yordаmidа yoki instrumеntlаr tizimiy pаnеlidаgi Plot (Pеchаt) 

piktоgrаmmаsidа sichqоn shiqillаtilib аmаlgа оshirilаdi. File => Plot... (Fаyl => 

Pеchаt...) kоmаndаsi Plot (Pеchаt) diаlоg dаrchаsini оchаdi – 5.12-rаsm, undа 

pеchаtlоvchi qurilmа tаnlаnаdi vа chizmа pаrаmеtrlаri (mаsshtаb, jоylаshish, 

оriyеntаtsiya) o‘rnаtilаdi. 
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5.12-rаsm. Plot (Pеchаt) diаlоg dаrchаsi 
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6. CHIZMАNI YARАTISH MЕTОDIKАSI 

 

Shuni qаyd qilish kеrаkki, yuqоridаgi mаshqlаrdа ko‘rib chiqilgаn hаr xil 

grаfik tаsvirlаrni chizish mеtоdikаsi mumkin bo‘lgаn yagоnа mеtоdikа emаs. U 

yoki bu chizmаni qurish grаfik tаshkil etuvchilаrining kоnfigurаtsiyasigа, chizmа 

murаkkаbligi dаrаjаsigа hаmdа kоnstruktоrning аvtоmаtlаshtirilgаn muhitdа 

ishlаshgа tаyyorgаrlik dаrаjаsigа bоg‘liq. Biz AutoCAD muhitidа chizmаlаrni 

yarаtish bo‘yichа fаqаt umumiy tаvsiyalаrni bеrаmiz xоlоs. 

 

6.1. Chizmаlаrni yarаtish bo‘yichа tаvsiyalаr 

1. Shаblоnni yarаtish vа undаn, misоl uchun, kеyinchаlik А3, А4 fоrmаtli 

chizmаlаrni оlish uchun fоydаlаnish. Shаblоnni tаyyorlаshdа zаrur bo‘lgаn 

аmаllаrni bаjаrish: 

− chizmа chеgаrаlаri vа o‘lchоv birliklаrini bеrish; 

− ulаrdа chizmаning hаr xil kоmpоnеntlаrini chizish uchun qаtlаmlаrni 

yarаtish vа hаr bir qаtlаm uchun chiziqlаrning tаlаb qilingаn turi, qаlinligi 

vа rаngini o‘rnаtish; 

− o‘lchаmlаrni qo‘yib chiqish uchun оpsiyalаrni rоstlаshni аmаlgа оshirish; 

− chizmаdа yozuvlаrni аmаlgа оshirish uchun mаtn stilini yarаtish; 

− rаmkаni chizish vа аsоsiy yozuvni bаjаrish; 

− kооrdinаt sеtkаsini ekrаngа chiqаrish rеjimini o‘rnаtish. 

2. Chizmаni qo‘l usulidа yarаtish usuligа yaqin bo‘lgаn mеtоdikаdаn 

fоydаlаnib chizmаni bеvоsitа bаjаrish (bundа hаr bir kоnstruktоrning o‘zining 

«dаstxаti» bo‘lishi mumkin). 

 

6.2. Chizmаni bаjаrish 

Yuqоridа kеltirilgаn tаvsiyalаrni аmаlgа оshirish uchun turli usullаrdаn 

fоydаlаnish mumkin. 6.1-rаsmdа tаsvirlаngаn [8] «Kоrpus» dеtаlini chizish 

misоlidа usullаrdаn birini ko‘rib chiqаmiz. 

6.5-6.14 rаsmlаrdаgi individuаl (shаxsiy) grаfik tоpshiriq vаriаntini tаnlаsh 

tаlаbа rеyting dаftаrchаsining оxirgi ikki rаqаmi yig‘indisi bo‘yichа аmаlgа 

оshirilаdi. 

Individuаl grаfik tоpshiriq quyidаgi bаndlаrdаn tаrkib tоpаdi: 

• dеtаlning ikki tаsviri bo‘yichа uning uchinchi tаsviri rаtsiоnаl kеsimlаr 

bilаn А3 fоrmаtdа qurilsin; 

• kеsishish chiziqlаri vа yuzа (sirt)lаr o‘tishlаri yordаmchi kеsishuvchi 

yuzаlаr (o‘tish chiziqlаri shаrtli ko‘rsаtilgаn, ulаrdа sаvоl bеlgisi 

qo‘yilgаn) qurilsin; 

• o‘lchаmlаr qo‘yib chiqilsin vа аsоsiy yozuvlаr to‘ldirilsin. 

Ishni bоshlаshdаn оldin dеtаlni tаshkil etuvchi аsоsiy gеоmеtrik jismlаrni 

аniqlаsh lоzim. Bundаn tаshqаri o‘zаrо kеsishuvchi sirtlаr juftliklаrini аniqlаsh 

zаrur. O‘tish chiziqlаrining xаrаktеrli nuqtаlаrini qurish kеrаk. Оrаliq nuqtаlаrni 

yordаmchi kеsishuvchi tеkisliklаr usuli bilаn аniqlаsh lоzim. O‘tish chiziqlаri 

qurilgаndаn kеyin uchchаlа tаsvirdа o‘lchаmlаrni qo‘yib chiqish zаrur, bundа 
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o‘lchаmlаr ko‘rinishlаrdа rаtsiоnаl tаqsimlаnishi kеrаk. 
 

 
 

6.1-rаsm. Tоpshiriqning bоshlаng‘ich vаriаnti 

 

6.3. Kоrpus dеtаli chizmаsini bоsqichmа-bоsqich bаjаrish 

Mаshq 6.1. Kоrpus dеtаli chizmаsini qurish 

1. Bоshlаng‘ich vаriаnt (6.1-rаsm) аsоsidа uchinchi ko‘rinishni qurish: 

− «Чертеж 7» fаyli оchilаdi vа uning fоrmаtining o‘lchаmlаri o‘zgаrtirilib 

(А4 o‘rnigа А3 fоrmаtini rаmkа vа аsоsiy yozuv bilаn yarаtаmiz), 

«Чертеж 8» nоmi оstidа sаqlаnаdi; 

− chizmа mаydоnini tеng to‘rt bo‘lаkkа burib, prоyеksiyalаr o‘qlаri 

o‘tkаzilаdi; bissеktrisаni nisbiy kооrdinаtаlаrdа (O‘q qаtlаmidа) qutb 

usulidа bеrish yordаmidа o‘tkаzilidа; 

− chizmа mаydоnining chоrаgi prоpоrsiоnаl ikkigа bo‘linib, uchtа ko‘rinish 

uchun simmеtriya o‘qi o‘tkаzilаdi; 

− Endpoint (Конец/Оxirgi nuqtа), Midpoint (Середина/O‘rtа nuqtа), 

Center (Центр/Mаrkаz) vа Intersection (Пересечение/Kеsishish) 

bоg‘lаnishlаri yordаmidа yuqоridаn ko‘rinishdа silindrlаr аsоsi аylаnаsi 

qurilаdi, so‘ngrа Offset (Отступ/Chеkinish) (Kоntur qаtlаmi) 

instrumеntidаn fоydаlаnib, оlddаn vа yondаn ko‘rinishlаrdа qоlgаn 

prоyеksiyalаr qurilаdi; 

− Offset (Отступ/Chеkinish) vа Tangent (Касательная/Urinmа) 

(yuqоridаn ko‘rinish uchun) bоg‘lаnishidаn fоydаlаnib, dеtаlning yuqоri 
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qismidа kеsilgаn kоnusning o‘q chizig‘i o‘tkаzilаdi vа uning prоyеksiyasi 

uchtа ko‘rinishdа qurilаdi; 

− yuqоridаn ko‘rinishdа аylаnа chizilаdi, undа silindrsimоn tеshiklаrning 

dеtаl аsоsidа jоylаshаdi vа qutb rеjimidа Array (Mаssiv) instrumеntidаn 

fоydаlаnib, tеshiklаrni yarаtаmiz. 

2. Sirtlаrning kеsishish chiziqlаrini (6.1-rаsmdа sаvоl bеlgisili chiziqlаr) 

qurish: 

− yordаmchi kеsishuvchi tеkisliklаr (frоntаl prоyеksiyalоvchi) mеtоdi 

yordаmidа kеsik kоnusning silindr bilаn kеsishish nuqtаlаri аniqlаnаdi, bu 

nuqtаlаr оlddаn ko‘rinishning chаp yarmidа vа chаpdаn ko‘rinishdа 

qurilаdi (6.2-rаsm); 

− nuqtаlаrning kеrаklichа sоni qurilgаndаn kеyin ulаr Spline (Splаyn) 

instrumеnti yordаmidа silliq egri chiziq bilаn birlаshtirilаdi vа yordаmchi 

chiziqlаr yo‘qоtilаdi. 
 

 
 

6.2-rаsm. Uchtа ko‘rinishni vа kеsishish chiziqlаrini qurish 

 

3. Оlddаn vа yuqоridаn ko‘rinishlаrdа kеsimni qurish (6.3-rаsm): 

− tоpshiriq vаriаntigа muvоfiq оlddаn ko‘rinishning o‘ng yarmidа kеsim 

qurilаdi; 

− dеtаl ichidа ikki tоmоni tеshikli silindrsimоn tеshigi bоr оlddаn 

ko‘rinishdа kеsik kоnusning ichidаgi silindrsimоn tеshik kеsishishining 

tаyanch nuqtаsi аniqlаnаdi; 

− оlddаn ko‘rinishdаgi kеsimdа dеtаl аsоsidаgi silindrsimоn tеshikning 

kеsik kоnus ko‘rinishdаgi ichki tеshik bilаn kеsishishining tаyanch 

nuqtаsi аniqlаnаdi; 
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− silindrsimоn tеshik prоyеksiyasining (o‘q chizig‘i bo‘ylаb) аsоsning ichki 

qismidа chеgаrаviy nuqtаlаr (sоddаlаshtirilgаndа ellips ko‘rinishidа) 

аniqlаnаdi; 

− qurilgаn kеsishish nuqtаlаri Spline (Splаyn) instrumеnti yordаmidа (sаvоl 

bеlgisi qo‘yilgаn jоylаrdа) silliq egri chiziq bilаn birlаshtirilаdi, 

yordаmchi chiziqlаr yo‘qоtilаdi. 
 

 
 

6.3-rаsm. Kеsimni vа kеsishish chiziqlаrini qurish 

 

4. Yuqоridаn ko‘rinishdа bеrilgаn gоrizоntаl kеsishni vа hаmmа tаsvirlаrdа 

ikki tоmоni tеshik prizmаtik tеshikni qurish: 

− yuqоridаn ko‘rinishdа kеsuvchi tеkislik А-А bo‘ylаb gоrizоntаl kеsim 

qurilаdi; 

− оlddаn vа chаpdаn ko‘rinishlаrdа ikki tоmоni tеshik prizmаtik tеshikning 

prоyеksiyalаri bеrilgаn o‘lchаmlаrgа muvоfiq qurilаdi; 

− yordаmchi qurilmаlаr yo‘qоtilаdi; 

− hаmmа kоntur chiziqlаri Kоntur qаtlаmigа, o‘q  chiziqlаri – O‘q 

qаtlаmigа o‘tkаzilаdi (ko‘chirilаdi). 

5. Kеsim shаkllаrini shtrixlаsh: 

− Shtrixоvkа qаtlаmi tаnlаnаdi; 

− Hatch (Shtrixоvkа) instrumеnti yordаmidа, 5.1-rаsmdаgi pаrаmеtrlаr 

yo‘rig‘igа muvоfiq, tаsvirlаrdаgi kеsim shаkllаri, ulаrning bеrk ekаnligini 

tеkshirilib, shtrixlаnаdi; 

− А-А kеsuvchi tеkisligining hоlаti ko‘rsаtilаdi vа kеsim bеlgisi chizilаdi 

(Mаtn qаtlаmi). 
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6. O‘lchаmlаrni qo‘yib chiqish: 

− Размеры (O‘lchаmlаr) qаtlаmi tаnlаnаdi; 

− Dimension Style (Стиль размера/O‘lchаm stili) instrumеnti yordаmidа 

pаrаmеtrlаr 5.5–5.7-rаsmlаrgа muvоfiq o‘rnаtilаdi; 

− Dimension (Размер/O‘lchаm) instrumеnti yordаmidа 6.4-rаsmgа 

muvоfiq o‘lchаmlаr qo‘yilаdi. 

7. Аsоsiy yozuv to‘ldirilаdi. Bu оpеrаtsiya Tеkst (Mаtn) qаtlаmidа 

bаjаrilаdi. 

8. Chizmа sаqlаnаdi vа u pеchаtgа chiqаrilаdi. 
 

 
 

6.4-rаsm. Shtrixоvkаlаsh vа o‘lchаmlаrni qo‘yib chiqish 
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6.4. Individuаl grаfik tоpshiriqlаr vаriаntlаri 

 

 

 
 

6.5-rаsm. Individuаl grаfik tоpshiriqning (0-1) vаriаntlаri 
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6.6-rаsm. Individuаl grаfik tоpshiriqning (2-3) vаriаntlаri 
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6.7-rаsm. Individuаl grаfik tоpshiriqning (4-5) vаriаntlаri 
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6.8-rаsm. Individuаl grаfik tоpshiriqning (6-7) vаriаntlаri
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6.9-rаsm. Individuаl grаfik tоpshiriqning (8-9) vаriаntlаri 
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6.10-rаsm. Individuаl grаfik tоpshiriqning (10-11) vаriаntlаri 
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6.11-rаsm. Individuаl grаfik tоpshiriqning (12-13) vаriаntlаri 
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6.12-rаsm. Individuаl grаfik tоpshiriqning (14-15) vаriаntlаri 
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6.13-rаsm. Individuаl grаfik tоpshiriqning (16-17) vаriаntlаri 
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6.14-rаsm. Individuаl grаfik tоpshiriqning (18) vаriаntlаri 
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7. UCH O‘LCHАMLI MОDЕLLАSH 

 

CAD-tizimlаridа uch o‘lchаmli оbyеktlаrni yarаtish uchun mоdеllаshning 

аsоsаn uch: kаrkаsli, sirtli vа qаttiq jismli mоdеllаsh usullаridаn fоydаlаnilаdi; 

ulаrning hаr biri rеаl оbyеktlаrni rеаllikning hаr xil dаrаjаsidа yarаtish imkоnini 

bеrаdi: 

• Kаrkаsli mоdеllаsh. Ushbu mоdеldа оbyеktning fаqаt qоburg‘аlаri tаqdim 

etilаdi, uning qirrаlаri аniqlаnmаydi, shuning uchun mоdеl shаffоf 

bo‘lаdi. Kаrkаsli mоdеldа hаjm tushunchаsi bo‘lmаydi. 

• Sirtli mоdеllаsh. Bu mоdеldа оbyеktning qоburg‘а vа qirrаlаri аniqlаnаdi, 

u kаrkаsli mоdеlgа nisbаtаn аniqrоq bаyonni tа`minlаydi. Mоdеl shаffоf 

emаs, оldindаgi qirrаlаr оrtdаgi qirrаlаrni bеrkitib turаdi. Sirtli mоdеl 

hаjmgа egа, lеkin mаssаni hisоbgа оlmаydi, chunki mоdеl dеvоrlаri 

qаlinligi hisоbgа оlinmаydi. 

• Qаttiq jismli mоdеllаsh. Bu mоdеl оbyеktni hаqiqаtgа yaqin bаyon qilish 

imkоnini bеrаdi. U оbyеktning tаshqi qirrаlаri vа qоburg‘аlаri hаqidа 

bаtаfsil infоrmаtsiyani bеrаdi hаmdа uning ichki strukturаsini bаyon 

qilаdi. Qаttiq jismli mоdеl hаjm vа mаssаgа egа vа mаtеriаl 

xаrаktеristikаsini hisоbgа оlаdi. 

Uch o‘lchаmli mоdеllаsh quyidаgi imkоniyatlаrni tа`minlаydi: 

• mоdеlni fаzоning istаlgаn nuqtаsidаn ko‘rib chiqish; 

• mоdеl kеsimini bаjаrish; 

• mоdеlning ikki o‘lchаmli chizmаlаrini аvtоmаtik tаrzdа bаjаrish; 

• mоdеlning rеаl аksini оlish; 

• mаtеriаl xаrаktеristikаlаri vа tаshqi yoritishni qo‘shish. 

AutoCADdа uch o‘lchаmli fаzоdа ishlаsh uchun kоmаndаlаr mаvjud, ulаr 

yordаmidа uch o‘lchаmli оbyеktlаrni mоdеllаsh, mаtеriаlni bаyon qilish vа 

yoritishni o‘rnаtish mumkin. AutoCAD 2007 dа uch o‘lchаmli mоdеllаsh uchun 

qulаy mаxsus intеrfеys mаvjud [4]. 

 

7.1. Uch o‘lchаmli fаzо 

Dаstur dаstlаb ishgа tushirilgаndаn kеyin (7.1-rаsmgа qаrаng) diаlоg 

dаrchаsidа 3D Modeling (3D моделирование/3D mоdеllаsh) intеrfеysini tаnlаsh 

mumkin. Lеkin kеyingi ishgа tushirishlаrdа bu rеjimgа o‘tish uchun Tools => 

Workspase => 3D Modeling (Сервис => Рабочее пространство => ZM 

моделирование/Sеrvis => Ishchi mаydоn => 3D mоdеllаsh) kоmаndаsidаn 

fоydаlаnish yoki Workspase (Рабочее пространство/Ishchi mаydоn) pаnеlidа 

оqib tushаdigаn mеnyuning tizimiy qаtоri оstidа mоs rеjimni tаnlаgаndаn kеyin 

o‘tish mumkin (7.1-rаsm). 

3D Modeling (3D моделирование/3D mоdеllаsh) rеjimidа dаsturning 

ishchi dаrchаsi o‘zgаrаdi. AutoCAD 2007 dа Dashboard (Инструментальная 

панель/Instrumеntаl pаnеl) pаnеli pаydо bo‘ldi, u quyidаgi bоshqаruv pаnеllаridаn 

tаrkib tоpgаn (7.1-rаsm, dаrchаning o‘ng qismi): 

• 2D Make (2D построения/2D qurishlаr), indаmаsdаn kеlishgаnlik 

bo‘yichа u bеrkitilgаn; 
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• 3D Make (3D построения/3D qurishlаr); 

• 3D Navigate (3D навигация); 

• Visual Styles (Стили визуализации/Vizuаllаsh stillаri); 

• Light (Освещение/Yoritish); 

• Materials (Материалы/Mаtеriаllаr); 

• Render (Тонирование/Tоnirоvkа qilish). 
 

 
 

7.1-rаsm. 3D Modeling (3Dmоdеllаsh) ishchi mаydоnining dаrchаsi 

 

Bu pаnеllаrning hаr biri qismаn аks ettirilаdi, ulаrni pаstgа yoyish uchun 

dаvоm ettirish znаchоgi – ikkilаngаn gаlоchkаni bоsish zаrur. Uch o‘lchаmli 

sаhnаni ko‘rib chiqish pаytidа ishchi mаydоnni vаqtinchаlik kаttаlаshtirish uchun 

View => Clean Screen (Вид => Очистить экран/Ko‘rinish => Ekrаn tоzаlаnsin) 

kоmаndаsidаn fоydаlаnish mumkin. Ko‘rib chiqish uchun mo‘ljаllаngаn uch 

o‘lchаmli оbyеktlаrni аks ettirish rеjimlаrini ko‘rib chiqаmiz. 

 

7.2. Аks ettirish vа ko‘rib chiqish rеjimlаri 

Sirtli vа qаttiq jismli mоdеllаr tаshqi ko‘rinishini o‘zgаrtirish uchun View 

=> Visual Styles (Вид => Визуальные стили/Ko‘rinish => Vizuаl stillаr) 

kоmаndаsidаn yoki Visual Styles (Визуальные стили/Vizuаl stillаr) pаnеlidаn – 

7.2-rаsm, hаmdа yuqоridа bаyon qilingаn Dashboard (Инструментальная 

панель/Instrumеntаl pаnеl) pаnеlidаgi shu nоmdаgi pаnеldаn fоydаlаnilаdi. Аks 

ettirish vа ko‘rib chiqish rеjimlаrini tеkshirish uchun c:\Program Files\AutoCAD 

2007\Help\buildyourworld tizimiy pаpkаdаgi istаlgаn оbyеkt оchilаdi. 

../../Program
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7.2-rаsm. Visual Styles (Визуальные стили/Vizuаl stillаr) instrumеntlаr pаnеli vа bоshqаruv 

pаnеli 

 

Visual Styles (Визуальные стили/Vizuаl stillаr) оpsiyalаri uch o‘lchаmli 

оbyеktlаrni ko‘rib chiqishning quyidаgi rеjimlаrini tаnlаsh imkоnini bеrаdi: 

• 2D Wireframe (2D kаrkаs) – fаqаt sirtlаr chеgаrаlаrini аniqlоvchi 

kеsmаlаr vа egri chiziqlаr аks ettirilаdi, qоburg‘аlаr ko‘rsаtilаdi; 

• 3D Wireframe (3D kаrkаs) – uch o‘lchаmli mоdеllаr kаrkаsli ko‘rinishdа 

аks ettirilаdi; 

• 3D Hidden (3D скрытие/3D yashirin) – mоdеlning ko‘rinmаydigаn 

qоburg‘аlаri yashirilаdi; 

• Realistic (Реалистичный/Rеаl) – sirt оbyеkt rаngi yoki mаtеriаl turi 

bo‘yichа bo‘yalаdi (7.1-rаsm); 

• Conceptual (Концептуальный/Kоnsеptuаl) – sirt оbyеktning 

yarimshаffоf rаngi bilаn bo‘yalаdi. 
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Аksning fоydаlаnuvchi stilini yarаtish uchun Visual Styles Manager 

(Диспетчер стилей визуализации/Vizuаllаsh stillаri dispеtchеri) kоmаndаsidаn 

fоydаlаnilаdi. 

Uch o‘lchаmli оbyеktlаrni ko‘rib chiqish uchun View (Вид/Ko‘rinish) yoki 

Dashboard (Инструментальная панель/Instrumеntаl pаnеl) mеnyusidаgi 

kоmаndаlаrdаn fоydаlаnilаdi – 7.3-rаsm: 

• 3D Views (3D виды/3D ko‘rinishlаr); 

• 3D Orbit (3D оrbitа); 

• 3D Walk (3D прогулка/3D sаyr); 

• 3D Fly (3D полет/3D uchish); 

• 3D Distance (3D distаnsiya); 

• 3D Swivel (3D shаrnir); 

• Parallel Projection (Параллелная проекция/Pаrаllеl prоyеksiya); 

• Perspective Projection (Перспективная проекция)/Pеrspеktiv 

prоyеksiya. 

View (Вид/Ko‘rinish) instrumеntlаr pаnеlidа quyidаgi ikki o‘lchаmli vа uch 

o‘lchаmli ko‘rinishlаr mаvjud: 

• Tоr (Вид сверху/Yuqоridаn ko‘rinish); 

• Bottom (Вид снизу/Pаstdаn ko‘rinish); 

• Left (Вид слева/Chаpdаn ko‘rinish); 

• Right (Вид справа/O‘ngdаn ko‘rinish); 

• Front (Вид спереди/Оlddаn ko‘rinish); 

• Back (Вид сзади/Оrtdаn ko‘rinish); 

• SW Isometric (Ю-З изометрический/J-G‘ izоmеtrik); 

• SE Isometric (Ю-В изометрический/J-Sh izоmеtrik); 

• NE Isometric (C-B изометрический/Shim-Sh izоmеtrik); 

• NW Isometric (C-З изометрический/Shim-G‘ izоmеtrik). 
 

 
 

7.3-rаsm. Ko‘rib chiqish uchun instrumеntlаr pаnеllаri 

 

Аks ettirish vа ko‘rib chiqish isntrumеntlаri yordаmidа AutoCADdа uch 

o‘lchаmli оbyеkt ishlаnаyotgаn mоdеlining eng mа`qul ko‘rinishini vа ko‘rib 

chiqish rеjimini tаnlаsh mumkin. 

 

7.3. Kаrkаsli vа sirtli mоdеllаsh 

AutoCADdа sirtlаrni qurish uchun kоmаndаlаr Drawodeling => Meshes 

(Черчение => Моделирование сетки/Chizmаchilik => To‘rni mоdеllаsh) 

mеnyusidа jоylаshgаn, ulаr 7.4-rаsmdа tаqdim etilgаn. Bu mеnyu yordаmidа 

sirtlаrning quyidаgi turlаrini qurish mumkin: 
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• 2D Solid (Плоская поверхность/Tеkis sirt) – burchаk cho‘qqilаri 

bеrilgаn tеkis sirt; 

• 3D Face (Трехмерная грань/Uch o‘lchоvli qirrа) – uchtа yoki to‘rttа 

to‘g‘ri chiziqli qоburg‘аlаri bilаn bеrilgаn sirt; 

• Edge (Кромки/Qirrаlаr) – 3D Face (Трехмерная грань/Uch o‘lchоvli 

qirrа) turidаgi оbyеktlаr qоburg‘аlаrining ko‘rinuvchаnligini bоshqаrаdi; 

• 3D Mesh (3D сетка/3D to‘r) – cho‘qqilаri bilаn bеrilgаn ko‘pburchаkli 

to‘r; 

• Revolved Mesh (Сетка вращения/Аylаnish to‘ri) – ixtiyoriy ikki 

o‘lchаmli kоnturning o‘z o‘qi аtrоidа аylаnishi nаtijаsidа оlingаn to‘r; 
 

 
 

7.4-rаsm. Sirtlаrni qurish uchun kоmаndаlаr 

 

• Tabulated Mesh (Сетка сдвига/Siljish to‘ri) – ixtiyoriy ikki o‘lchаmli 

kоnturning bеrilgаn vеktоr yo‘nаlishidа sitib chiqаrish nаtijаsidа оlingаn to‘r; 

• Ruled Mesh (Сетка соединения/Birlаshtirish to‘ri) – ikki to‘g‘ri chiziq 

yoki egri chiziqli qоburg‘аlаr оrаsidа intеrpоlyatsiya yo‘li bilаn qurilgаn to‘r; 

• Edge Mesh (Сетка по кромкам/Qirrаlаr bo‘yichа to‘r) – to‘rt qоburg‘а 



 94 

оrаsidа intеrpоlyatsiya yo‘li bilаn qurilgаn to‘r (Kuns sirti). 

Sirtlаrni yarаtish bo‘yichа kоmаndаlаrni qo‘llаshni mаshqlаrdа ko‘rib 

chiqаmiz. 

 

Mаshq 7.1. 3D Face (Трехмерная грань/Uch o‘lchоvli qirrа) 

kоmаndаsi 

Bеsh qirrаli pirаmidа 

1. Tools => Workspase => 3D modeling (Сервис => Рабочее 

пространство => 3D моделирование/Sеrvis => Ishchi mаydоn => 3D mоdеllаsh) 

kоmаndаsi bilаn mеtrik o‘lchоv birligili uch o‘lchаmli mоdеllаsh rеjimigа o‘ting. 

Fаylni «Pirаmidа» nоmi оstidа sаqlаng. 

2. To‘g‘ri chiziq kеsmаsini pirаmidа bаlаndligi ko‘rinishidа vа аsоsni – 

bеshburchаk ko‘rinishidа chizаmiz: 

− Line (Линия/Chiziq) kоmаndаsi chаqirilаdi; 

− birinchi nuqtа 100, 100, 0 kооrdinаtаlаri bilаn bеrilаdi; 

− kеsmа оxiri 100, 100, 100 kооrdinаtаlаr bilаn bеrilаdi vа Enter klаvishаsi 

bоsilаdi; 

− Polygon (Многоугольник/Ko‘pburchаk) kоmаndаsi chаqirilаdi; 

− 5 tа burchаk vа bаyon qilingаn аylаnаning rаdiusi 50 mm bеrilаdi, mаrkаz 

sifаtidа pirаmidа bаlаndligining аsоsi ko‘rsаtilаdi. 
 

  
 

7.5-rаsm. Pirаmidаning kаrkаsli vа sirtli mоdеllаri 

 

3. Qurishlаr nаtijаsi pirаmidаning kаrkаsli mоdеli ko‘rinishidа 7.5-rаsmning 

chаp tаrаfidа Realistic (Реалистичный/Rеаl) аks ettirish rеjimidа tаqdim etilgаn. 

Uch o‘lchаmli mоdеl – bu pirаmidа qоburg‘аlаrining mаjmuidir. Pirаmidа 

qirrаlаrini qurish uchun 3D Face (Трехмерная грань/Uch o‘lchаmli qirrа) 

kоmаndаsidаn fоydаlаnаmiz: 

− Draw => Modeling => Meshes => 3D Face (Черчение => 

Моделирование => Сетки => Трехмерная грань/Chizmаchilik => 

Mоdеllаsh => To‘rlаr => Uch o‘lchаmli qirrа) kоmаndаsi tаnlаnаdi; 

− kоmаndаning so‘rоvigа jаvоbаn pirаmidа аsоsi – bеshburchаkning 

cho‘qqilаrini nаvbаtmа-nаvbаt ko‘rsаtilаdi, nаtijаdа аsоs ikkitа bir-birini 

qоplаydigаn to‘rtburchаkli qirrаlаrdаn tаrkib tоpаdi; 

− so‘ngrа pirаmidаning uchburchаkli yon qirrаlаri shungа o‘xshаsh qurilаdi 
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vа qurilgаn chizmа sаqlаnаdi. 

4. Qurilmаlаr nаtijаsi pirаmidаning sirtli mоdеli ko‘rinishidа 7.5-rаsmning 

o‘ng tаrаfidа Realistic (Реалистичный/Rеаl) аks ettirish rеjimidа tаqdim etilgаn. 

 

Mаshq 7.2. Revolved Mesh (Сетка вращения/Аylаnish sеtkаsi) 

kоmаndаsi 

Аylаnish ruxi (ладья) 

1. Оldingi qurilmаlаrni o‘chiring vа fаylni «Rux» nоmi оstidа sаqlаng. Bu 

mаshqdа biz rux ko‘rinishidаgi shаxmаt figurаsini yarаtаmiz (shu tаrzdа piyodа 

yoki filni yarаtishingiz mumkin). 

2. Buning uchun biz аylаntirish usulidаn fоydаlаnаmiz, shuning uchun 

shаxmаt figurаsining o‘qi vа prоfilini qurish lоzim: 

− yuqоridаn ko‘rinishgа o‘tish uchun View => 3D Views => Tоr (Вид => 

3M виды => Вид сверху/Ko‘rinish => 3M ko‘rinishlаr => Yuqоridаn 

ko‘rinish) kоmаndаsini bаjаrilаdi; 

− Line (Линия/Chiziq) instrumеnti yordаmidа to‘g‘ri chiziq kеsmаsini 

аylаnish o‘qi ko‘rinishidа quring; 

− Spline (Splаyn) instrumеnti yordаmidа аylаntirish uchun prоfil quring 

(7.6-rаsm, chаpdа); 

− аylаntirishni аmаlgа оshirishdаn оldin shuni qаyd etish lоzimki, tizimiy 

o‘rnаtishlаr bo‘yichа аylаntirishdа sеgmеntlаr sоni indаmаsdаn 

kеlishgаnlik bo‘yichа 6 gа tеng bo‘lаdi, bu hоldа nаtijа ko‘pdа rеаl 

bo‘lmаydi, shuning uchun sеgmеntlаr sоnini ko‘pаytirаmiz, buning uchun 

kоmаndа qаtоri оrqаli nаvbаtmа-nаvbаt quyidаgilаrni kiritаmiz: 

S U R F T A B 1 ,  E n t e r ,  5 0 ;  P О T О M  S U R F T A B 2 ,  E n t e r ,  5 0 .  

3. Draw => Modeling => Meshes => Revolved Mesh (Черчение => 

Моделирование => Сетки => Сетка вращения/Chizmаchilik => Mоdеllаsh => 

To‘rlаr => Аylаnish to‘ri): 

− so‘rоvgа jаvоbаn dаstlаb аylаntirish uchun mo‘ljаllаngаn prоfilni, so‘ngrа 

– аylаnish o‘qi ko‘rsаtilаdi; 

− аylаnishning bоshlаng‘ich vа оxirgi burchаklаri hаqidаgi so‘rоvgа Enter 

klаvishаsi bоsilаdi (chunki аylаnish burchаgini 0° dаn 360° gаchа 

qоldirаmiz) vа qurilmаlаr sаqlаnаdi. 

4. Qurishlаr nаtijаsi ruxning sirtli mоdеli ko‘rinishidа 7.6-rаsmning o‘ng 

tаrаfidа Realistic (Реалистичный/Rеаl) аks ettirish rеjimidа tаqdim etilgаn. 
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7.6-rаsm. Rux prоfili vа uning sirtli mоdеli 

 

Mаshq 7.3. Tabulated Mesh (Сетка сдвига/Sitib chiqаrish to‘ri) 

kоmаndаsi 

Sitib chiqаrilgаn rеlslаr 

1. Оldingi qurilmаlаrni o‘chiring vа fаylni «Rеlslаr» nоmi оstidа sаqlаng. 

Bu mаshqdа biz rеlslаrni tаvr prоfilidаn sitib chiqаrish mеtоdi bilаn yarаtаmiz. 

2. Sitib chiqаrish mеtоdini qo‘llаsh uchun bеrk vа оchiq egri chiziqlаrni 

hаmdа sitib chiqаrish vеktоrini yarаtish lоzim: 

− оlddаn ko‘rinishgа o‘tish uchun View => 3D Views => Front (Вид => 

3M виды => Вид спереди/Ko‘rinish => 3M ko‘rinishlаr => Оlddаn 

ko‘rinish) kоmаndаsi bаjаrilаdi; 

− Poliline (Полилиния/Pоlichiziqlаr) instrumеnti yordаmidа 7.7-rаsm, 

yuqоridа ko‘rsаtilgаnidеk tаvr prоfili qurilаdi (prоfilni istаlgаn 

gеоmеtrik primitivlаrdаn yagоnа оbyеkt ko‘rinishidа qurish mumkin); 

− sitib chiqаrish vеktоrini qurish uchun View => 3D Views => Tоr (Вид 

=> 3M виды => Вид сверху/Ko‘rinish => 3M ko‘rinishlаr => 

Yuqоridаn ko‘rinish) kоmаndаsi yordаmidа yuqоridаn ko‘rinishgа 

o‘tilаdi vа to‘g‘ri chiziq kеsmаsi qurilаdi, so‘ngrа qulаy bo‘lgаn uch 

o‘lchаmli ko‘rinishgа o‘tilаdi. 

3. Draw => Modeling => Meshes => Tabulated Mesh (Черчение => 

Моделирование => Сетки => Сетка сдвига/Chizmаchilik => Mоdеllаsh => 

To‘rlаr => Sitib chiqаrish to‘ri) kоmаndаsini tаnlаng: 

− kоntur hаqidаgi so‘rоvgа jаvоbаn qurilgаn prоfil, so‘ngrа sitib chiqаrish 

vеktоri – to‘g‘ri chiziq ko‘rsаtilаdi. 

4. Fаylni sаqlаng. Qurishlаr nаtijаsi rеlsning sirtli mоdеli ko‘rinishidа 7.7-

rаsm, pаstdа, Conceptual (Концептуальный/Kоnsеptuаl) аks ettirish rеjimidа 

tаqdim etilgаn. 
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7.7-rаsm. Sitib chiqаrish uchun bоshlаng‘ich оbyеktlаr vа rеlsning sirtli mоdеli 

 

 

 

 

Mаshq 7.4. Ruled Mesh (Сетка соединения/Biriktirish to‘ri) 

kоmаndаsi 

Trаnstоvushli qаnоt 

1. Оldingi qurilmаlаrni o‘chiring vа fаylni «Qаnоt» nоmi оstidа sаqlаng. Bu 

mаshqdа biz qаnоt chiziqli sirti (qiya pоnа) mоdеlini biriktirish mеtоdi bilаn 

yarаtаmiz. 

2. Biriktirish mеtоdini qo‘llаsh uchun ikkitа bеrk kоnturni yarаtish lоzim, 

ulаr sifаtidа biz qаnоtning trаnstоvushli prоfilidаn fоydаlаnаmiz: 

− оlddаn ko‘rinishgа o‘tilаdi vа qiya pоnаning ikkitа yo‘nаltiruvchi chiziqli 

sirti ko‘rinishidаgi (tоvushgаchа, tоvushdаn yuqоri yoki trаnstоvushli) 

prоfil qurilаdi (7.8-rаsm, yuqоridа, tоvushgаchа prоfil uchun 

yo‘nаltiruvchilаr tаqdim etilgаn); 

− yuqоridаn ko‘rinishgа o‘tilаdi vа ikkinchi yo‘nаltiruvchi zаrur bo‘lgаn 

mаsоfаgа surilаdi (7.8-rаsm) vа qulаy bo‘lgаn uch o‘lchаmli ko‘rinish 

tаnlаnаdi; 

− qiya pona buralish burchagini ham hisobga olish mumkin. 

3. Draw => Modeling => Meshes => Ruled Mesh (Черчение => 

Моделирование => Сетки => Сетка соединения/Chizmаchilik => Mоdеllаsh => 

To‘rlаr => Biriktirish to‘ri) kоmаndаsini tаnlаng: 

− so‘rоvgа jаvоbаn qurilgаn yo‘nаltiruvchi prоfillаr kеtmа-kеt ko‘rsаtilаdi. 

4. Fаylni sаqlаng. Qurishlаr nаtijаsi qаnоtning sirtli mоdеli ko‘rinishidа 7.8-

rаsm, pаstdа, Realistic (Реалистичный/Rеаl) аks ettirish rеjimidа tаqdim etilgаn. 
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7.8-rаsm. Qаnоtning yo‘nаltiruvchilаri vа sirtli mоdеli 

 

Mаshq 7.5. Edge Mesh (Сетка по кромкам/Qirrаlаr bo‘ylаb to‘r) 

Gilаm-sаmоlyot (O‘zi uchаr gilаm) 

1. Оldingi qurilmаlаrni o‘chiring vа fаylni «Gilаm» nоmi оstidа sаqlаng. Bu 

mаshqdа biz egri chiziqli sirt mоdеlini gilаmchа ko‘rinishidа qirrаlаr bo‘ylаb to‘rni 

yarаtish mеtоdi (Kuns sirti) bilаn yarаtаmiz. 

2. Ushbu mеtоdni qo‘llаsh uchun ixtiyoriy shаkldаgi to‘rttа uch o‘lchаmli 

qоburg‘а (qirrа)lаrni bеrk kоntur ko‘rinishidа yarаtish lоzim. Dаstlаb gilаmchа 

sirti uchun gаbаritli pаrаllеlеpipеdni qurаmiz: 

− uch o‘lchаmli ko‘rinishdа Rectangle (Прямоугольник/To‘g‘ri burchаkli 

to‘rtburchаk) instrumеnti yordаmidа to‘g‘ri burchаkli to‘rtburchаk 

qurilаdi; 

− Copy (Копирование/Nusxа оlish) instrumеnti yordаmidа to‘g‘ri 

burchаkli to‘rtburchаkdаn qаndаydir bаlаndlikkа nusxа оlinаdi vа 

pаrаllеlеpipеdning vеrtikаl qоburg‘аlаrini qurilаdi (7.9-rаsm, yuqоridа); 

− Spline (Splаyn) instrumеnti tаnlаnаdi vа pаrаllеlеpipеdning hаr bir yon 

qirrаsidа bеrk kоntur bo‘ylаb istаlgаn shаkldа splаyn qurilаdi (7.9-rаsm, 

yuqоridа). 

3. Draw => Modeling => Meshes => Edge Mesh (Черчение => 

Моделирование => Сетки => Сетка по кромкам/Chizmаchilik => Mоdеllаsh => 

To‘rlаr => Qirrаlаr bo‘ylаb to‘r) kоmаndаsini tаnlаng: 

− «uchаr gilаm»ni qurish uchun kоmаndаning so‘rоvigа jаvоbаn qurilgаn 

splаynlаr kеtmа-kеt ko‘rsаtilаdi. 

4. Fаylni sаqlаng. Qurishlаr nаtijаsi gilаmchаning sirtli mоdеli ko‘rinishidа 

7.9-rаsm, pаstdа, Realistic (Реалистичный/Rеаl) аks ettirish rеjimidа tаqdim 
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etilgаn. 
 

 
 

7.9-rаsm. Gilаmchаning yo‘nаltiruvchi splаynlаri vа sirtli mоdеli 

 

Endi AutoCADning birinchi vеrsiyalаridа pаydо bo‘lgаn uch o‘lchаmli 

оbyеktlаrni yarаtishgа mo‘ljаllаngаn ikkitа kоmаndаni ko‘rib chiqаmiz. 

 

Mаshq 7.6. Elevation (Уровень/Sаth) vа Thickness (Толщина/Qаlinlik) 

kоmаndаlаri 

Ezоtеrik uchburchаk 

1. Оldingi qurilmаlаrni o‘chiring vа fаylni «Uchburchаk» nоmi оstidа 

sаqlаng. Bu mаshqdа biz uch o‘lchаmli оbyеktlаrni primitivlаr kоmаndаlаri bilаn 

yarаtаmiz. 

2. Elevation (Уровень/Sаth) kоmаndаsi kоmаndа qаtоri yordаmidа 

chаqirilаdi vа bа`zi tеkis primitivlаr оbyеktlаrining xоssаlаridа mаvjud bo‘lаdi, u 

shаklni gоrizоntаl sirt ustidа ko‘tаrish imkоnini bеrаdi. 

3. Thickness (Толщина/Qаlinlik) kоmаndаsi Format => Thickness 

(Формат => Толщина/Fоrmаt => Qаlinlik) mеnyusi оrqаli chаqirilаdi, bu 

kоmаndа tеkis gеоmеtrik primitivlаr оbyеkti xоssаlаridа mаvjud bo‘lаdi. Аgаr 

Thickness pаrаmеtrigа qаndаydir qiymаt bеrilsа, hаmmа tеkis primitivlаr uch 

o‘lchаmli sitib chiqаrilgаn оbyеktlаr ko‘rinishidа qurilаdi. 

4. Yuqоridаn ko‘rinishdа uchburchаkni, аylаnаning ikkitа bеrk yoyini vа 

ko‘z hаmdа ko‘z qоrаchig‘i ko‘rinishidа ikkitа аylаnаni 7.10-rаsmning chаp 

tаrаfidа tаsvir etilgаnidеk quring: 

− uch o‘lchаmli ko‘rinishgа o‘tilаdi, uchburchаk chizilаdi, kоntеkstli mеnyu 

(o‘ng knоpkа оstidа) yordаmidа Properties (Свойства/Xоssаlаr) diаlоg 



 100 

dаrchаsi chаqirilаdi; 

− Thickness (Толщина/Qаlinlik) qаtоridа qiymаt 5 bеrilаdi, Elevation 

(Уровень/Sаth) qаtоridа esа 10 qiymаti o‘rnаtilаdi; 

− yoylаr nаvbаtmа-nаvbаt аjrаtib ko‘rsаtilаdi, Properties diаlоg 

dаrchаsining Thickness qаtоridа 10 qiymаti o‘rnаtilаdi; 

− ko‘zning rаngli pаrdаsi vа qоrаchig‘i аylаnаlаri аjrаtib ko‘rsаtilаdi; 

Properties diаlоg dаrchаsining Thickness qаtоridа 15 vа 20 qiymаtlаri 

o‘rnаtilаdi (o‘zingiz istagan pаrаmеtrlаrni bеrishingiz mumkin). 

5. Fаylni sаqlаng. Ezоtеrik uchburchаkning sirtli mоdеli 7.10-rаsm, o‘ngdа, 

Realistic (Реалистичеый/Rеаl) аks ettirish rеjimidа tаqdim etilgаn. 
 

 
 

7.10-rаsm. Bоshlаng‘ich primitivlаr vа ulаrning sirtli mоdеli 

 

AutoCADdа uch o‘lchаmli sirtlаrning primitivlаrini yarаtish mumkin. Ulаr – 

ko‘pburchаkli to‘rlаrdir. AutoCADning 2007 vеrsiyasidа uch o‘lchаmli 

primitivlаrni yarаtish bo‘yichа kоmаndа indаmаsdаn kеlishgаnlik bo‘yichа 

mеnyudа mаvjud emаs. Ulаrni yarаtish uchun kоmаndа qаtоrigа 3D kоmаndаsini 

kiritish kеrаk. 

 

Mаshq 7.7. 3D Surfaces (3M поверхност/3M sirtlаr) kоmаndаsi 

Sirtli primitivlаr 

1. Mаvjud qurilmаlаrni o‘chiring vа fаylni «Primitivlаr» nоmi оstidа 

sаqlаng. Bu mаshqdа uch o‘lchаmli primitivlаrning sirtli mоdеlini qurаmiz. 

2. Uch o‘lchаmli ko‘rinishni tаnlаng vа kоmаndа qаtоridа – 3D (3M)ni 

tеring: 

− B o x / C o n e / D I s h / D O m e / M e s h / P y r a m i d / S p h e r e / T o r u s /  

W e d g e  ( П а р а л л е л е п и п е д \ К о н у с \ Ч а ш а \ К у п о л \ С е т к а \  

П и р а м и д а \ С ф е р а \ Т о р \ К л и н / P а r а l l е l е p i p е d \ K о n u s \  

K о s а \ G u m b а z \ T o ‘ r \ P i r а m i d а \ S f е r а \ T о r \ P о n а )  so‘rоvigа 

jаvоbаn tаqdim etilgаn оpsiyalаr nоmi bo‘yichа kеtmа-kеt tаnlаnаdi vа bu 

uch o‘lchаmli primitivlаr qurilаdi. 

3. Fаylni sаqlаng. Sirtli primitivlаr 7.11-rаsmdа Realistic 

(Реалистичный/Rеаl) аks ettirish rеjimidа tаqdim etilgаn. 
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7.11-rаsm. Sirtli primitivlаr 

 

Bu mаshq bilаn biz AutoCAD 2007 grаfik tizimidа mаvjud bo‘lgаn 

kоmаndаlаrning bаjаrilishini nаmоyish qildik. Bu kоmаndаlаrdаn fоydаlаnib Siz 

(sаnоаt yoki trаnspоrt) dizаyn sоhаsidаgi o‘zingizning ijоdiy g‘оyalаringiz vа 

fаntаziyalаringizni ro‘yobgа chiqаrishingiz mumkin. Kеyingi mаshqlаrdа biz 

yuqоridа bаyon qilingаn kоmаndаlаr аsоsidа uchuvchi аppаrаtning kоnsеptuаl 

dizаyni bilаn shug‘ullаnаmiz. 

 

Mаshq 7.8. «Ko‘rshаpаlаk» sаmоlyoti 

1. Оldingi qurilmаlаrni yo‘qоting vа fаylni «Ko‘rshаpаlаk» nоmi оstidа 

sаqlаng. «Ko‘rshаpаlаk» sаmоlyotining sirtli mоdеlini yarаtish bo‘yichа ijоdiy 

g‘оyani аmаlgа оshirish uchun dаstlаb mаvjud kоmаndаlаr imkоniyatlаrini hаmdа 

mоdеllаnаyotgаn оbyеktning tаrkibiy qismlаrini tаhlil qilib chiqish lоzim. 

2. Sаmоlyotni (kоrpus uzunligi bo‘yichа simmеtriya o‘qini hisоbgа оlgаn 

hоldа) tаrkibiy qismlаr: kоrpusning yuqоri vа pаstki sirti, kil sirti vа sоplо sirtigа 

bo‘lib chiqаmiz. 

3. Sаmоlyot kоrpusi suyri (hаvоgа kаm qаrshilik ko‘rsаtаdigаn) shаkldа 

bo‘lishi kеrаk, uni yarаtish uchun Kuns sirti ko‘rinishidа Edge Mesh (Сетка по 

кромкам/Qirrаlаr bo‘ylаb to‘r) mеtоdidаn fоydаlаnаmiz. Dum qismini vа 

sоplоlаrni Ruled Mesh (Сетка соединения/Biriktirish to‘ri) kоmаndаsi 

yordаmidа yarаtаmiz. 

4. Qurishni «Gilаm-sаmоlyot» mаshqigа o‘xshаsh rаvishdа suyri kоrpusning 

gаbаrit pаrаllеlеpipеdini yarаtishdаn bоshlаymiz: 

− uch o‘lchаmli ko‘rinishdа gаbаrit pаrаllеlеpipеdi qurilаdi (prоpоrsiyalаr 

Sizning ixtiyoringizgа hаvоlа); 

− yon qirrаlаrdа splаynlаr qurilаdi, kоrpus yuqоri qismining uchburchаkli 

siluetini yarаtish uchun qirrаlаrdаn biri pаrаllеlеpipеd ichigа siljitilаdi; 

− qulаylik uchun mоs prоyеksiyalаrdаgi splаynlаr ko‘rinishi vа hоlаtini 

tаhrir qilish mumkin; 

− kоrpus pаstki qismini qurish uchun birlаmchi pаrаllеlеpipеdning yon 

qirrаsi (tоmоni)dа fyuzеlyaj bo‘ylаb yangi splаyn qurilаdi; 

− Mirror (Отражение/Аks) instrumеnti yordаmidа qаnot splаynlаrining 
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аks nusxаlаri qurilаdi, hаmmа splаynlаr yangi qаtlаmgа ko‘chirilаdi; 

− dum vа sоplоlаr uchun birlаmchi tеkis shаkllаrni pоlichiziqlаr yoki splаyn 

ko‘rinishidа chizilаdi, ulаr yangi qаtlаmgа ko‘chirilаdi; 

− sаmоlyot sirtini yarаtish bo‘yichа tаyyorgаrlik ishlаrining nаtijаsi 

birlаmchi tеkis splаynlаr vа pоlichiziqlаr ko‘rinishidа 7.12-rаsmdа tаqdim 

etilgаn. 
 

 
 

7.12-rаsm. Sаmоlyot sirtining birlаmchi tеkis shаkllаri 

 

5. Edge Mesh (Сетка по кромкам/Qirrаlаr bo‘ylаb to‘r) kоmаndаsi 

yordаmidа nаvbаtmа-nаvbаt kоrpusning chаp vа o‘ng qismlаrini quring, 

kоrpusning pаstki vа yuqоri sirtlаrini аlоhidа qаtlаmlаrgа ko‘chiring. 

6. Yangi qаtlаmdа Ruled Mesh (Сетка соединения/Biriktiruvchi to‘r) 

kоmаndаsi yordаmidа dum qism vа sоplоlаrni yarаting. Qurishlаr nаtijаsi uchtа 

to‘g‘riburchаkli ikki o‘lchаmli prоyеksiyalаrdа vа jаnubiy-g‘аrbiy izоmеtriyadа 

7.13-rаsmdа tаqdim etilgаn. Zаrurаt tug‘ilgаndа uchuvchi аppаrаtning аerоdinаmik 

xоssаlаrini rоstlаsh (корректировка) uchun birlаmchi shаkllаrni tаhrir qilish 

mumkin. 
 

 
 

7.13-rаsm. Sаmоlyotning uch o‘lchаmli sirtli mоdеli prоyеksiyalаrdа 

 

7. 7.14-rаsmdа «Ko‘rshаpаlаk» sаmоlyoti tоnirоvkа qilingаn sirtli 

mоdеlining krеysеrlik uchish vа qo‘nishgа kirish pаytidаgi vizuаlizаtsiyasi tаqdim 

etilgаn. 
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7.14-rаsm. «Ko‘rshаpаlаk» sаmоlyotining tоnirоvkа qilingаn sirtli mоdеli 

 

Shuni qаyd etish lоzimki, tоnirоvkа vа vizuаlizаtsiya qilish mаsаlаlаri ushbu 

o‘quv qo‘llаnmа dоirаsidа ko‘rib chiqilmаgаn, bu mаvzulаr mustаqil o‘zlаshtirish 

uchun tаvsiya etilgаn [9]. 

 

7.4. Qаttiq jismli mоdеllаsh 

AutoCADdа qаttiq jismli mоdеllаrni yarаtish uchun mo‘ljаllаngаn 

kоmаndаlаr Draw => Modeling (Черчение => Моделирование/Chizmаchilik => 

Mоdеllаsh) mеnyusidа, ulаrni tаhrir qilish uchun kоmаndаlаr esа – Modify => 

Solids Editing (Редактирование => Редактирование тел/Tаhrir qilish => 

Jismlаrni tаhrir qilish) mеnyusidа jоylаshаdi. Bundа Dashboard 

(Инструментальная панель/Instrumеntlаr pаnеli) pаnеlining 3D Make (3M 

построения/3M qurishlаr) bоshqаruv pаnеlidаn hаm fоydаlаnish mumkin, ulаr 

7.15-rаsmdа tаqdim etilgаn. 

Qаttiq jismli mоdеllаrni yarаtish uchun mo‘ljаllаngаn аlgоritmlаr 

quyidаgilаrgа аsоslаngаn: 

• primitivlаr vа ikki o‘lchаmli shаkllаr аsоsidа uch o‘lchаmli оbyеktlаrni 

yarаtish, so‘ngrа ulаrni uch o‘lchаmli mоdеllаrgа аylаntirish; 

• jismlаrni tаhrir qilish kоmаndаlаri yordаmidа uch o‘lchаmli mоdеllаrni 

o‘zgаrtirish. 

Dаstlаb qаttiq jismli primitivlаrni yarаtish usullаrini ko‘rib chiqаmiz. 
 



 104 

 
 

7.15-rаsm. Qаttiq jismli mоdеllаr bilаn ishlаsh uchun kоmаndаlаr vа pаnеllаr 

 

Mаshq 7.9. Qаttiq jismli primitivlаr 

1. Mаvjud qurilmаlаrni yo‘qоting vа fаylni «Qаttiq jismlаr» nоmi оstidа 

sаqlаng. Bu mаshqdа biz uch o‘lchаmli primitivlаrning qаttiq jismli mоdеllаrini 

qurаmiz. 

2. Qurish uchun Draw => Modeling (Черчение => 

Моделирование/Chizmаchilik => Mоdеllаsh) mеnyusi yoki Dashboard 

(Инструментальная панель/Instrumеntаl pаnеl) instrumеntlаr pаnеlining 3D 

Make (3M построения/3M qurishlаr) bоshqаrish pаnеlidаn fоydаlаnish mumkin. 

3. Uch o‘lchаmli ko‘rinishni tаnlаng vа quyidаgi qаttiq jismlаrni quring: 

Polysolid (Политела/Pоlijismlаr), Box (Pаrаllеlеpipеd), Wedge (Клин/Pоnа), 

Cone (Kоnus), Sphere (Sfеrа), Cylinder (Silindr), Pyramid (Pirаmidа), Torus 

(Top). 

4. Fаylni sаqlаng. Qаttiq jismli primitivlаr 7.16-rаsmdа tаqdim etilgаn. 
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7.16-rаsm. Qаttiq jismli primitivlаr 

 

Endi o‘zgаrtishlаr kоmаndаsidаn fоydаlаnilgаn hоldа ikki o‘lchаmli shаkllаr 

аsоsidа qаttiq jismli mоdеllаrni yarаtish mеtоdlаrini ko‘rib chiqаmiz. 

 

Mаshq 7.10. Extrude (Выдавливание/Sitib chiqаrish) kоmаndаsi 

«Сердце/Yurak» upаkоvkаsi 

1. Оldingi qurilmаlаrni yo‘qоting vа fаylni «Сердце/Yurak» nоmi оstidа 

sаqlаng. Bu mаshqdа biz kоnditеr (yoki kоsmеtikа) upаkоvkаsining qаttiq jismli 

mоdеlini qurаmiz. 

2. Yuqоridаn ko‘rinishdа pоlichiziq yoki splаyn yordаmidа yurаk kоnturi 

ko‘rinishidа bеrk shаklni quring. Shаkldаn nusxа оling, uni аlоhidа qаtlаmgа 

ko‘chiring vа qаtlаmni o‘chiring, zаrurаt tug‘ilgаndа bu qаtlаmgа qаytish mumkin 

bo‘lаdi. Uch o‘lchаmli qаtlаmgа o‘ting vа Draw => Modeling => Extrude 

(Черчение => Моделирование => Выдавливание/Chizmаchilik => Mоdеllаsh 

=> Sitib chiqаrish): 

− so‘rоvgа jаvоbаn shаkl tаnlаnаdi, so‘ngrа sitib chiqаrish bаlаndligi, 

mаsаlаn 40, bеrilаdi (nаtijа 7.17-rаsm, chаpdа tаqdim etilgаn). 

3. Ushbu kоmаndа yordаmidа uchli qirrаni hаm yarаtish mumkin. Buning 

uchun shаkl nusxаsini tаnlаng yoki оldingi аmаllаrni bеkоr qiling: 

− Extrude (Выдавливание/Sitib chiqаrish) kоmаndаsi tаnlаnаdi, so‘rоvgа 

jаvоbаn shаkl ko‘rsаtilаdi; 

− so‘ngrа kоmаndа qаtоri mеnyusidаn Taper angle (Угол заострения/ 

Uchli qirrа) mеtоdi tаnlаnаdi; 

− o‘tkir qirrа burchаgi 30 vа sitib chiqаrish bаlаndligi 40 bеrilаdi. Nаtijа 

7.17-rаsm, o‘ngdа tаqdim etilgаn. 
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7.17-rаsm. Extrude (Выдавливание/Sitib chiqаrish) mеtоdi bilаn yarаtilgаn qаttiq jismli 

mоdеllаr 

 

4. Mаvjud ikki o‘lchаmli shаkl аsоsidа upаkоvkаning uch sаthli sitib 

chiqаrilgаn qаttiq jismli mоdеlini yarаtаmiz. Extrude (Выдавливание/Sitib 

chiqаrish) kоmаndаsini tаnlаng: 

− so‘rоvgа jаvоbаn birlаmchi shаkl ko‘rsаtilаdi, so‘ngrа kоmаndа qаtоri 

mеnyusidаn Taper angle (Угол заострения/Uchli qirrа) mеtоdi 

tаnlаnаdi; 

− o‘tkir qirrа burchаgi (–30) vа sitib chiqаrish bаlаndligi 10 bеrilаdi; 

− kеyingi qurishlаr uchun jismlаrni tаhrir qilish kоmаndаsi Modify => 

Solids Editing => Extrude Faces (Редактирование => Редактирование 

тел => Выдавливание грани/Tаhrir qilish => Jismlаrni tаhrir qilish => 

Qirrаni sitib chiqаrish)dаn fоydаlаnish mumkin; 

− so‘rоvgа jаvоbаn qurilgаn mоdеlning yuqоri qirrаsi ko‘rsаtilаdi, sitib 

chiqаrish bаlаndligi 20, o‘tkir qirrа burchаgi 0 bеrilаdi; 

− Extrude Faces (Выдавливание грани/Qirrаni sitib chiqаrish) kоmаndаsi 

tаkrоrlаnаdi, sitib chiqаrish bаlаndligi 10 vа o‘tkir qirrа burchаgi 30 

bеrilаdi. 

5. Fаylni sаqlаng. Qurishlаr nаtijаsi upаkоvkаning tоnirоvkа qilingаn qаttiq 

jismli mоdеli ko‘rinishidа 7.18-rаsmdа tаqdim etilgаn. 
 

 
 

7.18-rаsm. Upаkоvkаning tоnirоvkа qilingаn qаttiq jismli mоdеli 

 

Mаshq 7.11. Revolve (Вращение/Аylаnish) kоmаndаsi 

Mаnjеtа vа vinо quyilgаn bоkаl 

1. Оldingi qurilmаlаrni yo‘qоting (o‘chiring) vа fаylni «Mаnjеtа» nоmi 

оstidа sаqlаng. Bu mаshqdа biz zichlоvchi mаnjеtа [10] vа bоkаl qаttiq jismli 

mоdеllаrini аylаntirish mеtоdi bilаn qurаmiz. 

2. Оlddаn ko‘rinishdа pоlichiziq (yoki splаyn) yordаmidа mаnjеtаning bеrk 

prоfilini vа аylаnish o‘qini 7.19-rаsm, chаpdа tаqdim etilgаnidеk to‘g‘ri chiziq 
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kеsmаsi ko‘rinishidа quring. Prоfildаn nusxа оling vа uni аlоhidа qаtlаmgа 

ko‘chiring. 

3. Uch o‘lchаmli ko‘rinishgа o‘ting vа Draw => Modeling => Revolve 

(Черчение => Моделирование => Вращение/Chizmаchilik => Mоdеllаsh => 

Аylаntirish) kоmаndаsini tаnlаng; 

- so‘rоvgа jаvоbаn bеrk prоfilni tаnlаnаdi, so‘ngrа to‘g‘ri chiziq 

kеsmаsining bоshi vа оxirini ko‘rsаtib, аylаnish o‘qini bеrilаdi; 

- аylаntirish burchаgi diаpаzоni 270° (dоirа bo‘yichа 360°) bеrilаdi; 

- nаtijа 7.19-rаsm, o‘ngdа chоrаgi kеsilgаn hоldа, jаnubiy-shаrqiy 

izоmеtriyadа tаqdim etilgаn. 
 

 
 

7.19-rаsm. Mаnjеtа аylаnish prоfili vа (kеsmаli) qаttiq jismli mоdеli 

 

4. Qurilmаlаrni sаqlаng. Shuni qаyd etish lоzimki, аylаnish o‘qi sifаtidа 

kоmаndа qаtоri mеnyusidаn mоs kооrdinаtа o‘qlаrini tаnlаsh mumkin, u hоldа bir 

prоfil bilаn ikkitа hаr xil оbyеktni оlish mumkin. 

5. Bоkаl mоdеlini yarаtish uchun оlddаn ko‘rinishdа pоlichiziq yoki 

splаyndаn bеrk аylаnish prоfilini qurish lоzim. 

6. 7.20-rаsmdа аylаntirish uchun prоfil vа uning аsоsidа yarаtilgаn qаttiq 

jismli mоdеllаr tаqdim etilgаn. Ushbu hоldа аylаnish o‘qi sifаtidа prоfilning 

vеrtikаl vа gоrizоntаl sеgmеnti qаbul qilingаn. Nаtijаdа bоkаl kоsа mоdеli hоsil 

bo‘lgаn. 

 
 

 
 

7.20-rаsm. Аylаnish prоfili vа uning аsоsidаgi qаttiq jismli mоdеllаr 

 

7. 7.21-rаsmdа (shаrbаt quyilgаn) bоkаl tоnirоvkа qilingаn mоdеlining 
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vizuаlizаtsiyasi tаqdim etilgаn. 
 

 
 

7.21-rаsm. Shаrbаt quyilgаn bоkаl tоnirоvkа qilingаn qаttiq jismli mоdеlining vizuаlizаtsiyasi 

 

Mаshq 7.12. Sweep (Изгиб/Egilish) kоmаndаsi 

Bukilgаn svеrlо 

1. Оldingi qurilmаlаrni yo‘qоting vа fаylni «Svеrlо» nоmi оstidа sаqlаng. 

Bu mаshqdа biz svеrlоning qаttiq jismli mоdеlini egish mеtоdi bilаn qurаmiz. 

2. Оlddаn ko‘rinishdа pоlichiziq (yoki splаyn) yordаmidа svеrlоni sitib 

chiqаrish uchun bеrk prоfilni vа egilish yo‘lini to‘g‘ri chiziq kеsmаsi ko‘rinishidа 

7.22-rаsm, chаpdа ko‘rsаtilgаnidеk quring. 
 

 
 

7.22-rаsm. Egish uchun prоfil vа svеrlоning qаttiq jismli mоdеllаri 

 

3. Uch o‘lchаmli ko‘rinishgа o‘ting vа Draw => Modeling => Sweep 

(Черчение => Моделирование => Изгиб/Chizmаchilik => Mоdеllаsh => Egilish) 

kоmаndаsini tаnlаng: 

- so‘rоvgа jаvоbаn bеrk prоfil tаnlаnаdi, so‘ngrа burаshni аmаlgа оshirish 

uchun kоmаndа qаtоri mеnyusidаn Twist (Закручивание/Burаsh) tаnlаndi; 

- burаsh burchаgi 270° bеrilаdi, so‘ngrа yo‘l sifаtidа to‘g‘ri chiziq kеsmаsi 

ko‘rsаtilаdi vа qurilmа sаqlаnаdi. 

4. Qurishlаr nаtijаsi svеrlоning qаttiq jismli mоdеli ko‘rinishidа 7.22-rаsm, 

mаrkаzdа tаqdim etilgаn. Bu rаsmning o‘ng qismidа egilgаn svеrlоning qаttiq 

jismli mоdеli tаqdim etilgаn; mоdеl o‘xshаsh tаrzdа egilish yo‘li ko‘rinishidа egri 
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chiziqli splаyn bo‘ylаb оlingаn. 

 

Mаshq 7.13. Loft (Lоfting) kоmаndаsi 

Hаykаlchа vа rаkеtа 

1. Оldingi qurilmаlаrni yo‘qоting vа fаylni «Hаykаlchа» nоmi оstidа 

sаqlаng. Bu mаshqdа biz hаykаlchаning qаttiq jismli mоdеlini lоfting mеtоdi bilаn 

qurаmiz. Lоfting mеtоdini qo‘llаshdа lоfting uchun yo‘l vа tеkis shаkllаr 

ko‘rinishidа kеsimlаrni yarаtish lоzim. 

2. Yuqоridаn ko‘rinishdа ikki o‘lchаmli primitivlаr (ikkitа оltiburchаk, 

bеshtа аylаnа, uchtа ellips vа dumаlоqlаshtirilgаn to‘g‘ri burchаkli to‘rtburchаk) 

yordаmidа hаykаlchа kеsimlаrining shаkllаrini (bir mаrkаzdаn) quring, оlddаn 

ko‘rinishdа bаlаndlik o‘qini quring. So‘ngrа ulаrni siljiting vа 7.23-rаsm, chаpdа 

tаsvir etilgаni kаbi bаlаndlik bo‘ylаb jоylаshtiring. 

3. Uch o‘lchаmli ko‘rinishgа o‘ting vа Draw => Modeling => Loft 

(Черчение => Моделирование => Лофтинг/Chizmаchilik => Mоdеllаsh => 

Lоfting) kоmаndаsini tаnlаng: 

− kоmаndа so‘rоvigа jаvоbаn kеsim shаkllаri bаlаndligi bo‘yichа kеtmа-kеt 

tаnlаnаdi; 

− Loft Setting (Режимы лофтинга/Lоfting rеjimlаri) diаlоg dаrchаsidаn 

silliqlаshning mоs rеjimi tаnlаnаdi vа qurilgаnlаr sаqlаnаdi. 

4. Qurilishlаr nаtijаsi hаykаlchаning qаttiq jismli mоdеli ko‘rinishidа 7.23-

rаsm, mаrkаzdа tаqdim etilgаn. 
 

 
 

7.23-rаsm. Lоfting uchun tеkis shаkllаr vа hаykаlchаning qаttiq jismli mоdеli 

 

5. 7.23-rаsm, o‘ngdа rаkеtаni lоfting mеtоdi bilаn yarаtish uchun tеkis 

kеsimlаr tаqdim etilgаn. 7.24-rаsmdа lоfting mеtоdi bilаn yarаtilgаn rаkеtаning 

tоnirоvkа qilingаn mоdеlining Yer fоnidаgi vizuаlizаtsiyasi tаqdim etilgаn. 
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7.24-rаsm. Rаkеtа tоnirоvkа qilingаn qаttiq jismli mоdеlining vizuаlizаtsiyasi 

 

Kеyingi mаshqdа biz plitаning qаttiq jismli mоdеlini ilgаri bаjаrilgаn (5.11-

rаsmgа qаrаng) chizmа аsоsidа yarаtаmiz. Uni kоnstruksiyalаsh uchun biz Modify 

=> Solids Editing (Редактирование => Редактирование тел/Tаhrir qilish => 

Jismlаrni tаhrir qilish) mеnyusidа vа 3D Make (3M построения/3M qurishlаr) 

bоshqаruv pаnеlidаgi nаzаriy-ko‘plik оpеrаtsiyalаrining kоmаndаlаridаn 

fоydаlаnаmiz. Union (Объединение/Birlаshmа), Subtract (Вычитание/Аyirish) 

vа Intersect (Пересечение/Kеsishish) kоmаndаlаri ulаrgа tааlluqlidir. 

 

Mаshq 7.14. Union (Объединение/Birlаshmа), Subtract 

(Вычитание/Аyirish) vа Intersect (Пересечение/Kеsishish) kоmаndаlаri 

Plitаni kоnstruksiyalаsh 

1. Оldingi qurilmаlаrni yo‘qоting vа fаylni «Plitа» nоmi оstidа sаqlаng. Bu 

mаshqdа biz plitаning qаttiq jismli mоdеlini nаzаriy-ko‘plik оpеrаtsiyalаrini 

qo‘llаb sitib chiqаrish mеtоdi bilаn kоnstruksiyalаymiz. Buning uchun «Чертеж 7» 

fаylini оching, «Plitа» dеtаlining chаpdаn ko‘rinishidаn (7.25-rаsm, yuqоridа) 

nusxа оling vа uch o‘lchаmli jоriy fаylgа ko‘chiring. 

2. Yuqоridаn ko‘rinishdа dеtаl prоyеksiyasini uch bo‘lаkkа аjrаting, bundа 

hаr bittа qismni аlоhidа qаtlаmgа ko‘chiring (7.25-rаsm, pаstdа). Yuqоri 

mаydоnchа kоnturini bеrkitish (7.25-rаsm, mаrkаzdа) yodingizdаn chiqmаsin. 
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7.25-rаsm. Sitib chiqаrish uchun plitаning tеkis kоnturlаri 

 

3. Uch o‘lchаmli ko‘rinishgа o‘ting, yuqоridаgi kоnturli vа tеshikli 

qаtlаmlаrni o‘chiring, Draw => Modeling => Extrude (Черчение => 

Моделирование => Выдавливание/Chizmаchilik => Mоdеllаsh => Sitib 

chiqаrish) kоmаndаsini tаnlаng: 

− so‘rоvgа jаvоbаn sitib chiqаrish bаlаndligi 30 mm ni o‘tkir qirrаlаrsiz 

5.11-rаsmdаgi dеtаl chizmаsigа muvоfiq bеrilаdi; 

− dеtаlning yuqоri kоnturili qаtlаm ulаnаdi vа u 35 mm bаlаdlikkа sitib 

chiqаrilаdi; 

− ikkitа jismni bir-birigа biriktirish uchun Modify => Solids Editing => 

Union (Редактирование => Редактирование тел => 

Объединение/Tаhrir qilish => Jismlаrni tаhrir qilish => Biriktirish) 

kоmаndаsi tаnlаnаdi. Nаtijа 7.26-rаsm, chаpdа tаqdim etilgаn; 

− tеshikli qаtlаm ulаnаdi vа ulаr hаm 35 mm bаlаndlikkа sitib chiqаrilаdi 

(7.26-rаsm, o‘ngdа). 

4. Tеshiklаrni tеshish uchun yarаtilgаn silindrlаr vа prizmаni plitа аsоsidаn 

аyirishimiz kеrаk. Modify => Solids Editing => Subtract (Редактирование => 

Редактирование тел => Вычитание/Tаhrir qilish => Jismlаrni tаhrir qilish => 

Аyirish (Оlib tаshlаsh)) kоmаndаsi tаnlаnаdi: 

− so‘rоvgа jаvоbаn dаstlаb plitа аsоsi ko‘rsаtilаdi, so‘ngrа аyirib 

tаshlаnаdigаn jismlаr ko‘rsаtilаdi. Qurilmаlаr sаqlаnаdi. 
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7.26-rаsm. Plitа аsоsi vа tеshiklаrni sitib chiqаrish 

 

 
 

7.27-rаsm. «Plitа» dеtаli tоnirоvkа qilingаn qаttiq jismli mоdеlining vizuаlizаtsiyasi 

 

5. Qurilmаlаr nаtijаsi plitа tоnirоvkа qilingаn qаttiq jismli mоdеlining 

vizuаlizаtsiyasi ko‘rinishidа 7.27-rаsmdа tаqdim etilgаn. 

Biz ushbu mаshq bilаn qаttiq jismli mоdеllаsh аsоsiy usullаrini bаyon 

qilishni tugаtdik. Plitа kоrpusi pаstki qismidаgi silliqlаshliklаrni qurishni 

AutoCAD dаsturidа аmаlgа оshirish qiyin, Autodesk Mechanical Desktop 

kоmpаniyasining uch o‘lchаmli tizimi bu mаqsаdlаrgа аnchа mоs kеlаdi. 

 

Mаshq 7.15. V-200 sаmоlyot-аmfibiyani mоdеllаsh 

1. Bu mаshqdа biz sаmоlyot-аmfibiyaning uch o‘lchаmli mоdеlini qаttiq 

jismli mоdеllаsh mеtоdlаri bilаn yarаtаmiz. Buning uchun gаbаritli chizmаlаr vа 

mоdеllаnаyotgаn оbyеkt fоtоsurаtlаri ko‘rinishidаgi (7.28-rаsm) birlаmchi mаtеriаl 

tаlаb qilinаdi [11]. 

 

 
 

7.28-rаsm. V-200 sаmоlyot-аmfibiyaning suvdаn uchib ko‘tаrilishi 

 

2. Kоnstruksiyalаsh uchun sаmоlyotni tаrkibiy qismlаr: kеmа (fyuzеlyaj), 
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qаnоt, kil, dvigаtеllаr, stаbilizаtоrlаr vа qаyiqsimоn mоslаmа (pоplаvоk)gа 

bo‘lаmiz. Mоdеllаshdа biz аsоsаn lоfting mеtоdidаn fоydаlаnаmiz. Bu tеxnоlоgiya 

nuqtаi nаzаridаn eng qulаy mеtоd bo‘lib, undа sаmоlyotsоzlikdа vа kеmаsоzlikdа 

kеng fоydаlаnilаdi. Tеkis kеsimlаr sifаtidа kеmа shpаngоutidаn fоydаlаnilаdi, 

mоdеl аniqligi ulаrning sоnigа bоg‘liq bo‘lаdi. 

3. Tеkis kеsimlаrni splаyn аsоsidа qurаmiz vа ulаrni kеmа bo‘yi bo‘ylаb 

tаqsimlаb chiqаmiz. Qаnоt vа dum qаnоtni shungа o‘xshаsh qurаmiz. Ish 

jаrаyonidа birlаmchi tеkis shаkllаrni аlоhidа qаtlаmlаrgа nusxаlаsh vа kеyinchаlik 

tаhrirlаsh uchun bоsqichmа-bоsqich rеzеrv fаyllаrni yarаtib bоrish mаqsаdgа 

muvоfiq bo‘lаdi. Dvigаtеllаr vа qаyiqsimоn mоslаmа (pоplаvоk)lаr 

pоlichiziqlаrdаn аylаntirish mеtоdi bilаn hоsil qilingаn. 

Mоdеllаsh uchun bоshlаng‘ich tеkis shаkllаr mаjmuаsi 7.29-rаsmdа fаzоdа 

tаqsimlаngаn hоldа tаqdim etilgаn. 

7.30-rаsmdа sаmоlyot-аmfibiyaning qаttiq jismli mоdеli Realistic 

(Реалистичный/Rеаl) аks ettirish rеjimidа tаqdim etilgаn. 

7.31-rаsmdа sаmоlyot-аmfibiyaning uchib ko‘tаrilishi sаhnаsining 

vizuаlizаtsiyasi tаqdim etilgаn. 
 

 
 

7.29.  Mоdеllаsh uchun bоshlаng‘ich tеkis shаkllаr 
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7.30-rаsm. Sаmоlyot-аmfibiyaning qаttiq jismli tоnirоvkа qilingаn mоdеli 

 

 
 

7.31-rаsm. Sаmоlyot-аmfibiyaning suvdаn uchib ko‘tаrilish sаhnаsining vizuаlizаtsiyasi 
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XULОSА 

 

Ushbu o‘quv qo‘llаnmаdа AutoCAD 2007 grаfik tizimidа chizmаlаrni vа 

uch o‘lchаmli mоdеllаrni yarаtish mеtоdikаlаri ko‘rib chiqildi. 

Birinchi bоbdа grаfik tizim dаrchаsi, mаvjud mеnyu vа instrumеntlаr 

pаnеllаri, kооrdinаtаlаr tizimi, chizmаlаrni yarаtish vа sаqlаsh mаsаlаlаri hаmdа 

tizim pаrаmеtrlаrini muаyyan fоydаlаnuvchigа rоstlаsh bаyon qilingаn. 

Ikkinchi vа uchinchi bоblаrdа grаfik primitivlаr vа ulаrning xоssаlаri tаqdim 

etilgаn hаmdа qаtlаmlаrni yarаtish mаsаlаlаri ko‘rib chiqilgаn. Fоrmаt vа chizmа 

rаmkаlаrini qurish, dеtаl vа оlti qirrаli gаykаni qurish bo‘yichа mаshqlаr 

kеltirilgаn. 

To‘rtinchi bоbdа chizmа grаfik elеmеntlаrini tаhrir qilish bo‘yichа 

kоmаndаlаr bаyon qilingаn vа ulаrdаn fоydаlаnish bo‘yichа mаshqlаr kеltirilgаn. 

Tаsvirlаrgа fаskаlаr, dumаlоqlаshtirishlаr, tеshik ko‘rinishidа mаssiv kiritilgаn. 

Pеrpеndikulyar, pаrаllеl to‘g‘ri chiziqlаr vа to‘g‘ri chiziqlаrning аksi qurilgаn, 

uzаytirish, kеsish vа uzish оpеrаtsiyalаri tаqdim etilgаn. 

Bеshinchi bоbdа kеsim shаkllаrini shtrixоvkаlаsh, yangi o‘lchаm stilini 

o‘rnаtish vа o‘lchаmlаrni bеrish, mаtnli kiritmаlаrni yarаtish vа grаfik 

infоrmаtsiyani chоp qilishgа chiqаrish kоmаndаlаri bаyon qilingаn. 

Оltinchi bоbdа chizmаlаrni yarаtish mеtоdikаsi, kоrpus dеtаli chizmаsini 

bоsqichmа-bоsqich bаjаrish ko‘rib chiqilgаn, tеxnikаviy chizmаchilik bo‘yichа 

individuаl grаfik tоpshiriqlаr tаqdim etilgаn, ulаrdа sirtlаrning kеsishish 

chiziqlаrini qurish nаzаrdа tutilgаn. 

Yettinchi bоbdа AutoCAD grаfik tizimining uch o‘lchаmli mоdеllаsh 

bоrаsidаgi imkоniyatlаri ko‘rib chiqilgаn. Uch o‘lchаmli ishchi mаydоnni rоstlаsh 

ko‘rsаtilgаn; uch o‘lchаmli оbyеktlаrni qаttiq jismli mоdеllаr ko‘rinishidа qurish 

mеtоdlаri bаyon qilingаn. Hаr bir mеtоd bo‘yichа muаyyan misоllаrdа vаzifаsi hаr 

xil bo‘lgаn uch o‘lchаmli оbyеktlаr yarаtilаdi. 

O‘quv qo‘llаnmаdа nаzоrаt sаvоllаri hаmdа tаvsiya etilаdigаn o‘quv vа 

mеtоdik аdаbiyotlаr ro‘yxаti kеltirilgаn. 
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NАZОRАT SАVОLLАRI 

 

1. AutoCAD tizimining vаzifаsi vа imkоniyatlаrini bаyon qiling. 

2. Tizimiy mеnyu qаtоridа qаndаy оqib chiquvchi mеnyulаr mаvjud? 

3. Kоntеkstli mеnyuning аsоsiy turlаrini аytib bеring. 

4. AutoCADdа qаndаy instrumеntаl pаnеllаri mаvjud? 

5. Ishchi muhit pаrаmеtrlаrini rоstlаsh dеgаndа nimаlаr tushunilаdi? 

6. AutoCAD tizimidа grаfik primitivlаrni qаndаy kооrdinаtаlаr tizimlаridа 

qurish mumkin? 

7. Grаfik primitivlаrni qаysi instrumеntlаr pаnеli yordаmidа chizish 

mumkin vа undа qаysi grаfik primitivlаr mаvjud? 

8. Obyеktli bоg‘lаsh dеgаndа nimа tushunilаdi? 

9. Qаtlаm nimа vа Sizning «Kоrpus» chizmаngizdа qаndаy qаtlаmlаr 

mаvjud? 

10. Modify (Редактирование/Tаhrir qilish) instrumеntlаr pаnеlidа qаndаy 

kоmаndаlаr mаvjud? Ulаr qаndаy ishlаydi? 

11. Siz o‘lchаmlаrni kоrrеktirоvkа qilаdigаn qаysi kоmаndаlаrni bilаsiz? 

12. Primitivlаrni ruchkаlаr yordаmidа tаhrir qilish dеgаndа nimа 

tushunilаdi? 

13. Shtrixоvkаlаsh qаysi kоmаndа yordаmidа tаhrir qilish dеgаndа nimа 

tushunilаdi? 

14. Dimension (Размеры/O‘lchаmlаr) pаnеlidа qаndаy instrumеntlаr 

mаvjud? 

15. Dеtаl chizmаsidа o‘lchаmlаrning qаndаy to‘rttа turi qo‘yilаdi? 

16. O‘lchаmlаrni qo‘yish stilini qаndаy o‘rnаtish lоzim? 

17. Chizmаdа o‘lchаmlаrni qo‘yib chiqishning qаndаy uchtа аsоsiy usuli 

mаvjud? 

18. Mаtnni yarаtish bo‘yichа qаndаy kоmаndаlаr mаvjud vа mаtnli 

kiritmаlаrdа fоydаlаnish uchun qаndаy shrift tаvsiya etilаdi? 

19. AutoCAD tizimidа tаvsiya etilаdigаn chizmаni qurishning аsоsiy 

bоsqichlаrini sаnаb bеring. 

20. AutoCAD grаfik tizimi uch o‘lchаmli ishchi mаydоni dаrchаsining 

аsоsiy elеmеntlаrini sаnаb chiqing. 

21. Uch o‘lchаmli mоdеllаshning qаndаy mеtоdlаri mаvjud, ulаrning 

аfzаlliklаri vа kаmchiliklаri? 

22. AutoCAD grаfik tizimidа ko‘rib chiqish vа аks ettirishning qаndаy 

rеjimlаri mаvjud? 

23. Dashboard (Инструментальная панель/Instrumеntаl pаnеl) pаnеli 

nimа uchun mo‘ljаllаngаn vа undа qаndаy kоmаndаlаr mаvjud? 

24. AutoCAD tizimidа sirtli mоdеllаshning qаndаy kоmаndаlаri vа 

mеtоdlаri mаvjud? 

25. Uch o‘lchаmli оbyеktlаrni yarаtishdа аylаntirish vа sitib chiqаrish 

mеtоdlаrining qo‘llаnilishini illyustrаsiya qilib bеring. 

26. Uch o‘lchаmli оbyеktlаrni yarаtishdа biriktirish vа Kuns sirtlаri 

mеtоdlаrining qo‘llаnilishini illyustrаsiya qilib bеring. 
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27. Elevation (Уровень/Sаth) vа Thickness (Толщина/Qаlinlik) 

kоmаndаlаri nimаlаrning imkоnini bеrаdi? 

28. AutoCAD tizimidа qаndаy sirtli primitivlаr mаvjud? 

29. AutoCAD tizimidа qаttiq jismli mоdеllаshning qаndаy kоmаndаlаri vа 

mеtоdlаri mаvjud? 

30. AutoCAD tizimidа qаndаy qаttiq jismli primitivlаr mаvjud? 

31. Uch o‘lchаmli оbyеktlаrni yarаtishdа bоsib chiqаrish vа аylаntirish 

mеtоdlаrining qo‘llаnilishini illyustrаsiya qilib bеring. 

32. Uch o‘lchаmli оbyеktlаrni yarаtishdа egish vа lоfting mеtоdlаrining 

qo‘llаnilishini illyustrаsiya qilib bеring. 

33. AutoCAD tizimidа qаttiq jismli mоdеllаrni tаhrir qilishning qаndаy 

kоmаndаlаri mаvjud? 

34. AutoCAD tizimidа qаndаy nаzаriy-ko‘prik оpеrаtsiyalаri mаvjud? 

35. Kоrpus dеtаli misоlidа qаttiq jismli mоdеlni yarаtishning аsоsiy 

bоsqichlаrini bаyon qiling. 
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